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3-D Visualization and Animation



3D Visualization and Animation Contest 
 
The world of 3D is rapidly expanding, and career opportunities exist in a wide range of fields – 
including architecture, games, product and industrial design, civil engineering, and film and television 
animation. This contest allows students to step into a real world 3D production environment where 
creative output must be accomplished within specific timeframes, resources and design constraints. 
This is a two-person team event and includes a preliminary written exam. Contestants must produce 
high quality images and an animated short subject using 3D computerized images. Students are 
evaluated on their technical knowledge, production skills and creative abilities – including visual 
development and storyboarding. They will also have the opportunity to interface with and get 
feedback from high-profile judges with successful careers in 3D animation and visualization. 
 









































W
or
kb
oo
k
2010

This Workbook provided through a generous grant from

3D Visualization & Animation Competition

nerous grant from

3D



Workbook
Ta

bl
e 

o
f 

C
o

n
te

n
ts

2010WorkbookWorkbook

3D Visualization & Animation Competition

This Workbook provided through a generous grant from

Table of Contents

Introduction...................................................................3

3dsMax...........................................................................21

Maya..............................................................................140



3D Visualization & Animation Competition

Workbook

This Workbook provided through a generous grant from

333
In

tr
o

d
u

ct
io

n
2010WorkbookWorkbook

 A good idea that is not well executed is no longer a good idea, but a bad idea 

well executed is still a bad idea. 

So how do you come up with good concepts especially when you have to meet 

tight deadlines?

Each project you begin has an infinite number of design possibilities. As a artist 

working with CG software you are also a storyteller, and a technician. 

Always start with writing down your ideas and doing rough sketches, this is 

always a good start! You should be able to explain your concept in a clear and 

concise way to get the point across, think about reading the short summary 

about a movie online, what makes you want to go see the movie?

Sketches regardless to how rough are also a great place to begin. Whether it’s 

a character or environment, setting the stage in the earliest stages of the idea 

will help you flush out what is important and what’s not.

Storyboards are very important for organizing how you will tell your story in 

animation and organize your shots, they will help you bring your ideas to life. 

What are the basics of a good storyline? 

How do I develop an environment that matches my storyline?

 What am I trying to tell my audience? 

How can I make it effective enough so that the audience will understand 

my story? 

In the early stages of concept development you should ask yourself these 

questions: 

Who?

Why?

Where?

What?

When?

The story you choose to pursue will be based as much on chance as on 

research. Your imagination takes every bit of your experience from a daily walk 

to a favorite film and makes sense of it, combining it in ways no one else can, 

because no else has your knowledge, personality or experience. The magic of 

the ideation process is that you start in a familiar place, but then twist that into 

a new direction. 

Let’s start with an environment. Suppose we are going to create a set based 

around one of these ideas?

The living room of a Superhero in the year 3000

The Wizard’s room

The Mad Scientist’s laboratory, who is inventing a new way to time travel

For our example we will use the Mad Scientist’s laboratory!

Brainstorming your idea:
How will you convey the concept while just showing the lab and not the scientist?

Is the room scary or a funny?

What is the time period? Past, present, future?

Does the room look realistic or more fantastic? 

What are the elements you might find in a laboratory for example test tubes, 

flasks, beakers, etc.?

Using the concept of a “Mad Scientists Laboratory” or come up with your own 

idea and write a short paragraph describing the space, then make a list of what 

you might see in that space after you have answered the questions above.

The environment should give your audience clues about who the space belongs 

to and make it convincing.

Think about your target audience and how to will attract their attention.

Do some quick sketches to illustrate the objects in the space.

Try to set a mood and tone about the space.

Things like a rough floor plan can help

Also create a prop list of what would be good to have in the space.

Ideas and Concepts

y
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Good brainstorming clearly leads to a good project!

Good ideas are not always your first ideas, it’s a process of many iterations 

and trial and error to get to a great project. Creativity requires a willingness to 

boldly say what you think, but it also requires a willingness to let ideas evolve, 

if you are working on a team make sure to have everyone participate and share 

their ideas, you never know what will be the spark that makes the idea come 

alive! 

Generating ideas

The discussion process can help shape an idea into something it didn’t have 

the potential to be when just one mind was contemplating it. Two minds or 

three, or eight, or twelve, pursuing the same problem can present hundreds of 

possibilities for its solution. Even designers who don’t normally think out loud 

can benefit from this process, simply because one idea has the potential to 

multiply once a group starts discussing it. In this way of working and discussing 

ideas out loud also helps you as a designer to start to understand the ideas 

yourself. 

Remember without a good idea there is nothing but technique!

Ideas and Concepts
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Telling stories is as old as music, drawing, and perhaps even speech. We all love 

stories and we never outgrow them. We go to movies and read novels and even 

gossip because we want to be told stories and we want to tell stories.

All of us watch movies, play videos games, and watch television. We look 

at photographs and paintings, and often there will be no character, yet we 

understand what is happening and can be moved by these images.

In a movie the camera may lead you through a space glancing at objects 

that tells us who has been there, unveiling a portion of the story with no 

character in the scene, showing clues that may play a role later on in the 

movie.

In games you often have to discover what is happening by traveling 

through the environment as the visual clues unveil the story.

In an architectural visualization of an environment the designer also tells 

a story to the client about how the space will look and feel like, conveying 

a mood.

If I walk into the room you live in I would see things around the space that 

would tell me who lives there. This is what we want you to do here, tell us a 

story using a place, a room. We need to be able to look at the rendered images 

and animation and know exactly what is happening, just happened, or is about 

to happen.

Let's take the example of the Mad Scientist’s Laboratory, who is inventing a 

new way to time travel.

By looking at the images and animation we should be able to answer these 

questions:

Who lives or works here?

What do they do?

What is the general time period, past, present, future, is it fantasy?

What type of a person are they?

Think of the elements you may find in a laboratory for example test tubes, 

flasks, beakers, etc. to help convey the story.

The environment should give your audience convincing clues about the 

mad scientist.

Light may play a role; maybe you have windows, or skylights or huge doors.

Below are a few more things to consider about storytelling:

Storytelling is an art in itself.

It is based on an idea you want to convey to your audience.

The idea develops into narratives and visual treatments.

A script is developed which may consist of characters, scenes, props, etc.

Storyboard the script.

Think of camera angles to tell a visually compelling story.

Lighting can set up the mood for your story.

Audio can play an integral part in storytelling.

Transitions from one scene to another along with staging are thought of.

Timing will play an important role in every visual involved in the 

storytelling process.

Dramatic appeal along with a well developed plot that engages the 

audience is key.

A story has a beginning, a middle and an end. You can break them down as setup, 

conflict and outcome. You should have a structure to a story:

Character goes on a skydiving trip

Character's parachute is entangled in mid air

Character has a safe landing

3D animation is a great medium for storytelling.

You can show anything you want in the world of animation which can help you 

think about the impossible while telling a story.

Storytelling
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Another strength of animation is that it gives us more freedom to use color, 

movement, and style. We can make a chase scene more exciting by making the 

colors get redder as the heat of the moment increases. We can make a creature 

or vehicle move at exaggerated speeds, swell up or shrink down, and perform 

moves that would be impossible for any actor or dancer.

We aren’t limited to real actors or real settings. We can build impossible 

landscapes and populate them with mutant animals or monsters that only 

exist in our imaginations. As for style, animation can look real, like a cartoon, a 

combination of the two, or anything in between.

Storytelling
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Having good design is extremely important in any work of art as it makes 

something easier to understand and also serves as a visual reference for the 

information you are trying to provide. Good use of color is an important factor 

for good design. Composition and focal point are other factors to consider 

while coming up with good design.

The elements of design are the foundation to all visual imagery including 

traditional painting, illustration, architecture, graphic design, and 3D art.

Think of elements as ingredients such as flour, baking soda, water or vinegar. 

Principles are the wisdom of how to combine these ingredients or elements. 

If you want a mild combination, mix water and flour. If you want an exciting 

combination, mix baking soda and vinegar.

Elements of design - These are the building blocks to all visual 

imagery, from traditional painting to 3D. Below are a few elements of 

design.

Point - A point is the most basic of design elements and can be 

defined as the smallest area of visual attraction in a composition.

Line - Line could be considered one of the most powerful elements 

of design. Line is used to define a shape, describe a contour, or be 

implied by the outside edge of a form.

Shape - When a line encloses a space, it creates a shape. Shape is 

two-dimensional only, meaning that it has height and width, but no 

depth.

Space - Space is the expanse or area in which all objects and events 

take place.

Direction - Horizontal lines suggest stability and project calmness 

and peacefulness. Vertical lines depict power and height, and 

diagonal lines can have the feeling of action, movement, or 

instability.

Size - Size is simply the how one shape occupies an area with 

respect to another shape.

Texture - Texture is the surface quality of an object. Texture can be 

rough and prickly, like the surface of a cactus, or it can be soft like 

the fur on a cat.

Color - Color is the most complex of all the elements. It has a 

physical presence and creates a psychological response in the 

viewer.

Value - Value can be thought of as the darkness and the lightness 

of color.

Principles of design - These can be thought of as how we combine the 

elements of design to make great art. Below are some principles of 

design.

Balance - Balance is the visual arrangement of elements or objects 

in a composition that creates a sense of equilibrium. Balance can be 

symmetrical, asymmetrical, or radial.

Emphasis - Emphasis creates a focal point or points in a design. It 

serves as a marker to show what in a composition has hierarchy or 

importance.

Economy and Continuation - Economy is a principle of design 

which emphasizes the simplification of elements to express a 

message. Only the elements required to express the idea are used. 

Continuation refers to the “lining up” of visual elements in a design. 

When elements are placed in a continuous fashion, the viewer’s eye 

will transition from one element to the next with a feeling of unity.

Rhythm - Rhythm refers to the repetition of shapes or elements in 

a design. Rhythm also refers to the movement of the viewer’s eye 

through a design.

Unity - Unity refers to visual harmony and agreement among the 

elements in a design. When the parts work together to create a 

whole, you have unity.

Design
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Proportion - Proportion is the relationship of elements in 

comparison with each other, or with aspects of a single element or 

object.

Contrast - Contrast is used to create emphasis through the use 

of contrasting elements. Elements with strong contrast stand in 

opposition to one another: light against dark, large against small, 

round against square, smooth against rough, etc.

Repetition - There are different types of repetition:

Regular - Regular or systematic repetition is created when 

the elements and intervals between the elements have a 

consistency with very little change.

Flowing - Flowing rhythm is more organic and can have more 

variation in the elements used to create the composition, much 

like a winding natural stone walkway or waves of meandering 

wire.

As you learn to model, texture, and animate in 3D, think about how the 

elements and principles of design, color theory, and composition apply to your 

scene.

Are your objects interesting shapes?

Are the scale and proportion working?

Are there areas where your eyes can rest?

Are there focal points to draw the viewer to?

Are you using color to tell your story?

Working in 3D allows you to view your objects in orthographic and perspective 

views. You are able to create objects and render them from different camera 

angles. Design, color, and composition are important factors and a larger 

challenge to control in a 3D space. As you start to layout your project, think 

about what story you want to tell and how to apply the theories learned to 

create a clear message for the final viewer of your project.

Design
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Good quick storyboarding techniques are easier than you think and can really 

help you visualize your final animation.

Storyboards are sequential drawings that help us understand the story. 

Animation is hard work. Drawing is hard work, too, but it’s much easier to draw 

out shots to see how they look than to create an animation from start to finish.

Storyboards are used during the pre-visualization phase. It's extremely 

important to have a rough storyboard for your project so that the 3D team 

understands the process and can communicate it to others.

Storyboard help communicate how an animated sequence will look before any 

work is started on the computer. They make the movie without all the work of 

making the movie. However, storyboards lack two critical things: movement 

and sound.

Comics can include word balloons and 

sound effects because that’s part of their 

style, but storyboards represent the design 

of film shots, so storyboard artists usually 

write the dialogue and sound effects 

below each drawing, and often indicate 

movement with descriptions or multiple 

drawings.

One needs to understand animation to 

make a convincing storyboard. Try getting 

an idea of where everything is and how 

the animation can be staged as you read 

the script. If there is a character involved 

try envisioning the character as you read 

the script. After reading the script, try to 

envision how to expand on it to make it 

more interesting. You should be excited on 

starting the storyboarding process after 

you read the script and should have some idea on the images you are going to 

create.

Think of camera angles. The shots should tell the story, transitions are 

important in storyboards. Give a small description for each image.

Storyboards can be loose and sketchy or fully developed and in color. Either 

way, they are only preliminary. They allow an artist to explore options, to 

tell the story from one point of view or another and to play with various 

approaches before committing to one.

Below is an example of a rough, initial storyboard for a 10 second animation of 

the Mad Scientist’s Laboratory. The rough storyboard gives us an early idea of 

what the animation will look like. It also serves as a foundation for modeling 

the scene to make it look like a mad scientist’s laboratory.

Storyboarding Techniques
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Once your project is complete you will need to create a presentation to turn in, 

here are some suggestions for example of what might be due as part of a final 

presentation for our Mad Scientists Laboratory. 

A word document explaining your project. 
A maximum of 3 sentences which will help describe your concept (a TV Guide 
version). Make sure to include the title for your story at the beginning. and the 
names of all the team members, it’s also good to include your email address etc.

A prop List

A storyboard of rough illustrations explaining the storyline.
This should be a complete as you can make it in the time allowed to get your point 
across.
You can also include any other sketches you may have created.
A floor Plan Sketch is good to have to explain how you decided to lay out the 
space, this will also help with your storyboard

 

Composition Block-in
These are work in progress (WIP) renders at 640x480 .jpeg images of your 
process. Two for modeling, two for lighting, two for texturing, Try to maintain a 
smooth transition for these for example choose two shots and show them from 

the modeling, texturing and lighting stages.

Ten still renders including a close up and distance showing the room and details 

(640 x 480 .jpeg)

These are great for storytelling and process is always good to show.

Ten seconds of an Eye Level Fly-through/Walk-through of the space telling the 

story showing the details. Ten seconds is 300 frames.
Render the animation at a maximum of 640x480.
Render as .tga image sequence; this will give you the best quality.
Use QuickTime Pro, or some other editing software, to make a movie out of the 

sequential images.

Creating a Digital Presentation
When you turn in your final presention you will have:

Concept and Title document

Prop List document

Floor Plan Sketch

Prop Sketches

Rough Storyboard

Six Work in Process Renders-Block ins

Final 300 Frame animation render-10 seconds

10 Still Renders showing details
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Make sure to consider the time you will have to spend rendering the animation

Check how long one frame of the animation takes to render and then estimate the 

total time. For example, if one frame takes 10 seconds then 300 frames will take 

10x300=3000 seconds, which is 3000/60=50 minutes

Make sure to go through every setting in the render setting window within your 

3D software

Completing your Project on Time

Another strength of animation is that it gives us more freedom to use color, 

movement, and style. We can make a chase scene more exciting by making the 

colors get redder as the heat of the moment increases. We can make a creature 

or vehicle move at exaggerated speeds, swell up or shrink down, and perform 

moves that would be impossible for any actor or dancer.

We aren’t limited to real actors or real settings. We can build impossible 

landscapes and populate them with mutant animals or monsters that only 

exist in our imaginations. As for style, animation can look real, like a cartoon, a 

combination of the two, or anything in between.

What makes a good project?

Good design

Good concept art

Good story

Storyboards/Animatics

Project management

Workflow techiniques

Creating a final digital output

A good project starts with focusing on pre-visualization and conceptual design 

techniques. One needs to understand the importance of concept art and 

how it will support the storyboarding for an animated sequence. Why story 

is important and how your audience understands your story is key to keep in 

mind. Make sure that your audience can easily relate to aspects of storytelling 

for example characters and emotion, movement, timing and pacing, lights 

and camera angles all set the mood to tell a story. Story is the backbone and 

foundation of your project.

Other building blocks to create any work of art are the elements and principles 

of design. Focusing on the elements and principles of design will allow you to 

describe the concept with enough artistic depth visually and verbally to allow 

the viewer to accurately visualize the final 3D output.

Project management can consist of working smart within the software 

to managing a production schedule to make sure you meet deadlines for 

the project. Proper workflow techniques are extremely important in a 3D 

production. Making sure your fundamental concepts in 3D are clear becomes 

extremely important for any 3D production.

Final presentation is extremely important as that is the final output your 

audience will see. Making sure you leave enough time for rendering and any 

post production will play a key role in creating that final impact.
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Having a good pipeline as to how you should approach your workflow is 

extremely important for a successful project and should be thought out in 

advance before the production process. This will help in a smooth workflow and 

you will find yourself on track in a tight deadline driven project.

Below is an example of a workflow and tips related to each element in the 

pipeline:

Idea and Concept Art

Spend time on story and concept sketches.

Remember a story should have a beginning, middle and an end.

You can break them down as setup, conflict and outcome.

Storyboarding

Make sure you read the script well before you start making your 

storyboards.

In a tight deadline driven project rough sketches will help convey the 

story best; quickly illustrate the main points to convey the story.

3D modeling

Importance of pivot points while making 3D models from 2D curves

Unit setup for scene creation

Make sure you model from the world origin

Maintain a good edge loop workflow in your 3D models

Maintain overall good topology

Pay attention to quads and tris

Model with symmetry/mirror

Smooth only when needed

Lighting

Make use of basic light theory

Use three point lighting

Use lighting linking/include-exclude

Use shadows effectively

Texturing

Understand the importance of mapping

Use 2D and 3D procedural textures

Understand the importance of UV Texture editor/UVW Unwrapping

Use Photoshop to make your textures or enhance your existing images

Understand different shaders

Animation

Understand set key and autokey

Path animation

The importance of curve editor/graph editor

The importance of dope sheet

Principles of animation

Safe frames for animation

Effects

Have a good knowledge of any effects within your 3D software and use 

them wisely while keeping render times in mind.

Rendering

Make sure you understand render resolutions to estimate the amount of 

time it will take to render animation as still images.

Workflow and Helpful Tips
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Production Schedule Time Managing your project

Come up with a concept, write down your ideas and create some rough 

sketches.

8:00-8:30 am Have your project title, descriptive paragraph and some rough sketches 

complete.

Team breaks out responsibilities to decide who will be doing what

tasks. Begin the storyboards and plan camera shots along with a prop 

list.

8:30-9:30 am Assign a deadline for each task for example storyboards, modeling 

(working from prop list), lighting, animation, etc. along with 

coimpleting storyboards.

Concept, Sketches, Storyboard and Schedule/Workbreakdown are complete at 9:30 am

Modeling begins, block in environment with basic shapes for

composition  and set up first lighting pass as team members create 

assests.

9:30-10:30 am First pass Lighting set up  and environment blocked in. Make sure to 

establish a proper project pipeline to flow from one task to another and 

that you will have time to complete all your assets.

Modeling completed, replace block in objects with final objects 

Review models. Refine second lighting pass thinking about your story.

10:30am to 

1:30 pm

All Modeling complete, make sure you followed proper naming 

conventions. Add objects in layers to manage your scenes.

All Modeling complete! Be Save files often and also back up multiple files in increments.

Begin Texturing objects, adding simple object animation, effects and

final lighting pass.

1:30-3:30 pm Texturing, object animation and effects complete (Make sure to group

objects within your 3D scene to manage the scene better.)

Using your storyboard set up your camera to complete your 10 second

fly through animation.

3:30-4:00 pm Check a test version of the fly through. Keep making animation

previews/playblasts to check your animations. 640x480. Render one

frame and estimate how much time it will take for the entire animation.

Work Complete Begin Rendering and Presentation!!!

Render your final animation and complete still images for your 

presentation.

4:00-4:45 pm Make sure you can render in this amount of time! Prepare your still 

images, storyboard, and project description for presentation following 

the guidelines.

Rendering done! Make the movie and submit your presentation. 5:00 pm Congratulations!

Managing your project and staying on your timeline with your production 

schedule is crucial to completing a great project. Let’s look at an example of a 

project that’s worked on and completed over an eight hour period of time.

In this example we are going to use the “Mad Scientists Laboratory” as the 

example, we will just be working on the environment for this part of the project 

beause characters can be very complicated and take much more time.

The most important thing for any project is to be managed effectively so that 

you can meet your necessary deadlines. Having a production schedule will 

help you meet these deadlines in a timely manner. Not following a production 

schedule will often lead to either an incomplete or an average project. Here is 

the breakdown for the schedule.

Managing Your Time
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Example of some initial ideas.

A storyboard displaying the track

Process
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Modeling the track getting the reference images in your 3D 

software

Process
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Assembling the track to curve it

Process
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Some lighting studies before you begin lighting the entire 

scene (The entire scene will be lit not just the track)

Process
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Track lit with the entire scene

Process
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Creating materials for the track

The track used for animating the vehicle

Process
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Rendering the scene

Final Render

Process
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3 - Layers and Selection Sets
Layers allow you to manage the objects in 

your scene. Selection Sets allow you to add 

objects to sets for easy selection.

2 - Transform, Rotate, Scale
These tools allow you to Select, 

Transform, Rotate and Scale objects 

in the scene.

4 - Primitives
In 3DS Max you create primitive 

3D geometry as a starting block 

to modeling detailed 3D objects.

7 - Quad Menu
The Quad menu can be accessed 

in the viewport by right clicking 

the mouse. You will get a differ-

ent menu dependent on what 

objects you are working with.

9 - Auto Key
Auto Key allows you to automatically key objects as you 

scrub through the timeline making transform, Rotate and 

Scale changes. Any change you make a key will be created.

10 - Animation Settings
Animation Settings allow you to take control over 

all aspects of your animation setup, from Frame 

Rate to Number of Frames.

5 - Material Editor
The Material Editor is where 

all materials and maps are 

created. It’s easy to use and 

materials can be dragged 

and dropped onto objects in 

the scene.

6 - Viewport Navigation
Using the viewport Tools, you 

can orbit, Pan and Zoom the  

Viewports.

8 - Rendering
When you render, 3DS 

Max converts a 3D 

Scene into a 2D Image.

1 - Setting a Project

When you start up 3DS Max, it is best practice to 

set up a project file. This will allow you to always 

save work to a specific directory.

Time Slider

Playback Controls

Command Panel
Main Toolbar

Viewport Navigation
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 Material Editor

Menus

Toolbar
Slots

Maps

Assign

Material Type

Colour

Map Button

Parameters

Shader Graph

Modifiers

Tabs

Object Name

Modifiers

Quad Menu

Hide / Unhide

Options
Transforms

Convert

Sub-Objects

Render Settings

Render View

Render

Tabs

Main ToolBar

Transform Tools

Undo/Redo/Save

Snaps

Menus

Mirror

Layers

Material Library

Graph Editor
Render

Selection Sets

File

Modify Stack

Modifier Options

Current Modifier

Delete

Show End Result

Modifier On/Off

Create Tab

Modify Tab

Rendering

Rendered View

Render

RGB / Alpha

Save / Clone

Render Window
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With your project folder now set, if you go 

to File>Open you will bring up the Open File 

dialog.

3

Click on Set project Folder. In the

Browse For Folder dialog that appears,  navigate to a 

directory and create a new Folder. This folder should have 

a name relevant to the project. Once you have created 

the project folder, click OK. Your project Folder is now set. 

Every time you hit save the current scene will get saved to 

this directory. 

2

File Management is crucial to the success of any 3D project. By setting a project 

folder, you are always making sure that files get saved to specific and relevant direc-

tories. For example when you set up a project all scene files you save are saved to the 

Scenes Folder, any materials you save are saved to the Materials Folder etc. First got 

to File>Manage>Set Project Folder.

1

The Open file dialog, navigates you directly to the Scenes Folder, in the 

project Folder you set up earlier. Notice that all your files are laid out in an 

organized manner. Any files you save, Export, Render are all saved to their 

relevant Folders making it really easy for you to manage your project and 

ensure that data doesn’t get lost. 

4
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1 You can create primitive objects by going to 

the  Create Tab in the Command Panel

4

An Editable Poly has 5 Sub-Object levels, Vertex, Edge, Border, 

Polygon and Element. Each of these levels allows you access to 

different elements of the Poly.

Once you have created a primitive 

object as your starting block you can 

convert it to an Editable Poly and then 

start using some of the Sub-Object 

modeling tools to  develop and refine 

your model. Any primitive can be 

converted to an Editable Poly just as a 

shape can be converted to an Editable 

Spline.  All Editable Polys allow you 

access to Sub-Object modes. 

3

2

Primitive objects consist of Boxes, Spheres,

Cones, Planes, Pyramids and Cylinders. They are easy to create, gener-

ally with a 2 click mouse operation

5

Modifiers can also be applied to objects in 

the Modify Tab, through the Modifiers List. 

When a modifier is added, it appears above 

the Editable Poly in the Modifier Stack.
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3dsMax Grouping vs. Selection Sets 
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In this tutorial you will get started with creating simple groups and selection 

sets. It is important to understand the differences between the two, and 

when to use them. To add objects to a group you will first create two 

Cylinders in the viewport. 

1

Select the two objects using the Select Object tool from the Main 

ToolBar. On the Menu Bar go to group Menu>Group.

2

The Group Dialog appears. Give your group a 

name.

3

Now if you select either one of the two 

cylinders they both become selected as a 

group. With Groups you can only select the 

objects as a whole group. You can’t go in and 

select individual components of a group. That’s 

where Selection Sets come in handy.

4

5

Selection sets let you add objects to sets and 

select them. This is helpful when objects are hard 

to see. Create a series of Boxes and Cylinders in 

the Viewport.

6

From the Main ToolBar hit the Selection Sets Button

7

The Selection Sets Dialog Appears. 

Select the Boxes and hit the + sign in 

the dialog. This adds the Boxes to a 

Selection Set. 

8 You will see a new Set appears, Double click 

on it to Rename it. Give it a logical name.

9

From the Selection Set Filter on the Main 

Toolbar, hit the drop Down Arrow and you 

will be able to select the boxes easily.
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When you link objects in 3DS Max, you create Child-Parent re-

lationships, where the child will always follow the movements 

of the parent. You will create a set of primitive spheres. You can 

copy the arrangement you see here or you can follow along. We 

will link all the outside spheres to the central sphere and have 

that sphere act as the parent.

1

When you drag from the Child to the Parent, you will 

see a rubber band drawn between the two spheres. 

Release the mouse over the Parent.

3

Now that you have linked all the outside spheres to 

the central sphere, or the Children to the Parent. If 

you select the parent and rotate it in the X-Axis, all 

the Children will follow.

5

Select the sphere as shown, and from the Main Toolbar go to the 

Select and Link Tool.  Drag from the Sphere to the central sphere. 

The outer sphere becomes the child and the central sphere becomes 

the Parent. Always select the Child first.

2

You can now select all the remaining outer spheres and drag to the 

central sphere, the Parent.

4

If at any time, you wish to unlink objects, you can do so by selecting all 

the objects you wish to unlink, and from the Main Toolbar select the 

Unlink button. This will unlink all Children from the Parent.

7

If you select one of the children and move it, it will 

move independently of the parent. However, when 

you select the Parent again and rotate it, the Child 

will be bound to it from its new position.

6
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2

The Material Editor is an Easy to use dialog. This is where all your 

scene materials and textures will be created. The Material Editor 

allows you to manage individual scene materials in their own 

individual material slots. You can create Procedural Materials. These 

are materials created parametrically within 3DS Max. You can also 

create Bitmap Materials. These use external image files.

1 First you will create a simple Procedural Material. To 

do this click on an empty material slot. Click the Arch 

and Design Slot, and from the Material/Map browser 

select Standard. You are now working with a simple 

Standard Material. Click the Diffuse Color Swatch and 

change it to Red.

You have created a simple 

material that is now ready 

to be dragged and dropped 

onto an object in your scene.

You will now create a material with a Texture Map applied to it. 

Select an empty material slot, and change it to standard. Click the 

little grey Map button next to the Diffuse Slot. This will bring up 

the Material/Map browser and will allow you to select a map for 

your material.

3

4

From the Material/Map Browser, select a Cellular Map. This is a 

procedural texture map, meaning that the texture is controlled via 

sets of parameters within the Material Editor. If you select a Bit-

map file, it is best to save the image to your Images Folder in your 

Project Directory , and load it from there. This file will also need 

to be supplied with the scene file when you transfer to another 

computer.

5 If you double click on the Cellular 

Map, you will notice it is added to 

the Diffuse slot of your Standard 

Material, and the material takes on a 

new appearance. Maps are great for 

creating realistic looking textures. 
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In this tutorial, you will create a simple animation of 

a sphere moving across the viewport. To start, go to 

the Command Panel>Create>Geometry>Sphere. Left 

Click in the viewport and drag out a Sphere. Right click 

when you are done. Go to the Main Toolbar and select 

the Move Tool. Select the Sphere. You are now ready 

to start animating.

Go to the bottom right of the interface 

and hit the Auto Key button. Move the 

Time Slider to Frame 10 and then move 

the Sphere to a new position. Notice 

that two key frames are created. One 

at frame 1 and one at Frame 10. Move 

the Time Slider to Frame 20 and move 

the Sphere.

As you move the Time Slider 

across the Time Line and move 

the Sphere you will see new 

keys are created. Set new Keys 

at Frames 30, 40, 50 etc until 

you reach 100. When you are 

done be sure to turn off Auto 

Key. 

Once you have animated your Sphere, Go to Graph Editors>Track View - Curve Editor. With your 

object selected you will see the animation curves that were created. You can refine your animation 

using these curves. 

The animation and Playback controls allow you to play your anima-

tion in real-time in the 3DS Max viewports. Auto Key, allows you to 

set an initial key, scrub through the timeline, move your object, and 

the object will be automatically keyed. It’s a quick and easy way to 

animate objects in 3D space

Auto Key

Time Configuration

Set Key
Playback Controls

Frame Number

The Command Panel is a very impor-

tant part of 3DS Max. Its where all 

objects are created and modified. It 

is made up of Tabs that are arranged 

in an easy to use layout. Most object 

parameters can also be animated using 

Auto key or Set Key. Lights and Cam-

eras can also be animated.

Geometry

Shapes

Lights

Cameras

Helpers
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In this tutorial, you will animate a camera along a path. This is a great way 

of creating camera walkthroughs. You can attach either a Free Camera or a 

Target Camera to a path. First go to Command panel>create>Shapes>Line and 

create  an open spline. This will be used as the path. The next step will be to 

create a target camera and an object in the scene for the camera to look at.

1

Create a box and put it at the centre of the 

path. To create the Camera, go to Command 

Panel>Create>Cameras>Target Camera. In the Top view, 

place your Camera over the path and drag until the tar-

get is over the box. In the next step, you will attach the 

camera to the path. You will do this using a Transform 

Controller called a Path Constraint.

2

To create the Path Constraint Controller, select the camera and 

go to the Command Panel>MotionTab. In the Motion Tab, Click on 

the Position option in the Assign Controller Rollout so it becomes 

highlighted in yellow. Next Click on the little button in the rollout 

to bring up the Assign Position Controller dialog. You will select 

Path Constraint. You won’t see much happen yet other than the 

Path Controller being added to the Position Transform. 

3

Scroll down the Rollout to the Get Path Button. 

Press the button, and with the cross hair, click on 

the path. You will notice the camera jump to the 

start of the path whilst the target remains over 

the box.  You will also notice that two key frames 

have been added at the start and end of the Time 

Line. If you press play in the play back controls 

you will see the camera move along the path, 

whilst the target remains over the Box. Press C 

on your keyboard to go to the Camera View. You 

cannot move the camera directly anymore, you 

must move the path and the camera will move 

with it. Go ahead and try adding a Free Camera 

to the Path

4
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Opening Autodesk 3ds Max 2010

After installing 3ds Max 2010 you can open it two separate ways. One is by 

simply double-clicking on the icon that 3ds Max will have generated during 

installation on your desktop.

Alternatively, you can navigate to 3ds Max in Windows® by navigating to 

Start Programs Autodesk Autodesk 3ds Max  2010. Upon launch you should 

be given two options. If you have purchased 3ds Max 2010 you will have an 

activation code that came with the software documentation. Follow the steps 

on-screen during the activation process to launch the software. If you are using 

3ds Max on a trial basis, choose that option and the software should load with a 

30-day trial that has all of the features of the regular version for a limited time.
Once the software loads, you will see 3ds Max software’s first splash screen.

Here you will find that the first splash screen points you in the direction of 

Essential Skills Movies. These short movies are designed to jump start you in 

the direction of whatever it is you are using 3ds Max 2010 for. By clicking on 

any of the six movie choices, 3ds Max will automatically launch your default 

Internet browser and begin playing a short video, giving you some basic 

instruction on your topic of choice. These video clips are just a small taste of 

the help that is available for you when learning the software.

The What’s New option will launch your default Internet browser and take you 

to the Autodesk website dedicated to explaining the newest features in this 

version of 3ds Max. If you are familiar with previous versions of 3ds Max, this 

site will provide you with additional training and videos on the most recent 

additions to the software.

The Learning Path option will launch your default Internet browser and take you 

the Autodesk 3ds Max Service and Support website. This site can point you in 

the direction of a multitude of topics regarding 3ds Max, including tutorials, 

discussion forums, additional help and documentation, as well as events and 

seminars. If you are new to 3ds Max, this is a great resource for furthering your 

education or finding answers to questions you may have while learning the 

software.

Lastly, on the bottom left of the box you can check on or off under Show this 

dialog at startup to show this popup when you launch 3ds Max or not. If you 

decide to not have the box pop up at launch, but would like access to any of 

these features, you can find them under the Help menu on the main toolbar.

Once you have clicked Close, you are looking at the default 3ds Max 2010 

interface. Take a moment to get familiar with the basics of the interface as we 

start to address some of the key 

3ds Max 2010 startup splash screen.
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Key Interface Elements
Using the image above as a guide, let’s look at some of the main UI elements in 3ds Max 

2010.

1 Main Toolbar
The main toolbar provides quick access to tools and dialog boxes for many of the 

most common tasks in 3ds Max 2010.

2 Command Panel and Menu Bar
The command panel comprises six user-interface panels that give you access to 

most of the modeling features of 3ds Max 2010, as well as some animation features, 

display choices, and miscellaneous utilities. To switch to a different panel, LMB 

click the tab at the top of the command panel.

3 Time Slider
The time slider lets you navigate along the timeline and jump to any animation 

frame in your scene. You can quickly set position and rotation or scale keys by RMB 

clicking the time slider and choosing the desired key from the Create Key dialog 

box. We will discuss animation and the time slider further in Lesson 11, as well as 

Projects 5 and 6.

4 Status Bar Controls
The 3ds Max 2010 window contains an area at the bottom for prompt and status 

information about your scene and the active command. To its right/left is the 

coordinate display area, in which you can manually enter transform values. To its 

left, is the MAXScript listener window, where you input single-line scripts.

5 Animation and Time Controls
Between the status bar and the viewport navigation controls are the animation 

controls, along with the time controls for animation playback within viewports. 

Use these controls to affect your animation over time. We will discuss animation 

and the time controls further in Lesson 11, as well as Projects 5 and 6.

6 Animation Playback Controls
Use these buttons to see your scene in motion through time. We will discuss 

animation and the playback controls further in Lesson 11, as well as Projects 5 and 6.

7 Viewport Navigation Controls
Use these buttons to navigate your scene within the viewports. As we progress 

further in this lesson we will explore these features more.

8 Viewport
When you start 3ds Max 2010, the main screen contains four viewports showing 

the scene from different angles. By default you are looking at the Top, Front, 

Left, and Perspective views respectively. The Top, Front, and Left views are 2D 

representations of your scene, also referred to as Orthographic views. 

The Perspective viewport, by contrast, most closely resembles human vision in 3D. 

We will cover viewport navigation further in this lesson.

9 Graphite modeling tools
The graphite modeling tools menu is new with 3ds Max 2010, and it combines 

a wealth of new polygon-modeling features, including freeform sculpting and 

powerful loop-modeling tools, with the tried-and-true toolset in a dynamic, 

configurable new ribbon interface. By clicking the small arrow button at the end of 

the bar you can minimize and maximize the toolbar.

1

2
9

3
4 5

8

6 7

The 3ds Max 2010 interface.
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Creating a cylinder using the menu bar.

Directly underneath the menu bar is the Main 

toolbar. It is primarily a series of icons that take some 

memorizing to get used to, but handle a large number 

of the most commonly used 3ds Max functions. These 

functions are accessed by LMB clicking on them. Some 

of the buttons along the Main toolbar have additional 

functions by RMB clicking on them as well. We will 

discuss several of these additional features throughout 

this book.

Now that we have the very basics of what each element in the UI is, let’s focus 

a little more on some specific tips for navigation and getting around.

Menus, Features, and Moving Around

The menu bar along the top of the interface contains a large number of the 

most commonly used functions in 3ds Max. For almost every single button 

or icon you can click on, there is likely a menu function associated with it. 

As we move forward in the lessons, menu items are referenced as Menu 

Name Submenu Menu Item. For example, if you needed to create a cylinder, 

you could do so by LMB clicking Create Standard Primitives Cylinder in the 

menu bar.

Navigating the viewports, Interface, and 3D Space

The default Main toolbar found under the menu bar.
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Directly underneath the Main toolbar are the graphite modeling tools. This 

new toolset contains a series of tools new to 3ds Max 2010, as well as a neatly 

organized collection of some of the most commonly used functions while 

creating 3D geometry. Without having created anything yet you will not see 

many options, but as you begin to build your assets these tools will come to 

life with all sorts of features and functions to improve your modeling speed 

and quality. To expand the menus, simply LMB click on any of the tabs to access 

their features.

Tip: 
Hovering your mouse over a vast 

majority of the icons and buttons in the 

Main toolbar will show you the name 

of that button. If you wonder what that 

button does specifically, try looking it up 

in the Help menu.

A small example of the many features in the graphite modeling toolset.

As you have already noticed, the predominant real estate on screen is four 

separate windows into 3D space, called viewports. These windows each 

represent a different view of your scene or asset. To access any of the viewports 

individually, you do so by LMB, RMB, or MMB clicking the desired viewport. You 

will see a yellow highlight along the border of the viewport you currently have 

selected.
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If you would like to maximize any of the views on your screen, rather than 

working with all four of them open, you can do so by first accessing your 

desired viewport and then pressing Alt + W on your keyboard. Alternatively, 

at the very bottom right corner of the UI you can also press the Maximize 

Viewport Toggle to maximize or minimize the currently accessed viewport.

Working with a maximized viewport is a personal preference, but it definitely 

increases the visual workspace of your scene or asset. To quickly move back and 

forth between the various viewport options, you have more than one way to do 

it. RMB clicking on the Perspective title in the upper right-hand corner of your 

viewport can allow you to LMB click any of the desired views to choose them. 

Alternatively, using the hotkeys can be a quick option as well.

Press Alt + W or use the Maximize Viewport Toggle to maximize your 

selected viewport.

RMB click on the name of your current viewport to 

bring up additional view choices.
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In any viewport, to drag the camera around freely, MMB click and hold 

anywhere in any of the viewports left, right, or up and down, and you will drag 

the camera in that direction. Keep in mind that this does not actually move 

anything in your scene, it simply moves the camera that is pointed at your 

scene.

The Viewport Configuration window with the Layout tab selected.

Tip: 
If you want to work with multiple viewport windows, 

there are a couple options to customize the look 

of them. LMB click on the very center of the four 

viewports and you will see the icon change, allowing 

you to drag the windows to the size you deisre. 

Also, you can access preset configurations by clicking 

the + button at the top of any of the viewport windows 

and choosing Configure, and choosing the Layout tab. 

Here you can choose any of the premade layouts and 

then click OK. 

You can also access this window under Views  

Viewport Configuration.
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Rolling the MMB up or down will cause your camera to zoom forward or back. 

Holding down the Alt button while rolling the MMB will slow the speed of 

zoom.

Holding down the Alt and the MMB simultaneously will cause your camera to 

roll around the object in 3D space.

Use the Zoom Extents or Zoom Extents All choices to frame your selection  

inside the current viewport.

Tip: 
The Z key is the default hotkey for Zoom 

Extent All Selected. Get used to quickly 

moving around in 3D Space and then 

tapping the Z hotkey to quickly reframe 

your scene.

If at any time during your camera movements you want to get back to the 

center of the grid (known as 0,0,0) or frame the camera on your selected 

object(s) you can either click the Zoom Extents to center in just one currently 

active viewport, or the Zoom Extents All option will frame all of the viewport 

windows you currently have open.
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Navigating the Command Panel
The Command Panel along the right side of the UI is where a large number of 

creation and adjustments are made to geometry. Aside from the new graphite 

tools, this is also where the majority of the polygonal mesh functions are found 

as well. While there are a large amount of tools to cover, for the first project we 

will focus on just a few.

To access the various tabs, pull-down, or objects from the Command Panel, 

simply hover your mouse over the desired selection and LMB click it.

The Create tab features the majority of objects to create, ranging from various 

3D and 2D shapes, cameras, lights, and more. Under the Create tab there are 

many other subgroups as well as pull-down menus for all the different things 

you can create. Keep in mind that any of these shapes or objects are simply 

building blocks for the objects we will be creating.

The Modify tab is where specific adjustments are made to the specific selected 

objects, as well as the many modifiers we will use when working with 3D. If you 

have nothing selected it will be blank, because you have nothing selected to 

modify.

The Hierarchy tab is where adjustments to an object’s pivot point can be made, 

or we can utilize the working pivot. We will dive further into this later.

The Motion tab is focused more for animation and trajectories.

The Display tab allows you to quickly filter what is being shown on screen with 

various category options.

The Command Panel, with the Create  

tab selected, Geometry option chosen,  

and Box selected.
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The Utilities tab has a preset collection of various unique tools and functions.

As you may notice, there are several submenus in the Command Panel. In the 

example to create a Box, you can see Object Type, Name and Color, Creation 

Method, Keyboard Entry, and Parameters as the submenus. To expand or 

collapse submenus inside of the Command Panel, simply hover your mouse 

over the name of the submenu, and LMB click to expand or collapse. 

The Command Panel, with several of 

the submenus collapsed.
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Now that you understand the very basics of the interface as it pertains to 

game asset modeling, let’s go ahead and create our first object in 3D space. 

Keep in mind that we will be exploring a large amount of the interface as we 

move forward, but hopefully you are starting to get familiar with it.

Create a geometry box.

For your first object, let’s create a simple box.

In the Command Panel, select the Create tab, the Geometry 

option, and the Box as the Object type.

In the Perspective viewport, hold the LMB and drag it around 

anywhere in the viewport. As you are moving the box around 

in the viewport, you are identifying its length and width.

Release the LMB, and move the mouse up or down in the 

viewport. This is identifying the object’s height.

When you get a height you are happy with, click the LMB 

again.

Start by dragging the box in the Perspective viewport.

Creating and naming objects in 3ds Max 2010
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FG02_013_DragUp.tif

Name the box and change its color.

Now that you have created your first box, let’s name it 

something and change its color.

Start by selecting your box. You do this by LMB clicking on the 

box in the viewport.

In the Command Panel, under the Name and Color submenu, 

type in a new name for your box.

Next to the name, you should see a color box. In my example 

you can see it as a green box. Yours might be a different color 

because by default 3ds Max will randomly choose a color for 

you when you create a new object.

Click the color box using the LMB and a new window should 

appear.

In the Object Color window, pick any color you want to 

change the color of your box.

Move the mouse up to identify the box height.

Tip: 
In the Object Color window, you can turn off the 

random color generation by unchecking the box 

next to Assign Random Colors. Any color you choose 

will be the default color of all of your objects you 

create from now on.
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Now that you have created your first object in 3D space, feel free 

to play around with other shapes. The creation method for many of 

them is very similar and we will further explore more primitives in 

the next chapter. Regardless of which shape you create, there are a 

few methods to adjusting how you view objects in 3D space.

For whichever viewport you are in, you will notice there are several 

different viewport options in the top left-hand corner of the 

viewport itself. By default when you start max, the setting should 

be [Smooth + Highlights], as indicated between the two [ ] brackets. 

This setting is how the object inside the viewport is rendered, in 

this case, you can see smoothing on rounder or softer geometry, 

and there will be a lighting highlight. You can change this by LMB 

clicking on the [Smooth + Highlights] option and selecting a 

different view as you choose.

Changing the display of objects you create

Change the color and name of your box.
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The Default [Smooth + Highlights] viewport setting on a sphere.

The option changed to [Wireframe] viewport setting on a sphere.



Workbook3dsMax Skills 
46

Sk
il

ls
2010WorkbookWorkbook

3D Visualization & Animation Competition

It is also possible to select [Smooth + Highlights] and [Edged Faces] at the same 

time as well.

The [Smooth + Highlights] and [Edged Faces] both selected in the viewport.

Tip: 
While it is possible to change these visual choices in the drop-down menu, 

getting used to using the hotkeys for them will greatly speed up your 

workflow. As you start working with more complex scenes and objects, you 

will constantly be going back and forth between wireframe, flat shaded, 

and shaded + edge faces.

The default hotkey to toggle back and forth between [Smooth and Highlights] 

and [Wireframe] view modes is F3.

The default hotkey to turn [Edged Faces] on and off is F4.
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Create a new folder for your project.

After clicking this, the Browse For Folder window will pop up asking you for 

where you want to set the root of your project folder. Think of this as the place 

on your computer where you want to store everything associated with this 

project. Navigate to where you want to store your project, LMB click the Make 

New Folder button and rename the folder.

When you start working with a scene in 3Ds Max, either through the course 

of this book or on your own, it is a good idea to start getting into the habit of 

setting up your project folders before you begin. While at first it is simply good 

to keep track of your 3ds Max files, as your scenes start to get bigger and bigger 

and contain multiple different assets, you will definitely want to keep track of 

all of them.

Set your project path.

To set up your project path, click the icon in the upper-left corner.

Clicking this icon in the upper-left corner if your UI will allow you to set a path for 

your project.

Create a new project folder named 

My3dsMaxProject on the desktop.

Setting a project folder
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Choose your file options.

As you hover over the different menu items under the File Options, you will see 

additional options and explanations pop up in the right side of the menu. Some 

of the more common file options you should be familiar with are as follows.

Saving your scene
Few things are more important than saving and backing up your work. Since we 

set up a project folder, by default when you attempt to save your scene it will 

drop it under the scenes folder inside of your project.

Click the 3ds Max icon to access your file options.

To start with, click the File icon (which is the large 3ds Max icon) in the top-left 

corner of the menu bar to bring up your file options.

Clicking the 3ds Max icon will bring up your file options.
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New—These options can maintain some of your current scene settings, but will 

create a new 3ds Max scene for you.

Reset—Think of Reset as a whole fresh new scene. This is the same as restarting 

3ds Max. You will lose all of your current settings and they will go back to the 

default.

Open—As expected, this is the option to open previous 3ds Max files.

Save—The default save. The first time you Save it will direct you to the scene 

folder of your project folder structure. You can, however, choose to save your 

scene anywhere you wish.

Save As—Similar to the normal Save, but also includes the options to use an 

incremental save as well as saving only selected objects in your scene. The

Save As Save Selected option will take only what you currently have selected 

in your scene and save that as a completely unique file. The Save Copy As 

option will automatically add a numeric extension to the end of your file. For 

example, if your scene is called MyScene, using the File Save As Save Copy As 

will automatically attempt to save your scene as MyScene01. This is optional, 

but it is definitely helpful when you want to be able to save your scenes in 

chronological order or have a safe point to go back to later.

Import / Export—The Import and Export options are useful when working with 

various file types that may have been exported from other software packages, 

as well as merging 3ds Max files together. We will cover this more in Chapter 6.

File Save As Save Copy As will automatically add a numeric extension to your file 

name.
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What primitives are

Before you can start building the world’s best game level, or the coolest game 

character anyone has ever seen, the forms and shapes to make those things 

almost always start with primitives. Primitives are the very basic 3D shapes that 

make up the foundations of more complex shapes. In 3D modeling, primitives 

are used as the rough first-pass shapes that an artist may create before adding 

to the model to make it more complex. For example, a skyscraper or a might 

start with a box. A fireman’s pole might start as a cylinder. A bed sheet—a 

plane.  

Look at the world around you. You are surrounded by boxes, cylinders, spheres, 

planes, and tubes. This very book you are holding is made up of a series 

of primitives! Whether you are creating props for a game or a game level, 

primitives are the building blocks that every artist must control before moving 

on to more complex 3D modeling. Even Michelangelo started with a box.

Standard primitives

Let’s take a look at some of the more commonly used primitives and a brief 

description of them. While this is not all of the primitives you can create in 3ds 

Max 2010, these are some of the more commonly used ones you will want to 

familiarize yourself with as you begin to work in 3D.

Cone—The cone is a 

slightly tapered cylinder 

that can either have two 

flat ends, or one flat end 

and one sharp point.

Box—The box is the simplest and 

most primitive of them all, but from 

which an enormous amount of 

shapes can ultimately emerge. Also 

known as a cube, the box is created 

with a default six sides.

Sphere—The sphere is a round ball. 

By default, the sphere has a uniform 

circumference and radius.

Cylinder—The cylinder 

is a round primitive that 

extends along a height 

parameter, and the radius 

can be adjusted as well.

Tube—The tube is a hollowed out 

cylinder  

that has geometry along the outside 

as well as the inside.

Torus—The torus 

primitive is a wheel 

or tube shape that 

forms a circle. 
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Extended Primitives

A bit more complex are the extended primitives. These shapes attempt to 

bridge the gap between the basic primitives and editable polygon objects, 

which we will discuss further in Lesson 5. We will not list all of them here, but 

there are a few shapes you might fight useful as you begin to use primitives.

Pyramid—The pyramid is a simple 

five-sided shape, with four of the 

sides meeting at a point.

Plane—The plane is a very simple 

flat piece of geometry with no 

height or width. Think of it as a flat 

sheet of polygons.

Chamfer Box—The chamfer 

box is very similar to the 

regular box primitive, but you 

have the ability to round off 

the edges—also known as 

chamfering.

Chamfer Cylinder—The chamfer cylinder is very 

similar to the regular cylinder primitive, but 

just like the chamfer box, you can chamfer the 

edges as well.

Oil Tank—The oil tank is 

a cylindrical shape with 

rounded caps on both 

ends.

Capsule—The capsule is similar to 

the oil tank, but fully rounds off the 

ends.

L-Extent—The L-extent 

extended primitive creates 

an elbow joint shape similar 

to the letter L.

C-Extent—The C-extent extended 

primitive creates a corner joint 

shape similar to the letter C.
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Creating Standard Primitives

In the previous chapter we briefly discussed how to create your first box. Many 

other primitives are created in a very similar fashion. Let’s discuss some of the 

more commonly used primitives and identify exactly how to create them.  

Create a primitive box.

For our first primitive, let’s create that simple box again.

In the Command Panel, select the Create tab, the Geometry option, and choose 

the Box as the Object Type.

In the Perspective viewport, hold the LMB and drag it around anywhere in the 

viewport. As you are moving the box around in the viewport, you are setting its 

length and width.

Release the LMB, and move the mouse up or down in the viewport. This is setting 

the object’s height.

When you get a height you are happy with, click the LMB again.

Start by LMB dragging the box in the Perspective viewport.

Move the mouse up to set the box’s height.

Choosing Cube from the Creation Method submenu.

Tip: 

From the Creation Method submenu for the Box, you can choose the 

option of Cube instead of Box, and when you LMB drag in the viewport, all 

of the parameters (length, width, height) will be uniform. 
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Create a primitive sphere.

For our second primitive, let’s create a sphere.

Select the Geometry option and choose Sphere as the Object Type.

In the Perspective viewport, hold the LMB and drag it around anywhere in the 

viewport. As you are moving your mouse around in the viewport, you are setting 

the sphere’s radius.

When you get a radius you are happy with, release the LMB.

When you get a height you are happy with, click the LMB again.

Start by LMB dragging the cylinder in the Perspective 

viewport.

Move the mouse up to set the cylinder’s height.

Create a primitive cylinder.

For our next primitive, let’s create a cylinder.

Select the Geometry option and choose Cylinder as the Object Type.

In the Perspective viewport, hold the LMB and drag it around anywhere in the 

viewport. As you are moving the shape around in the viewport, you are setting the 

cylinder’s radius.

Release the LMB, and move the mouse up or down in the viewport. This is setting 

the cylinder’s height.
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Create a primitive tube.

For our next primitive, let’s create a tube.

Select the Geometry option and choose Tube as the Object Type.

In the Perspective viewport, hold the LMB and drag it around anywhere in the 

viewport. As you are moving the shape around in the viewport, you are setting the 

tube’s Radius 1, which ultimately can be either the inner or outer radius.

Release the LMB, and then move the mouse left or right in the viewport. This will 

determine the tube’s Radius 2 parameter, which is either the inner or outer radius.

When you get a radius you are happy with, click the LMB again.

Move the mouse up or down in the viewport to determine the tube’s height.

When you get a height you are happy with, click the LMB again.

Start by LMB dragging the tube in the Perspective viewport to set the Radius 1.

Move the mouse left or right to set the tube’s Radius 2.

LMB click, and then move the mouse up or down to set the tube’s 

height.
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Create a primitive plane.

For our next primitive, let’s create a plane.

Select the Geometry option and choose Plane as the Object Type.

In the Perspective viewport, hold the LMB and drag it around anywhere in the 

viewport. As you are moving your mouse around in the viewport, you are setting 

the plane’s length and width.

When you get a size you are happy with, release the LMB.

Creating Extended Primitives

Creating extended primitives works very similarly to standard primitives. Like 

the standard ones, some of the parameters have specific creation requirements 

depending on the primitive you are trying to make.

As you may have noticed, the extended primitives are not in the same creation 

area as the standard primitives. To access the Extended Primitives, or other 

geometric shapes to create, in the Command Panel, select the Geometry option 

and LMB click on the drop-down menu. By default it should be set to Standard 

Primitives. Select Extended Primitives to change the different object types and 

reveal a new set of primitives.

Creating the plane in the Perspective viewport.

LMB click the drop-down 

menu and choose Extended 

Primitives.

A new list of primitives 

appears.

Tip: 

From the Creation Method submenu for the Plane, you 

can choose the option of Square instead of Rectangle, 

and when you LMB drag in the viewport, both of the 

parameters (length and width) will be uniform. 
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Create an extended primitive chamfer box.

For our first extended primitive, let’s create a chamfer box.

From the Command Panel, select the Create tab, the Geometry option, 

Extended Primitives drop-down, and choose ChamferBox as the Object Type.

In the Perspective viewport, hold the LMB and drag it around anywhere in the 

viewport. As you are moving the object around in the viewport, you are setting 

the chamfer box’s length and width.

Release the LMB, and move the mouse up or down in the viewport. This is setting 

the object’s height.

When you get a height you are happy with, click the LMB again.

After clicking the LMB to get the height, move the mouse left-to-right to 

determine the Fillet amount, also known as the chamfer amount.

Start by LMB dragging the box in the Perspective viewport.

Move the mouse up to set the box height.

Move the mouse left to right to set the fillet amount.
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Create an extended primitive chamfer cylinder.

For our next extended primitive, let’s create a chamfer cylinder.

Select the Geometry option and choose ChamferCyl as the Object Type.

In the Perspective viewport, hold the LMB and drag it around anywhere in the 

viewport. As you are moving the object around in the viewport, you are setting 

the chamfer cylinder’s radius.

Release the LMB, and move the mouse up or down in the viewport. This is setting 

the object’s height.

When you get a height you are happy with, click the LMB again.

After clicking the LMB to get the height, move the mouse left-to-right to 

determine the Fillet amount, also known as the chamfer amount.

Start by LMB dragging the chamfer cylinder in the Perspective viewport. Move the mouse up to set the chamfer cylinder’s 

height.

Move the mouse left to right to set the fillet amount.
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Create an extended primitive L-extent.

For our next extended primitive, let’s create an L-extent.

Select the Geometry option and choose the L-Ext as the Object Type.

In the Perspective viewport, hold the LMB and drag it around anywhere in the 

viewport. As you are moving the object around in the viewport, you are setting 

the L-Ext’s Side and Front lengths.

Release the LMB, and move the mouse up or down in the viewport. This is setting 

the object’s height.

When you get a height you are happy with, click the LMB again.

After clicking the LMB to get the height, move the mouse left-to-right to 

determine the Side and Front widths.

When you get a width you are happy with, click the LMB again.

Move the mouse left to right to set the L-extent’s width.

Start by LMB dragging the L-extent in the Perspective viewport.

Move the mouse up to set the L-extent’s height.
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How to alter the parameters of the primitives 
you create

Regardless of which primitive you create, all of them have parameters that you 

can adjust. As you can expect, not all of the parameters are going to be the 

same, but the method for changing various parameters is.

Whatever setting you create a primitive to begin with can be altered to reach 

your desired result. Adding additional polygons, changing the height or radius, 

or even the overall scale can all be done even after you have created the 

primitive. Let’s look at how to adjust some of those parameters after you have 

created a primitive.

Adjust parameters of a primitive box.

For our first test, let’s change some parameters of a basic box.

Start by creating a standard primitive Box in the Perspective viewport.

After you have created the box, RMB click anywhere in the viewport to end the 

creation process.  After you do this, you will notice that you no longer have any  

parameters under the Create tab. This is because the creation process is done. 

Now it is time to edit the object.

Next to the Create tab in the Command Panel is the Modify tab. If you have 

nothing selected you will not see much other than the Modifier List, but by LMB 

clicking on the box, many of the original parameters we saw when we created the 

box are back.

After creating a box, RMB 

click in the viewport to 

end the creation process.

Under the Modify tab, many of the creation parameters are back.

From the Parameters submenu, LMB click on any of the Parameter values 

and type in some numbers in the box, or use the small arrow icon next to the 

parameter numbers to drag the values up and down with the LMB. This is the 

same as typing the numbers in manually, but is obviously less accurate. You can 

also add numbers to the length, width, or height segments to change those values 

as well.
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Adjust parameters of a capsule.

For our next object, let’s change some parameters of an extended primitive 

Capsule.

Start by creating an extended primitive Capsule in the Perspective viewport.

After you have created the capsule, RMB click anywhere in the viewport to end 

the creation process. 

Switch to the Modify tab and randomly alter the Parameters to get a different 

shape. Yours might look different than mine, depending on what you type in.

Changing the parameters of the same box to create a customized 

shape.

After creating a 

capsule, RMB click in 

the viewport to end the 

creation process.
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Moving, rotating, and scaling primitives in 
your scene

Now that you understand the basics of creating primitives, it is important that 

you understand how to manipulate them. Once you have created them, you will 

want to move and alter them around in 3D space, and you can do that with the 

move, rotate, and scale tools.

Move a primitive.

For our next exercise, let’s move a primitive around in 3D space.

Select the Geometry option, select and create any primitive you want to move.

Ensuring you have the primitive selected, press the Move tool on the Main 

toolbar, or use the W hotkey on your keyboard. You will notice an icon appear on 

your primitive. This is known as the Move gizmo or widget.

Rotate a primitive.

Next, let’s rotate a primitive around in 3D space.

Select the Geometry option, select and create any primitive you want to rotate, 

or use the same object as before.

Ensuring you have the primitive selected, press the Rotate tool on the Main 

toolbar, or use the E hotkey on your keyboard. You will notice the icon change to 

the Rotate gizmo on your primitive.

The Move tool selected on the 

Main toolbar.

The Move gizmo appears with 

our Teapot primitive selected.

The Rotate tool selected on the Main toolbar.

The Rotate gizmo appears with our Teapot primitive 

selected.

LMB click and hold the Move gizmo on any of the small directional arrows.

Move the mouse in the direction that the arrow is pointing to move your object in  

3D space.

LMB click and hold the Rotate gizmo on any of the colored lines to select that 

direction for rotation.

Move the mouse in the direction that the arrow is pointing to move your object in 

3D space.
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Scale a primitive.

Next, let’s scale a primitive.

Select the Geometry option, select and create any primitive you want to scale, or 

use the same object as before.

Ensuring you have the primitive selected, press the Scale tool on the main toolbar, 

or use the R hotkey on your keyboard. You will notice the icon change to the Scale 

gizmo on your primitive.

LMB click and hold on the Scale gizmo on any of the colored directional lines to 

select that direction for scaling.

Move the mouse in the direction that the line is pointing to scale your object in 

3D space.

To do a Uniform scale, LMB click and hold on the yellow center of the gizmo and 

drag the mouse in any direction.

The Scale tool selected on the main toolbar.

The Scale gizmo appears with our Teapot primitive selected.
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What modifiers are

When you start to build geometry in 3D space, you may find yourself wanting 

to add a little more to the objects you create. You may also find that the 

default shapes are not exactly giving you the results that you want. Modifiers 

are tweaks and features that you can add to primitives or geometry in order to 

alter their original state, and give you a different result from the original.

For example, a Bend modifier may allow you to take a cylinder you made 

and put a curve into it. One of the FFD modifiers could allow you to stretch 

and skew your mesh all you want. The Symmetry modifier could save you a 

considerable amount of time by mirroring your geometry over to the other 

side so you only have to model half of it. These are just a few examples of the 

different results you can achieve with modifiers.

How to apply a modifier

While the list of all the different modifiers is quite extensive and their results 

can be vastly different from each other, the way to apply any modifier to an 

object is the same. Let’s start with a very simple shape, apply a modifier, and 

then adjust some parameters.

Create a primitive box.

For our first modifier, let’s 

add one to a simple box with 

four length, width, and height 

segments. Start by creating that 

box.

Select the box, and then apply a modifier to it.

As you may have noticed, at the top of the Command Panel in the Modify tab 

under the name of the object, there is a drop-down menu titled Modifier List. LMB 

clicking anywhere on the Modifier List will expand it, and the available modifiers 

will appear.

With the box you created selected, LMB click the Modifier List to expand the 

available modifiers.

From the available modifiers listed, scroll down until you find the FFD 2x2x2 

modifier and LMB click it to apply it to your box.

Create a box primitive with four 

length, width, and height segments.

Expand the modifier list and select FFD 2x2x2 to apply it to your 

box.

Now that you have applied the modifier to your box, there is a new 

set of available options. You will also notice that the name of the 

modifier FFD 2x2x2 has appeared above your object’s name in the 

Command Panel.  This is known as the modifier stack. At the top 

of the stack we can see that we have the FFD 2x2x2 modifier, and 

underneath it is the original box. Think of modifiers as “extras” 

that we are adding to the original object, without losing any of 

the information of it unless we want to. The original box will stay 

exactly the same regardless of what we do to the modifier above 

the stack. 
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Currently the top level of the stack is selected, and as you can see the parameters 

in the Command Panel are specific for the FFD 2x2x2 modifier. However, if we 

would like to go back down and adjust the parameters of the original box, we can 

do that by LMB clicking the word Box under the FFD 2x2x2 modifier. This is called 

“Moving down the stack.”

Move down the modifier stack and adjust the parameters of the original box.

Now that you know how to move down the stack, let’s adjust the original box 

parameters.

With the box you created selected, LMB click on the word Box in the Command 

Panel to move down the modifier stack.

Change the Parameters to 20 length, width, and height segments.

A modifier has been applied to the 

box, creating a modifier stack.

Moving down the stack by LMB 

clicking the original object underneath 

the modifier.

Move down the stack and change the parameters to 20 length, width, and 

height segments.

Make some adjustments to the object with the FFD 2x2x2 modifier.

After changing the original box’s parameters, go back up to the top of the stack and 

let’s change the shape of the box using the FFD 2x2x2 modifier.

With the box selected, at the top of the modifier stack with FFD 2x2x2 selected, 

press the small plus sign next to the name of the modifier to expand the subobject 

options and select Control Points. This is a subobject mode selection of the 

modifier. We will discuss subobject modes extensively in future chapters.
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With Control Points option selected, hold the LMB and drag select a control 

point at any of the corners of your object to select them. The FFD modifier has 

added these control points to allow you to make changes to your object as you 

wish. Next, with a control point selected, use the Move tool to move the control 

point in any direction, changing the shape of the box entirely.

Now that you have made an adjustment to your mesh with your first modifier, feel 

free to move other control points and adjust parameters of the original object and 

see what sort of results you get with the object.

Press the small plus sign next to the 

name of the modifier to expand its 

subobject selection modes. When 

expanded, it will change to a minus 

sign.

Moving a control point to change the shape of the box.

Random parameter changes and adjustments to the control 

points to get a different shape.
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If you decide you do not want to use the modifier anymore and wish to go back 

to the original object, you can delete the modifier by RMB clicking on the top 

of the modifier stack on the name of the modifier, and LMB clicking Delete. 

Alternatively, you can LMB select the modifier in the stack, and then LMB click on 

the small Trashcan icon under the modifier stack. Keep in mind that deleting the 

modifier will remove it forever, and you will not have your custom shape anymore.

From the Parameters submenu select the Bend modifier, LMB click and hold the 

small spinners next to Angle and Direction and drag them up or down to randomly 

change the parameters of the Bend modifier. You can also type in parameters and 

see what your results are. 

Deleting the modifier; going back to the default primitive.

Using Modifiers in your workflow

While we will not cover every single modifier in this book, let’s look at just a 

couple of the commonly used modifiers and a brief description of them.

Apply the Bend modifier.

For our next primitive, create a cylinder and add a Bend modifier. The Bend 

modifier attempts to do just like what it sounds like: bend your geometry any way 

you want it to.

From Standard Primitives, create a Cylinder and set it to a radius of 20, height of 

80, height segments 10, cap segments 1, and sides 18.

LMB click the Modifier List drop-down and choose the Bend modifier. 
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Apply the Symmetry modifier.

Next, create a teapot and apply a Symmetry modifier. The Symmetry modifier 

works like a mirror along the axis of an object, copying what you have on one side 

over to the other.

Select Standard Primitives and create a Teapot with Radius set to 40 and 

Segments  

set to 6.

LMB click on the Modifier List drop-down and choose the Symmetry modifier. 

Layers

Another important feature of working with 3ds Max 2010 is the built in Layer 

Manager. Layers play an important role in working with 3ds Max, because they 

allow you to work with multiple objects or pieces of your scene without having 

all of them visible all the time. The objects still exist in your scene, but layers 

allow you to quickly and easily hide or unhide objects in the scene as you wish.

The Layer Manager, available by LMB clicking the icon on the Main toolbar, is 

a tool where you can create and delete layers. You can also view and edit the 

settings for all of the layers in your scene, as well as the objects associated with 

them. You can specify the name, visibility, renderability, color, and more.

Creating a teapot and applying the Symmetry modifier to it gives it two 

spouts.

Access the Layer Manager by LMB clicking the icon on the Main 

toolbar.

Flipping the Symmetry 

modifier gives us 

a teapot with two 

handles.

By default, the Symmetry modifier is set to mirror along the axis of X, and your 

teapot should have two spouts and no handle. LMB click the Flip box under the 

Parameters to flip the symmetry to the other side, giving the teapot two handles 

instead.
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Layer Manager Interface Elements

Create New Layer—Creates a new layer containing any selected objects. The 

new layer’s name is generated automatically (Layer01, Layer02, and so on) 

but you can change it by clicking the label. Note: The new layer becomes the 

current layer.

Delete Highlighted Empty Layers—Deletes highlighted layers if they are empty. 

Note: This button is unavailable if the highlighted set of layers contains any 

of the following: nothing (that is, no layers are highlighted), the active layer, 

objects, Layer 0, or nonempty layers.

Add Selected Objects to Highlighted Layer—Moves currently selected objects 

into the highlighted layer. Note: This button is unavailable if nothing is selected 

or if more than one layer is highlighted.

Select Highlighted Objects and Layers—Selects all of highlighted objects, as 

well as all objects contained in any highlighted layers. Note: This button is 

unavailable if nothing is highlighted.

Highlight Selected Objects’ Layers—Highlights layers containing the currently 

selected objects and automatically scrolls so that highlighted layers are visible 

in the layer manager. Note: This button is unavailable if nothing is highlighted.

Hide/Unhide All Layers—Toggles the display of all layers.

Tip: 

This is most useful if you freeze all 

layers and then unfreeze only the layers 

you want to work on. 

Tip: 

This is most useful if you hide all layers 

and then display only the layers you 

want to work on. 

Freeze/Unfreeze All Layers—Toggles the frozen state of all layers.

List of Layers—Displays layers, their associated objects, and their properties. 

To expand or collapse the object list for each layer, click + (plus sign) or - 

(minus sign), respectively. To modify a property, click its icon. To select all 

layers quickly, RMB click and choose Highlight All. To open the Object/Layer 

Properties dialog box, LMB click on the icon next to the layer or object.

Tip: 

You can sort the layers by any of their 

properties by clicking on the column 

name. 
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Layers—Displays the names of the layers/objects. Click a name to select the 

layer, or to  

rename the layer. 

Note: 
Removing objects from the radiosity 

solution can significantly decrease 

radiosity processing and rendering time, 

however it does sacrifice some accuracy 

in the solution. It can be useful for 

creating quick test renders.

Note: 
Clicking the layer icon opens the Layer 

Properties dialog box for all highlighted  

layers. Clicking the object icon opens 

the Object Properties dialog box for all 

highlighted objects.

Current Layer Toggle—The unlabeled column to the right of the layer name 

indicates the current layer and lets you make a different layer current. A check 

mark appears next to the current layer. LMB click the check box next to another 

layer name to make it current.

Hide—Hides and unhides layers. When a layer is hidden, it is invisible. You 

might want to hide layers that contain construction or reference information.

Freeze—Freezes layers. You cannot select or edit objects on a frozen layer. 

Freezing a layer is useful if you want to view information on a layer for 

reference but do not want to edit objects on that layer.

Render—When on, objects appear in the rendered scene. Nonrendering objects 

do not cast shadows or affect the visual component of the rendered scene.

Color—Changes the color associated with the highlighted layers. You can select 

another color by LMB clicking the color swatch to display either the Object 

Color dialog box (for objects), or the Layer Color dialog box (for layers). You 

can set an object’s color independently, or turn on ByLayer in the Object Color 

dialog box to use the associated layer’s color.

Radiosity—When on, objects are included in the radiosity solution. Objects not 

included in the radiosity solution do not contribute to indirect illumination. 

If these objects are lights, only their direct contribution will be used for 

rendering. 
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Working with layers

Now that we have looked at the interface of the Layer Manager, let’s create a 

few pieces of geometry and add them to layers.

Create a collection of geometry we will add to layers.

Using what you have learned, create five standard primitive Boxes, Cylinders, and 

Spheres in the Perspective viewport.

LMB drag select the boxes in your scene, and bring up the Layer Manager by LMB 

clicking on the icon in the Main toolbar.

RMB click on our new Layer01 layer, and then LMB click Rename.

Rename the layer BoxesLayer.

Repeat the same steps for the spheres and cylinders, and create new layers for 

them called SpheresLayer and CylindersLayer.

Start by LMB dragging the box in the Perspective viewport.

Each of the layers renamed and objects added to them.

Create a new layer and rename it.

Next, let’s add the boxes to a new layer.

LMB click on the Create New Layer icon.

A new layer appears on the list, named Layer01. By default, since you had the 

boxes selected, the boxes are now added to this layer.

Adjust the settings of various objects in the layers.

Lastly, let’s adjust some parameters of the various layers and the objects inside of 

them.

Under the BoxesLayer select the icon to hide the layer group. Notice that the layer 

group disappears. The objects are not lost, but will remain hidden from view until 

we unhide.
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For the CylindersLayer, select the icon to freeze the layer group. Notice that after 

we freeze this layer the color has changed to gray. This is indicating to us visually 

that the layer is frozen and we can no longer adjust it until we unfreeze that layer.

Expand the SpheresLayer to reveal the objects in that layer, and change the colors 

of some of the spheres.

Copies, instances, and references

As you start to create more and more geometry, you may find yourself wanting 

to copy geometry, rather than having to create brand new geometry all the 

time and trying to match up the parameters. Trying to make 50 spheres one 

at a time could get rather frustrating! Aside from simply making a copy of 

an object, you can also create a version of the object that will allow you to 

adjust parameters of one and have it propagate to the other versions of itself. 

In 3ds Max 2010, these cloning methods are known as copies, instances, and 

references.

Adjusting the parameters 

of the various layers and 

objects inside of them.

A copy is simply a duplicate of an object. The new version will only retain 

the original shape of the object when copied, but after that it is completely 

independent of any other object in the scene. Think of a copy just like you 

would with a copy machine in an office. Once you have that copied piece of 

paper, if you make changes to the original or the copy, it will not affect the 

other one.

An instance is a duplicate of the original object, but will simultaneously mirror 

any changes to either versions of the object. For example if I have a Box 

primitive, I make an instance of that box, and then change parameters of either 

object, both objects will change together at the same time. The exception to 

this is moving, rotating, and scaling with the gizmos.

A reference is almost identical to an instance in that any changes to one will be 

applied to both objects. The difference, however, is that a reference can have 

additional modifiers applied to it, without affecting the other versions of the 

object, and give you an idea of what the final result will be after those modifiers 

are applied further down the stack. For example, if I have a Box primitive, I 

make a reference of that box, I can then apply additional modifiers to that box 

without affecting the other versions of it.

Make a copy of an object.

Let’s start with making a copy of an object.

Start by creating a Standard Primitive Sphere in the Perspective viewport.

After you have created the sphere, select the sphere and then select the Move 

tool, or use the W hotkey.

With the sphere selected, choose any direction of the Move tool, and while 

holding down the Shift button on your keyboard, LMB drag that direction, and 

once you have a distance you are happy with, release the LMB.

The Clone Options dialog box will pop up. Make sure that Copy is selected, type 

in 2 for Number of Copies, and then LMB click OK to create the copies.
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You will now have three spheres in the scene—the original sphere you created, 

and the two copies you made. You should also notice how the spheres are spaced. 

However far you drug the sphere the first time before releasing the LMB is how 

far apart each of the copies will be from each other.

Make an instance of an object.

Next, let’s do the same method, but this time choose instance.

Start by creating a standard primitive teapot in the Perspective viewport.

With the teapot selected, hold down the Shift button on your keyboard, LMB drag 

that direction using the Move tool, and once you have a distance you are happy 

with, release the LMB.

When the Clone Options dialog box pops up, choose Instance, and type in 2 for 

the Number of Copies.

Hold down Shift and drag the Move tool to bring up the Clone Options.

Three spheres will now be in the scene, evenly spaced.
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Several things will have changed as you will notice. The object name in the 

Command Panel under the Modifier List has been bolded, and any adjustments 

you make to the teapot’s radius or segments will apply to all three of the teapots. 

If you were to add a modifier to any of the teapots, it too would affect all of the 

other instances.

Create a teapot and make two instances of it.

Changing the parameters of one instance affects them all.
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Make a reference of an object.

Finally, let’s create a reference. A reference will work almost exactly the same as an 

instance, but we can add modifiers to the reference and see what the final outcome 

will be as we adjust parameters of the other version of the object.

Start by creating a standard primitive Box in the Perspective viewport, and give it 

10 length, width, and height segments.

With the box selected, hold down the Shift button on your keyboard, LMB drag 

that direction using the Move tool, and once you have a distance you are happy 

with, release the LMB.

When the Clone Options dialog box pops up, choose Reference, and leave the 

Number of Copies at 1.

As you will notice, the object name in the Command Panel from the Modifier 

List has been bolded just like an Instance, and a new dark gray bar has appeared. 

This is where new modifiers will appear if you add them to either one of the two 

references. Add an FFD 2x2x2 modifier to either of the references and adjust the 

control points. The gray bar will stay on the modifier stack as an indication that it 

is used in conjunction with the reference. But, as you notice, the modifier is only 

affecting one of the boxes.

Create a Box and make 1 Reference of it.

Changing the parameters of one instance affects them all.
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Lastly, go down the modifier stack by LMB clicking the Box in the modifier stack, 

and change the length, width, and height segments back down to 1. As you see, 

both of the objects’ default settings change, but the version with the modifier on 

it also retains the effects of the modifier itself.

Changing the parameters of one instance affects them all.
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What editable polygon objects are

While each of the basic primitives are a great building block when working 

with geometry in 3D, even with modifiers they will never give you complete 

capabilities to create everything you could possibly think of. Editable polygon 

objects are objects that have been converted to take advantage of the 

subobject modes that make up those objects.

The five subobjects that make up an editable poly are vertices, edges, borders, 

polygons, and elements. While these subobjects exist on all 3D objects, 

you can only manipulate them individually by converting your object to a 

polygonal surface. Cutting up your geometry and adding to it beyond the 

basic primitives is realistically only achievable with a polygonal object, such as 

converting it to an editable polygon.

How to convert a primitive to an editable 
polygon object

There are at least two quick and easy methods to converting your objects to 

an editable polygon object.  Once you have converted them to an editable 

poly, you will notice the entire Command Panel will change to access new 

features for the new editable poly object.

Access the Quad menu.

The first method to converting an object to an editable polygon object is to use 

the  

Quad menu.

Create a Box primitive in the Perspective viewport, and then RMB click it to 

bring up the Quad menu.

At the bottom of the menu, move your mouse down to the Convert To option to 

extend that menu, and LMB click Convert to Editable Poly.

Change it from within the Command Panel.

Another method is to simply convert it in the Command Panel.

From within the Command Panel, RMB click Object from the Modifier List and 

LMB click Editable Poly to convert it.

RMB click on a primitive and choose Convert to 

Editable Poly.

RMB click the object mode from the Modifier List, then 

LMB click the Editable Poly option.
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Navigating the newly changed command 
panel

You may have noticed a large amount of new menu items appear after 

converting your primitive to an editable poly. Do not worry—you will not have 

to master each and every single piece of information to be a decent 3D artist. 

But it is important to understand many of the features in order to successfully 

create the objects you set out to make. There are also several tips you will 

need to know about navigating this newly changed Command Panel.

Minimize and maximize submenus—We have 

mentioned this before, but it is important to 

remember that in order to expand or collapse the 

submenus in the Command Panel, all you need 

to do is LMB click the box that has the name of 

the submenu. You will find that when working 

with editable poly objects you will not need every 

single menu expanded, so it might be a good idea 

to collapse the ones you do not need.

Increase the width of the Command Panel—Another tip for maximizing the 

Command Panel is to expand the panel altogether. Along the edge of the 

Command Panel, where the panel meets the viewport, if you hover your 

mouse slightly you will see the mouse icon change. Holding down the LMB and 

dragging it to the left will allow you to “pull” the Command Panel out further to 

give more screen space to the different menu options.

The Command Panel with all but one 

submenu collapsed.

Holding the LMB and dragging left at the edge of the Command Panel allows you  

to stretch its width.

Put the submenus in your preferred order—When it comes to modeling in 3D for 

games and working with subobject modes, there are some common submenus 

you will use more often than others. One feature to help with this is to LMB 

click and hold any of the submenu titles, and then drag it up or down to your 

preferred order. So whether you choose to have expanded the Command Panel 

or to keep it small, you can choose which order your menus are in.
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Drag the Command Panel up or down—Lastly, it is 

important to know how to drag the Command Panel 

up or down if you choose not to expand it out. If 

you hover your mouse over any area that is not a 

button or a submenu, your icon will change to a 

small hand, allowing you to “grab” the panel and pull 

it up or down. Alternatively, there is a very small 

traditional scrollbar at the very furthest left side of 

the Command Panel. Either of these methods will 

drag the panel up or down.

How to change  between 
subobject modes

As you may have guessed, there are multiple ways 

to switch between the subobject modes. Depending 

on whether you are taking advantage of the vertex 

toolset or the polygon toolset, you will want to 

be able to quickly switch between the different 

subobjects to take advantage of specific tools 

available to each of the subobjects.

Using your keyboard, pressing 1-5 will switch 

between each of the subobject modes.

If you have an Editable Poly object selected, pressing 

the icon for any of the five subobjects under the 

Selection submenu will change between them.

When hovering your mouse over the 

Command Panel, a small hand icon 

appears allowing you to drag the 

panel up or down.

An Editable polygon object with the 

Polygon subobject mode selected.
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In the Graphite Modeling Tools menu, select the icons for the various subobject 

modes.

The various subobject modes can be selected from within the Graphite 

Modeling Tools menu. Tip: 

When we describe the various functions, 

some of them also contain a dialog box 

that allows for additional functions or 

settings than the default function. The 

dialog box is brought up by clicking 

the small box icon next to the normal 

function’s name.

Subobject modes

There are literally hundreds of various tools associated with each of the 

subobject modes. If you have looked at the different submenus under each of 

them, it is easy to become somewhat confused at the vast amount of options. It 

is not required to master them all, but feel free to experiment and see what you 

get! You can always utilize the powerful Help Menu by pressing F1, typing in the 

command you want to learn more about and experimenting on your own.

As you may have noticed as well, once you have converted an object to editable 

poly, the graphite modeling tools start to spring to life. This handy tool provides 

graphical icons and drop down menu descriptions that make understanding 

each of the functions of editable polygons that much easier. For many of the 

subobject tools, we will identify the name of the function and which submenu 

it falls under. Whether you choose to access it via the classic Command Panel 

or the new graphite tools is entirely up to you. The graphite tools do organize 

them a little more than the Command Panel does as well as provide a graphical 

icon for many of the functions, so it definitely makes a good learning tool for 

beginners and advanced modelers alike.

Here we will focus on three of the five subobject modes: Vertex, Edge, and 

Polygon. As we move throughout the book, we will utilize tools specific to the 

other subobject modes as well.
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Features of the Edit Geometry submenu

The Edit Geometry rollout provides global controls for changing the geometry 

of the poly object, at either the top (object) level or the subobject levels. The 

controls are the same at all levels, except as noted in the descriptions below.

To access a dialog box, LMB click on 

the small box next to the function you 

are using.

The Edit Geometry options are 

available to all of the subobjects, and 

can change slightly depending on the 

subobject.

Tip: 

To select multiple subobject pieces, hold down the Control button on your 

keyboard and then LMB click the desired element on your object. For example, to 

select more than one polygon, switch to the Polygon subobject mode, LMB click 

one polygon, hold down Control on your keyboard, and then LMB click another 

polygon to select more than one. To deselect the element, hold down the Alt key 

and LMB click or drag the subobject selection to deselect it.
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Repeat Last—Repeats the most recently used command.

Constraints—Lets you use existing geometry to constrain subobject 

transformation.  

Choose the constraint type:

None—No constraints. This is the default option. 

Edge—Constrains subobject transformations to edge boundaries. 

Face—Constrains subobject transformations to individual face surfaces. 

Normal—Constrains each subobject’s transformations to its normal, or 

the average of its normals. In most cases, this causes subobjects to move 

perpendicular to the surface.

Create—Lets you create new geometry. How this button behaves depends on 

which level is active:

Object, Polygon, and Element—Lets you add polygons in the active viewport. 

After you turn on Create, click three or more times in succession anywhere, 

including on existing vertices, to define the shape of the new polygon. To finish, 

RMB click. While creating a polygon at the Polygon or Element level, you can 

delete the most recently added vertex by pressing Backspace. You can do this 

repeatedly to remove added vertices in reverse order of placement. You can 

start creating polygons in any viewport, but all subsequent clicks must take 

place in the same viewport. 

Vertex—Lets you add vertices to a single selected poly object. After selecting 

the object and LMB clicking Create, LMB click anywhere in space to add free-

floating (isolated) vertices to the object. The new vertices are placed on the 

active construction plane.

Edge and Border—Lets you create an edge between a pair of nonadjacent 

vertices on the same polygon. LMB click Create, LMB click a vertex, and then 

move the mouse. A rubber-band line extends from the vertex to the mouse 

cursor. LMB click a second, nonadjacent vertex on the same polygon to connect 

them with an edge. Repeat, or, to exit, RMB click anywhere in the viewport or 

LMB click Create again.

Collapse— (Vertex, Edge, Border, and Polygon levels only) Collapses groups 

of contiguous selected subobjects by welding their vertices to a vertex at the 

selection center.

Attach—Lets you attach other objects in the scene to the selected poly object. 

After activating Attach, LMB click on another object to attach it to the selected 

object. The Attach operation remains active, so you can continue clicking 

on other objects to attach them as well. To exit, RMB click anywhere in the 

active viewport or click the Attach button again. Attaching a non-mesh object 

automatically converts it to the editable-poly format.

Detach— (subobject levels only) Detaches the selected subobjects and the 

polygons attached to them as a separate object or element(s). With an editable 

poly object, when you LMB click Detach, 3ds Max prompts for those options in 

the Detach Dialog.

Slice Plane— (subobject levels only) 

Creates a gizmo for a slice plane that 

you can position and rotate to specify 

where to slice. Also enables the Slice 

and Reset Plane buttons. LMB click 

Slice to create new edges where the 

plane intersects the geometry. To 

perform the slice, LMB click the Slice 

button.
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Slice—(subobject levels only) Performs the slice operation at the location of the 

slice plane.

Reset Plane—(subobject levels only) Returns the slice plane to its default 

position and orientation. Available only when Slice Plane is on.

QuickSlice—Lets you quickly slice the object without having to manipulate 

a gizmo. Make a selection, LMB click QuickSlice, and then LMB click once at 

the slice start point and again at its endpoint. You can continue slicing the 

selection while the command is active. To stop slicing, RMB click anywhere in 

the viewport, or click QuickSlice again to turn it off.

Cut—Lets you create edges from one polygon to another or within polygons. 

LMB click at the start point, move the mouse and LMB click again, and continue 

moving and clicking to create new connected edges. RMB click once to exit 

the current cut, whereupon you can start a new one, or RMB click again to exit 

Cut mode. While cutting, the mouse cursor icon changes to show the type of 

subobject it is over, to which the cut will be made when you click.

X/Y/Z—Makes all selected subobjects planar and aligns the plane with the 

corresponding plane in the object’s local coordinate system. The plane used is 

the one to which the button axis is perpendicular; so, for example, clicking the 

X button aligns the object with the local YZ axis. At the Object level, makes all 

vertices in the object planar.

Features of the Vertex subobject mode

Vertices are points in space. They define the structure of other subobjects 

(edges and polygons) that make up the polygon object. When you move or 

edit vertices, the connected geometry is affected as well. Vertices can also 

exist independently; such isolated vertices can 

be used to construct other geometry but are 

otherwise invisible when rendering. Some of the 

vertex-specific tools are as follows.

The Vertex subobject mode.
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Remove—Deletes selected vertices and combines the polygons that use them. 

The keyboard shortcut is Backspace.

Using the Target Weld to pick the 

original vertices to weld over.

Using Target Weld, the vertex is 

welded over to the vertex next to it.

A selection of vertices removed with the Backspace hotkey.

Break—Creates a new vertex for each polygon attached to selected vertices, 

allowing the polygon corners to be moved away from each other where they 

were once joined at each original vertex. If a vertex is isolated or used by only 

one polygon, it is unaffected.

Weld—Combines contiguous, selected vertices that fall within the tolerance 

specified in the Weld dialog box.  All edges become connected to the resulting 

single vertex. Inside of the Weld dialog box, you can specify the weld threshold 

- a number that represents the distance between vertices. The smaller the 

number, the closer the vertices need to be in 3D space for the weld to work. 

Weld is best suited to automatically simplifying geometry that has areas with a 

number of vertices that are very close together. Before using Weld, set the Weld 

Threshold via the Weld dialog box.  

Target Weld—Allows you to select a vertex and weld it to a neighboring target 

vertex.Target Weld works only with pairs of contiguous vertices; that is, vertices 

connected by a single edge. In Target Weld mode, the mouse cursor, when 

positioned over a vertex, changes to a + cursor. LMB click and then move the 

mouse; a dashed, rubber-band line connects the vertex to the mouse cursor. 

Position the cursor over another, neighboring vertex and when the + cursor 

appears again, click the mouse. The first vertex moves to the position of the 

second and the two are welded. Target Weld remains active until you click the 

button again or RMB click in the viewport.
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Connect—Creates new edges between pairs of selected vertices. Connect 

does not let the new edges cross. For example, if you select all four vertices of 

a four-sided polygon and then click Connect, only two of the vertices will be 

connected.

The Edge subobject mode.

Selecting a series of vertices and using the connect tool.

Features of the Edge subobject mode

An edge is a line connecting two vertices that forms the side of a polygon. An 

edge cannot be shared by more than two polygons. Some of the Edge subobject 

tools are as follows.
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Remove—Deletes the selected edges and combines the polygons that use them. 

Removing one edge is like making it invisible. The mesh is affected only when 

all or all but one of the edges depending on one vertex are removed. At that 

point, the vertex itself is deleted and the surface is retriangulated. To delete the 

associated vertices when you remove edges, press and hold Ctrl while using the 

Remove operation, either by mouse or with the Backspace key. This is called a 

Clean Remove, and it ensures that the remaining polygons are planar.

Chamfer Settings—Opens the Chamfer Edges dialog box, which lets you chamfer 

edges via interactive manipulation and toggle the Open option. If you click this 

button after performing a manual chamfer, the same chamfer is performed 

on the current selection as a preview and the dialog box opens with Chamfer 

Amount set to the amount of the last manual chamfer.

Selecting a series of edges for removal.Performing a clean remove of the 

edges with the Ctrl + Backspace 

hotkey.

Chamfering the edge of a box.

Chamfer—Click this button and then drag edges in the active object to execute 

a Chamfer. To chamfer edges numerically, RMB click the Chamfer Dialog button 

and change the Chamfer Amount value. If you chamfer multiple selected edges, 

all of them are chamfered identically. If you drag an unselected edge, any 

selected edges are first deselected.

 An edge chamfer “chops off” the selected edges, creating a new polygon 

connecting new points on all visible edges leading to the original vertex. The 

new edges are exactly <chamfer amount>  distance from the original edge along 

each of these edges. For example, if you chamfer one edge of a box, each corner 

vertex is replaced by two vertices moving along the visible edges that lead to 

the corner. Outside faces are rearranged and split to use these new vertices, 

and a new polygon is created at the corner.
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Bridge—Connects border edges on an object with a polygon “bridge.” Bridge 

connects only border edges; that is, edges that have a polygon on only one side. 

This tool is particularly useful when creating edge loops or profiles.

Using the bridge tool to connect two sets of disconnected edges.

Features of the Polygon subobject mode

A polygon is a closed sequence of three or more 

edges connected by a surface. Polygons provide the 

renderable surface of editable poly objects. Some of 

the polygon subobject  

tools are as follows.

Performing the Connect function on a series of selected edges.

The Polygon subobject mode.

Note:  
You can connect only edges on the same 

polygon. Also, Connect will not let the  

new edges cross. For example, if you 

select all four edges of a four-sided 

polygon and then click Connect, only 

neighboring edges are connected, 

resulting in a diamond pattern.

Connect—Creates new edges between pairs of selected edges using the current 

Connect Edges dialog box settings. Connect is particularly useful for creating or 

refining edge loops. 
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Extrude—Lets you perform manual extrusion via direct manipulation in the 

viewport. LMB click the button, and then drag vertically on any polygon to 

extrude it. Extruding polygons moves them along a normal and creates new 

polygons that form the sides of the extrusion, connecting the selection to the 

object. Following are important aspects of polygon extrusion:

When hovering over a selected polygon, the mouse cursor changes to an Extrude 

cursor.

Drag vertically to specify the extent of the extrusion, and horizontally to set the 

size of the base.

With multiple polygons selected, dragging on any one extrudes all selected  

polygons equally.

You can drag other polygons in turn to extrude them while the Extrude button is 

active. LMB click Extrude again, or RMB click anywhere in the active viewport to 

end the operation.

Bevel—Lets you perform manual beveling via direct manipulation in the 

viewport. Click this button, and then drag vertically on any polygon to extrude 

it. Release the mouse button and then move the mouse vertically to outline the 

extrusion. LMB click again to finish.

When over a selected polygon, the mouse cursor changes to a Bevel cursor. 

With multiple polygons selected, dragging on any one bevels all selected polygons 

equally. 

You can drag other polygons in turn to bevel them while the Bevel button is 

active. LMB click Bevel again or RMB click in the active viewport to end the 

operation.

Performing the Extrude function on a group of polygons.

Performing the Bevel function on a group of polygons.
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Inset—Performs a bevel with no height; that is, within the plane of the polygon 

selection. LMB click this button, and then drag vertically on any polygon to 

inset it.

When over a selected polygon, the mouse cursor changes to an Inset cursor. 

With multiple polygons selected, dragging on any one insets all selected polygons 

equally. 

While the Inset button is active, you can drag other polygons in turn to inset 

them. To end the operation, LMB click Inset again, or right-click anywhere in the 

active viewport.

Performing the Inset function on a group of polygons.

Selecting a series of adjacent polygons and using the bridge tool to connect them.

Bridge—Connects two polygons or polygon selections on an object with a 

polygon “bridge.” There are two ways to use Bridge in Direct Manipulation 

mode (that is, without opening the Bridge Dialog Box.)

Make two separate polygon selections on an object, and then LMB click Bridge. 

This will create the bridge immediately, using the current Bridge settings, and 

then deactivates the Bridge operation. 

If no qualifying selection exists (that is, two or more discrete polygon selections), 

LMB clicking Bridge activates the button and places you in Bridge mode. First, 

LMB click a polygon and move the mouse; a rubber-band line connects the 

mouse cursor to the clicked polygon. Click a second polygon to bridge the two. 

This creates the bridge immediately using the current Bridge settings; the Bridge 

button remains active for connecting more pairs of polygons. To exit Bridge 

mode, RMB click anywhere in the active viewport or LMB click the Bridge button 

again.
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Working with the Material Editor

Let’s start by opening the Material Browser. You can find the icon along the top 

of the Main toolbar, or use the keyboard hotkey M. 1

2 3 9 4

5
78

6
33 99 44

55
77

The Material Browser interface.

Tip: 

It is easy to get lost with all the buttons 

and menus with the Material Browser 

when you are first getting started. When 

in doubt, you can always use the Go to 

Parent button to find your way back to 

the top of a material node. You can also 

simply delete the material and start 

over.
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When you first open the Material Browser, there are plenty of new options and 

buttons to greet you. First, let’s get familiar with some of the most important 

buttons as they apply to this book, and a description of their usage.

1 Material Node—These are the icons that act as a visual representation 

of your material, with a small preview of what the material looks like. Double-

clicking the LMB will bring up a scalable pop-up window that allows you a closer 

look at your material.

2 Assign Material to Selection—Once you have a material created, this 

button will apply it to the object you have selected in your viewport.

3 Reset Map/Mtl to Default Settings—This button will essentially delete 

your material and all of the setups in it back to the default state. 

Tip: 

Remember that with any submenu in 3ds Max 2010, you can 

expand and collapse the menu by clicking anywhere on the 

box that has the name of the submenu. You can also “drag” the 

menu up and down by clicking anywhere in the gray area of 

the interface that is not a button and LMB click dragging it up 

or down. The icon will change to a hand when your mouse is 

anywhere that you can drag in a menu.

4 Go to Parent—This button is basically the “go back to the beginning“ 

button that will take you to the very top level of your material. As you begin to 

work with materials and textures, and the more complicated your materials are, 

you will want to remember this button to get back to the top level

5 Empty Box Input Nodes—any of these empty boxes represent a map or 

input that can be used for that parameter. For example, if we have created a 

diffuse (also known as color) map, LMB clicking the small box next to Diffuse” 

will give us the ability to add that map. When you have a map or a parameter 

value plugged into these nodes, the letter M will appear over these otherwise 

empty boxes. You can also RMB click on these nodes and choose Clear to 

remove the maps completely. This is helpful if you have accidentally clicked a 

node and added something you did not intend to.

6 Material Name—Each of the materials will have a number and the 

word Default next to it when you first begin work on your scene. If you wish to 

rename your material to something more relevant, simply replace the text in 

this box with the name of your choosing to replace it.

7 Opacity—Adjusting this value will alter how see-through your material 

is. 100 is the default meaning it is not see-through at all, and the closer you get 

to 0 the less visible the material is.

8 Default Color Picker—These gray boxes are color pickers. If you would 

like to create a material with just a color value, LMB click the gray box next to 

the word Diffuse to bring up the color picker and select a color of your choice.

9 Show Standard Map in Viewport—Causes the material to show on the 

3D object in the viewport. When rendered the material will generally always 

show up, but this button allows you to see it in 3D.
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Creating your first material

For our first material, we will set up a simple ground texture that could be 

used as a ground or floor piece in a level. Before we can even begin to texture 

our object we need to think about the surface it is going to be. If I am making 

something out of stone, a marshmallow texture might not work! 

So, the first thing I might do is find a 2D image that looks close to what I am 

attempting to re-create. In future chapters we will discuss further some of the 

art involved with texture painting, but for now let’s start with a simple image.

So for our first texture, we will take a square 2D image and put it onto a square 

shape in 3D.

Set up a new material node.

Press the M hotkey on your keyboard to open the Material Browser, or LMB click 

the icon on the Main toolbar.

On the very top-left blank material node, LMB click it to select it. A white outline 

appears over the material node to indicate it is your currently selected node.

Rename this material Ground_Floor. After you have entered the new name, you 

should also see the name appear at the top of the Editor window, indicating it is 

the current material node selected.

A basic cobblestone ground texture.

Select a new node and rename it.

This texture works well because it is flat, does not have many sharp or harsh 

shadows on the surface, and is not warped by any sort of odd perspective 

problems. Looking at this image alone, you could almost imagine it being laid 

out flat on geometry to create a road. Quality texture maps do not need a lot 

of cleanup or fixing to start with. If the image had a sharp shadow in it, what 

would happen in your game if you shined a flashlight on that spot? The shadow 

would show up and that would spoil the sense of reality on the surface.

The next important step of texture maps is to ensure that the size remains 

relatively close to the size of the target geometry. If we took this square shaped 

picture and tried to squeeze it into a really long and thin picture frame, it would 

not look right at all.
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Import your diffuse color map.

Under the submenu Blinn Basic Parameters, next to the diffuse, LMB click the 

empty node (the small empty box next to the gray color). This brings up a new 

window called the Material/Map Browser.

You should now see the surface of the ground replace the gray sphere in the 

Material Editor, giving you a small representation of what it looks like.

You will also see that you are in a different set of menus than previously. This is 

because you are now looking at the exclusive parameters of that diffuse texture 

and not the material as a whole. You will also see that the icon changed from 

Standard to Bitmap, indicating that you are working with a 2D bitmap, and not a 

standard material.

Select a new node and rename it.

Select a new node and rename it.The Material/Map Browser contains a multitude of various types of prebuilt maps, 

parameters, and input types; 2D texture maps are called bitmaps.

Select Bitmap at the top of the Material/Map Browser by double-clicking the LMB.

After you have clicked it, a browser pops up asking you where the image is.

Navigate to support_files/Project1/Lesson6/FG06_Ground.tif on the DVD for this 

ground texture to select it. Under the Bitmap Parameters submenu, you also notice that the path to the 

image is listed here. If you want to change it to a different texture, you could do so 

by LMB clicking on the box and redirecting the path.



Workbook3dsMax Skills 
93

Sk
il

ls
2010WorkbookWorkbook

3D Visualization & Animation Competition

Go back to the parent of the material.

Under the collection of material nodes, LMB click the Go to Parent icon to get 

back to the top of the material.

Apply the material to the plane by dragging it.

There are two quick methods for applying a material to an object. The first method 

is to drag the material node onto the object.

Open the Material Editor window if you have closed it with the keyboard hotkey 

M.

In the Perspective viewport, ensure that the plane primitive you created is in 

view.

Creating the sphere in the Perspective 

viewport.

Create a standard primitive plane in the Perspective viewport.

How to apply a material to an object

Now that we have created our first material, let’s create a simple plane apply 

the material to.

Create a standard primitive plane.

In the Perspective viewport, create a plane and give it a length and width value of 

100.

Set the length and width segments to 1.
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While holding the LMB, click and drag the Ground_Floor material onto the plane. 

When you do this, you will notice the icon change to a small square. Release the 

LMB to apply it.

Apply the material to the plane with the Assign Material to Selection function.

The second method to applying a material works almost exactly the same as the 

previous. The only difference is that you do not need to drag the material node at 

all, simply select the object and apply it.

Open the material editor window if you have closed it with the keyboard hotkey 

M.

In the Perspective viewport, ensure that the plane primitive you created is in 

view.

With the plane selected, LMB click the Assign Material to Selection button to 

apply the material to the plane.

LMB click and drag the material onto the plane.

After applying the material, turn on the Show Standard Map in Viewport to have 

to appear.

After you drop the material onto the object, your plane should turn gray. This is 

because we have not turned the material on to show up in the viewport. We do 

that by LMB clicking on the Show Standard Map in Viewport icon. This works as 

sort of an on and off switch to show the texture in the scene.
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If you have not already, make sure you turn Show Standard Map in Viewport on 

to see it.

LMB click the Assign Material to Selection to apply the material to a selected 

object.

A standard render of the plane, next to the viewport view of the object.

Close the Material Browser. You have now correctly applied a material, 

composed of a diffuse color map, to an object.

You can render the object with the keyboard hotkey F9 to see what it would look 

like at its highest quality, but we will cover more on rendering and composition in 

later chapters.
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Unwrap UVW Key Interface Elements

The Unwrap UVW modifier works just like any other modifier to apply it. After 

you apply it, you are given three subobject modes  Vertex, Edge, and Face. These 

are the three editable elements you will work with when it comes to UVs. Just 

like most all windows in Autodesk® 3ds Max®  2010 software, you can LMB click 

and hold along the border of the window to resize it as needed. You can also 

move the window to another monitor if you have that. Let’s look at some of the 

key elements of the interface to get started.

1 Edit UVW Window

This is the primary window where you will be working with the UVs of your 

object. To bring up the window, click the Edit… button under the Parameters 

rollout.

2 Currently Selected Subobject

When working with UVs, the subobject you select in the Edit UVW window will 

also appear shaded on your geometry in the 3D viewport. Switching between 

subobject modes works the same as an editable poly using the 1, 2, and 3 

hotkeys.

3 Move, Rotate, Scale, Freeform, and Flip Tools

These are some of the most commonly used tools in the set. As with many 

features in 3ds Max, LMB clicking them and holding down the button will reveal 

a rollout of various other tools as well. Similar to working in 3D, the hotkeys for 

Move, Rotate, and Scale are the same in the UV tools.

4 Quick Planar Map

We will be using this tool quite a bit when working with Unwrapping. Using the 

X, Y, or Z axis in 3D, we can use this tool to quickly lay out a selection of UVs.

5 Show Map Toggle

This toggle will show a selected image in the window, or a checkerboard 

pattern by default.

The Unwrap UVW Interface

Tip: 

While inside the Edit UVW window, hold 

down the MMB to drag the viewport 

around, and scroll the MMB up and 

down to zoom in and out .

6 Rotate and Align UV Tools

Use these tools to rotate UV chunks, or align subobject selections. Hover over 

each of them for a description.
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Create a checkerboard texture

As we begin to texture, we will want to assign a checkerboard pattern to our 

objects to make sure that there is not any unusual stretching or skewing of 

our UVs. Imagine for a moment that you make that box again, but the UVs 

are stretched and not laid out flat. The texture of that object would also look 

skewed and stretched if the UVs are not relatively the same dimensions of the 

object itself. A checker pattern will allow you to visually ensure there is no 

unusual stretching or skewing of the UVs.

Start by opening the Material Editor.

Select an unused Material node, and LMB click on the box next to the Diffuse slot.

When the Material/Map Browser window pops up, choose Checker as the map 

type by double-LMB clicking it.

When unwrapping, imagine a box being split apart and laid down flat. We 

will not actually change the original geometry, but when working with UVs, 

this is the goal in order to get a clean and easy surface to paint a texture on.

UVW unwrapping explained

When working in 3D, UVW unwrapping is used to describe the process of laying 

your object’s faces out flat into an informational 2D plane so that you can apply 

textures and materials to your object. The UVW coordinates of an object are 

basically a set of stored information inside of a piece of geometry that defines 

how a texture will look if applied to it.

The UVW coordinate system with regards to 3D is similar to the XYZ coordinate 

system you should be familiar with when modeling. However, when it comes to 

UVW unwrapping, the U and V axis of a texture map correspond to the X and 

Y axis, while the W axis correspond to the Z axis, and is generally only used for 

procedural maps, which we will not cover here. This is also why it is sometimes 

referred to as UV mapping or working with UVs and the W is omitted.

When unwrapping an object, you do not physically modify the actual geometry 

itself, you are simply modifying the UVW coordinates , which is what all of the 

object’s faces might look like in 2D if they were rolled out flat. To illustrate, 

imagine a simple box made up of six polygons. To easily paint a texture map 

onto that box, imagine the box unfolding and laid out completely flat. Since 

texture painting is done in 2D, we could then take all six of those flattened 

faces of that box and paint them with the UVW coordinates of the box 

accurately, and then apply the texture to the box. This is the process of UVW 

unwrapping.
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Click the box next to the Diffuse slot and choose Checker as the map type.

By default, it is a black-and-white checker pattern with only a 1x1 tiling. The more 

you tile the texture, the smaller it will be repeated across the surface, which is fine 

for a checker pattern. So for now, change the tiling to 20x20. Under the Checker 

Parameters rollout, 

feel free to change the colors as you desire by LMB clicking the color box and 

choosing your own.
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Animation concepts

Animation is based on a principle of human vision. If you view a series of 

related still images in quick succession, you perceive them as continuous 

motion. Each individual image is referred to as a frame.

Historically, the main difficulty in creating animation has been the effort 

required of the animator to produce a large number of frames. One minute of 

animation might require between 720 and 1800 separate images, depending 

on the quality of the animation.  Creating images by hand is a big job. That is 

where the technique of keyframing comes in.

Most of the frames in an animation are routine, incremental changes from 

the previous frame directed toward some goal. Traditional animation studios 

realized they could increase the productivity of their master artists by having 

them draw only the important frames, called keyframes. Assistants could then 

figure out what belonged on the frames in between the keyframes. The in-

between frames were called tweens.

Once all of the keyframes and tweens were drawn, the images had to be inked 

or rendered to produce the final images. Even today, production of a traditional 

animation usually requires hundreds of artists to generate the thousands of 

images needed.

How it works in 3ds Max

3ds Max 2010 is your animation assistant! As the master animator, you 

create the keyframes that record the beginning and end of each animated 

sequence. The values at these keyframes are called keys. 3ds Max calculates the 

interpolated values between each key to produce the completed animation.

In traditional animation, the master animator 

could determine the keyframes at the beginning 

and end of the ball rolling, and the assistant 

would fill in the frames with the tweens. In 3ds 

Max, you identify the keyframes and 3ds Max fills 

them in for you!
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The majority of the animation tools can be found along the bottom of the UI.

Autodesk 3ds Max can animate just about any parameter in your scene. You 

can animate modifier parameters, such as a bend angle or a taper amount, 

material parameters, such as the color or transparency of an object, and much 

more. Once you have specified your animation parameters, the renderer takes 

over the job of shading and rendering each frame. The result is a high-quality 

animation.

Key Interface Elements

Let’s look at some of the main animation tools in 3ds Max 2010, and a brief 

explanation of them.

1 Time Slider

The Time Slider is along the top of the Track Bar, and shows the current frame 

of animation you are on. It also lets you move to any frame in the active time 

segment. To move the Time Slider along the Track Bar, LMB click it and hold, 

while moving left or right along the Track Bar. RMB clicking the slider bar opens 

the Create Key dialog box, which lets you create position, rotation, or scale keys 

without using the Auto Key button.

2 Auto Key and Set Key Modes 

Auto Key mode toggles the keyframing method that when turned on, any 

changes made to the object’s position, rotation, and scale are automatically 

keyframed (recorded). Set Key mode allows you to create keys only when  

you want. Unlike Auto Key, Set Key mode gives you control over what you key 

and when.

3 Set Keys

When in Set Key modes, use this button to create a keyframe with the selected 

object.

4 Animation Controls

These controls include Go To Start, Previous Frame/Key, Play/Stop, Next Frame/

Key, and the Go To End functions respectively. Hover over each for their 

function.

5 Time Configuration

This will launch the Time Configuration window that will allow you to adjust the 

Frame Rate, Time Display, Playback options, and more. This is also where you 

can specify the animation Start, End, Length, and Frame counts.
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Lighting Basics

The 3D artist is a lot like a photographer. The 3D artist has the ability to arrange 

the lights in a scene to suit their needs. In fact, the 3D artist has significantly 

more freedom than a photographer. The 3D artist is not constrained by gravity. 

They can place their lights anywhere in the environment without worrying 

about them tipping over, if the extension cord is long enough to reach the 

light, if the heat of the light is going to set things on fire, and how long the 

light bulb will last before burning out. In fact the 3D artist can also have lights 

that cast shadows or not, lights that remove light from their scene, and lights 

that simulate a specific time of day or natural effect. In essence the 3D artist 

has much more creative freedom than a photographer because of their ability 

to determine the light in a scene.

Lighting is the basis of a great looking image or animation. Lighting sets the 

mood and gives the viewer clues about what may or may not happen in both 

still images and animations. At its foundation the lighting in a scene will tell 

the viewer whether it is day or night. Just as good value relationships in an 

image can save an average image, good light in a 3D scene can make models 

and textures appear much better.
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Here you will take a look as some of the traditional light arrangements you 

might use as a starting point when lighting a scene. We will then take a scene 

that lacks any light at all and show you how effective lighting is built and why 

each step works. We will take a look at how the color of a light affects the 

objects in a scene. Finally, we will take a look at some of the lighting features 

that are found in Autodesk®3ds Max®.

There are a few basic things every 3D artist should consider before beginning 

the process of lighting a scene.

What mood are you trying to create in your scene or 

animation? In many cases this is the first question you 

should ask yourself because it will determine where in the 

scene you place the light or lights.

What colors should your lights be? Colored lights will 

affect all the models and textures in a scene. It does you 

no good to light a scene with orange and red lights if the 

textures on your models are predominately green and blue. 

Do you want harsh or soft lighting? Often the feeling of 

how harsh or soft the light in a scene is depends on how 

the shadows being cast appear. Sharp shadows tend to 

indicate harsh lighting and softer shadows indicate softer 

light sources.

Adding Lights to a 3D Scene

The types of lights you create are determined by the 

menus in an application and the type of rendering you 

plan on using and can include spot lights, Omni lights, 

distant lights, and so on. Lights in a photographer’s studio 

and in a 3D scene are referred to by specific names that 

indicate their function. The function of the lights you create is determined by 

their placement in a scene. In the following each function (name) or a light will 

be described. 

Once the light’s functions are described, some general lighting schemes will be 

diagramed that will give you a good starting point when it comes to lighting your own 

scenes. 

Types of Lights

Key or main light. This is the predominant and brightest light in most scenes. 

Every 3D scene will probably have a key light. The position of the light depends on 

what you, the artist, are trying to say. Traditionally, the key light is positioned at a 

45-degree angle from a line drawn directly between the camera and subject.

Figure01b
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Positioning the key light in the vertical plane relative to the subject will depend 

on the mood of the scene  

A higher light will appear quite natural, like sunlight 

A lower-positioned light will appear more theatrical 

A key light that is positioned at eye level will look slightly strange
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Fill or secondary light

The fill light is positioned opposite the key light. Without a fill light in 

a scene the shadows on objects would be too dark and opaque. The 

fill light should be significantly less intense than the key light. While 

there is no set percentage for its intensity, generally it will be less 

than 50 percent as intense as the key light.
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Rim lights

If there is a light source in view in a scene, you will probably want to add a 

rim light to the scene. Placing this light at a 135-degree angle behind your 

subject on the side of the visible light is a good starting point. Rim lights 

are used extensively and can add a nice border between the subject and 

background.
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Backlights

Generally backlights are used to separate the main subject from the background. They 

are pointed at an object in the background, throwing the subject into a higher-contrast 

relationship.
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Sunlight light

There is usually a light in 3D programs that simulates sunlight. In 3ds 

Max, sunlight is called skylight. Skylight light is one of the ways it is 

possible in 3ds Max to imitate daylight in a scene. You can set the color 

of the sky or assign a map to it. The sky is represented as a dome above 

the scene. The position of the skylight and how far it is located from 

objects has no effect on how bright the lighting appears. The skylight 

object is simply a representation of the lighting that always comes from 

above. 

Skylight should be used with the light tracer. The light tracer produces 

soft-edged shadows and bleeds an object’s color into the surrounding 

for bright scenes. A sunlight scene would be considered a bright outdoor 

scene. The light tracer does create an accurate representation of 

sunlight, but it is easier to use than some of the other ways of imitating 

sunlight.  
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Ambient light. While not actually a light source, it is 

intended to simulate the natural light that bounces 

around a scene. Intense light will need less ambient 

light than weaker lights. Figure07 shows the ambient 

light in the scene increased from nothing to a dark 

blue.



Workbook3dsMax Skills 
109

Sk
il

ls
2010WorkbookWorkbook

3D Visualization & Animation Competition

Standard Lighting Schemes

 This section shows some basic lighting setups often used in photography 

studios. These arrangements are good starting points for the 3D artist 

when deciding how to light a scene they are creating.

These lighting setups are pretty self-explanatory and will not need much 

description, if any at all. Each image shows the subject, camera, and lights 

along with a rendered version.

45-degree single light source.
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45-degree key light with additional fill light.
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90-degree single light source (side lighting).
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90-degree single light source with 45-degree fill 

light.
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135-degree rim light source.



Workbook3dsMax Skills 
114

Sk
il

ls
2010WorkbookWorkbook

3D Visualization & Animation Competition

Two 135-degree rim light sources produce very 

harsh and stark images. Great for intense action 

shots where silhouette is important.
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Frontal lighting at camera level, produces a very 

flat image.
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Rembrandt lighting where the light source is 

almost directly above the subject and shadows are 

left very dark and opaque.
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Theatrical lighting where the light source is placed low in comparison to the 

subject. Generally shadows are also very dark and opaque.
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Here we will look at how  lighting affects a scene beginning without any light 

source at all.

In the beginning when there is no light, we cannot see anything in the scene. We 

have no idea where objects are located or if something is going to reach out and 

grab us.

Figure 01

So, let’s add a light. Right now it is a white light without any color. Now you can 

tell there is an object on some kind of surface but very little beyond that. You 

can tell that the object is opaque or very nearly so since there is a cast shadow 

on the flat surface. Since you can see the object, you may be able to make some 

assumptions about its nature.

Figure 02

Figure 01 Figure1 02
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Figure 03 Figure 04 

Up to this point the image is only various shades of gray. So, let’s add some color 

to the object. It makes the image more interesting to look at but having only a 

single color in a scene looks rather strange.

Figure 03

Add a fill light opposite the key light and low to the ground. Because we are in a 

colored environment at this point, make the fill light lean slightly toward the color 

of the environment. This light will help lighten the stark contrast of the shadows 

and add a touch of color to them, imitating color being reflected from the light 

bouncing around the environment. 

Figure 04
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Figure 03

While the object has a local color (just like an apple is red), 

you can see that changing the color of the light dramatically 

changes the color of the object. If the reflected light is 

strong enough, you may see some of the object’s local color 

but very subdued. You may also be able to see some of the 

object’s local color along the terminating edge between the 

light and shadow side.

Just for fun, let’s continue to change the color of the light 

source and see the effect on the object. We will pick colors 

for the light from around a standard 12-spot color wheel. We 

will change the color of the fill light to the complement of 

the key light color.

The next six images show the influence of colored lights on 

our scene. Both the environment and object can be effected 

in unexpected ways. When you plan your light scheme you 

absolutely must take into consideration the color of the 

lights you use.
Figures 05-09

The scene is looking more natural at this point. We still do not have any visual 

clues to the nature of the material composing the object. We could change the 

surface characteristics of the object to gives us an idea of what it is made of but 

this will be covered more in the next section on texture, so we will leave things as 

they are right now.

Let’s change the color of the light and see what happens. 

Figure21
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Figure 07

Figure 06

Figure 09

Figure 08
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Figure 11

Summary

In this section we looked at lighting and some basic arrangements 

that could be used as a starting point in a scene. We also looked at the 

influence the color of lights can have on objects within your work. 

Careful planning when adding lights will give your images and 

animations that extra something special and take your work above the 

mundane.

Figure 10
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Setting Up the Basic Scene
Setting Up the Basic Scene

When you start 3ds Max it automatically creates a scene with some default 

lighting, so you can at least see what you are doing. However, it is not a lighting 

scheme that you probably want to use for your final scene.

Let’s add a general lighting scheme to the scene that contains a key light, fill 

light, rim light, and an additional light at or below the ground plane to simulate 

light from the ground plane bouncing back into the shadows created by the 

other lights. 

Autodesk 3ds Max comes with two types of lights: photometric lights and 

standard lights. 

Photometric lights let you more accurately simulate light in a real-world 

environment. You can set many different parameters to control such things as 

intensity, color, color temperature, and so on. To get the most accurate real-

world simulation, use the mental ray® renderer with photometric lights.

Standard lights will do for most situations. They can simulate almost any kind 

of light you can think of from the sun to flashlights. They are not meant to 

accurately simulate real-world lighting.

All the different types of lights are displayed as objects when added to a scene. 

Most of the lights have many of the same controls, so as you learn to use one 

kind the others will not be difficult to use when needed. 
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Adding Lights

The Key Light

To begin, we will add a key light using a spotlight. Remember that the key light 

is usually the brightest light in the scene and is the light that will be responsible 

for the shadows of the different objects.

From the create panel, select lights and either a Target Spot or a Free Spot 

to add to your scene. Make sure that you check the on box in the General 

Parameters/Shadows rollout that appears when you select the Target Spot or 

Free Spot light. 

In the top viewport, place the light at about a 45-degree 

angle from the line of sight between the robot and the 

camera. If you use a Target Spot, it is recommended that 

you do not place the light target directly over the object.

It is just easier to select the target should you need to 

move it if it is not directly on top of the object.
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From the Left or Right viewport, place the target object 

about midway up on your object. Raise the Target Spot 

light to about 45 degrees above the object.

When you begin to add your own lights, the default lights 

created when a scene is created are removed. 

Render from the camera view to see how the addition of 

a key light has changed the scene.



Workbook3dsMax Skills 
126

Sk
il

ls
2010WorkbookWorkbook

3D Visualization & Animation Competition

The edge of the light on the back plane is a bit harsh and the curve of the light 

comes very close to the right clamp hand of the robot, creating a tangent which 

in turn creates a point of tension in the image. We will fix this, but first we 

should look at and evaluate the shadow of the object itself. 

Creating good shadows is a critical skill you need to master when working in 

3D. While it is beyond the scope of this section to go deeply into each shadow 

type, it is worthwhile to show a few renders using each shadow type. 

Creating Shadows

The shadow of the robot itself is acceptable, but where it is cast on the vertical 

wall it becomes a bit blocky and does not represent the objects casting the 

shadow well. There are a number of different ways for 3ds Max to create 

shadows. These methods include:

Area Shadows

Ray-Traced Shadows

Advanced Ray-Traced Shadows

Shadow Maps

mental ray Shadow Maps

In the rendering that was just finished, the shadow was created using Shadow 

Maps. Shadow Maps are real bitmap images that 3ds Max renders and then 

combines into the finished render to create the shadow. 

There are several things you can do to change the way the Shadow Maps 

appear:

Increase the size of the Shadow Map. This does require more memory to calculate, 

so if you are not on a computer with lots of memory, be careful doing this. The 

figure shows the difference in the rendered shadows when the Shadow Map size 

increased from 512 to 2048.
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You can also smooth out the shadows if you increase the 

Sample Range of the Shadow Map, which will smooth 

their appearance.

You can, of course, increase both the Sample Range and 

Size to get very nice results.
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One disadvantage of Shadow Maps is that they will not 

render as expected when using transparent objects. 

Specifically, they treat all objects as opaque. 

So let’s change the shadow type and see what happens 

with the rendered robot. 

To change the shadow type you do not need to change 

the current light source. 

Select the Shadow drop-down menu, and choose Area 

Shadows. Leave everything at the default settings and 

render the robot.
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Area Shadows can take a long time to render. They produce very soft shadows; 

and they get softer as the shadow gets further from the object. There are 

a number of different options with this shadow, including the basic shape 

of the light the shadow is calculated from. You should spend some time 

exploring the various settings. Changing the Area Light Dimensions will have 

a dramatic effect on the softness of the shadow. The following shadows were 

rendered with Area Light Dimensions at the default 10 for the length and width 

(Figure10a), changed to 5 in both the height and width (Figure10b), and finally 

with the settings at 1 (Figure10c). As you can see from the images, the lower the 

setting, the sharper the shadow.
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Now let’s look at Ray-Traced Shadows. Ray-Traced Shadows are calculated by 

tracing the ray of light’s path from the light source to and beyond the object. 

Ray-Traced Shadows are more precise than shadow-mapped ones, though 

they always create a shadow with a hard edge. Ray-Traced Shadows work with 

transparent, translucent, and wireframe objects in a scene. 

Select Ray Traced Shadows from the Shadows drop-down menu. 

The robot is rendered with Ray-Traced Shadows. Notice how crisp the shadows are 

along their entire length when compared to Area and Shadow Map shadows.
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Let’s now choose Advanced-Ray-Traced Shadows. Advanced Ray-Traced 

Shadows are like Ray-Traced Shadows, but you have more control over how the 

shadows look. One of the major differences is the ability to soften the edges of 

the shadows so they are not so crisp and sharp.

Choose Advanced Ray Traced shadows from the Shadow drop-down menu.

The robot is rendered with Ray -Traced Shadows. With the default settings, the 

shadows are still very crisp along their edges.
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By increasing the Shadow Spread value, the edges of the shadows can be 

softened. When you do increase the Shadow Spread, you also need to increase the 

Shadow Integrity, Shadow Quality, and Jitter Amount. Figure 14 shows the robot 

rendered with the Shadow Spread value of 20, Shadow Integrity to 6, Shadow 

Quality to 6, and Jitter Amount to 2.
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Figure 15 shows the Shadow Spread value set to 50. The other settings have been 

left as they were in the previous image. Raising the Shadow Integrity and Shadow 

Quality settings can significantly increase the render time required.

Before we add any more lights, let’s adjust the softness of the 

edge of the spotlight so the light shining on the back vertical 

surface is not so harsh. 

The transition between the light and shadow of the Spot 

Light is called falloff. It is represented in the scene when the 

spotlight is selected and Light Cone is visible. The light cone 

is visible by default. Adjusting the falloff of the spotlight 

is easy and can be done using the Hot Spot and Falloff 

spinners located in the Spotlight Parameters rollout or using 

manipulators located on the default Main Toolbar. 
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Click and activate Select And Manipulate. As you move 

the cursor over the light cone in the viewports, the 

hotspot and falloff circles will temporarily turn red. When 

the circle is red, you can adjust the size of the spotlight 

falloff, hot spot, or both. The larger the gap between 

the two circle representations, the softer the transition 

between the shadow and light will appear in the render. 
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This image shows the robot render with 

the falloff between the light and shadow 

increased. The transition is much wider 

and softer than the original.
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Now let’s get back to adding lights to our scene.

The Fill Light

We will now add a fill light to the robot scene. Remember 

that the goal of the fill light is to lighten the very opaque, 

dark, and dense shadows created by the key light.

Add either a Target Spotlight or a Free Spotlight to the 

scene placed on the opposite side of the key light at 

about half the height of the robot object.

Drag the target or point the light at the robot. 

Adjust the falloff of the light to your liking. There is no 

right or wrong setting.
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Leave the Shadows box unchecked in the General Parameters rollout.

In the Intensity/Color/Attenuation rollout, set the Multiplier value to a setting 

between .5 and .75

Click the Color preview to open the color picker, and using the Dropper tool, 

select the bluish color from the floor plane. Lighten the color if it is in the darker 

range of values.

Render the robot. The shadows are lighter and there is some of the ground color 

in the fill light simulating light reflecting from the ground into the robot object.
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Finally, we will add a rim light to further separate the robot from the 

background.

 The Rim Light

The rim light is used to separate the object from the background. It can be 

placed on either side of the object. As the artist, you will need to decide which 

side would light most effectively. In this particular scene, we will place the 

rim light behind the robot on the same side as the key light. In this particular 

instance, this is done because the values of the light side of the robot are very 

similar to the values on the background plane.

To place the rim light, do the following:

Add either a Target Direct or a Free Direct light to the scene. We use the direct 

light because it has parallel rays and can be places such that it does not light the 

ground plane. Place it on the same side as the key 

light at about half the height of the target object, 

slightly behind the robot, and so the rays of the light 

are moving parallel to the floor surface. It does not 

matter if it is positioned behind the rear plane. The 

light will shine through that object.

Turn off shadows if they are on.

Drag the target or point the light at the robot. 

Adjust the falloff so there is very little since we do 

not need a smooth and gradual transition between 

the light and shadow. 
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This time increase the multiplier value to 2 and change 

the color or the light back to white. This will give a 

very intense light that will serve as a rim light quite 

adequately.

Render the robot.

As you can see, the added contrast between the robot and the background 

nicely separates the two and makes the object more the focal point. 
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1 - Setting a Project

When you start up Maya, it is best practice to set 

up a project file. This will allow you to always save 

work to a specific directory.

3 - Marking Menus
Marking Menus allow you quick access to 

editing your mesh objects. You can select 

different components to allow you to start 

modeling.

2 - Primitives
In Maya you create primitive 3D 

geometry as a starting block to 

modeling detailed 3D objects

4 - Channel Box
The channel box gives you 

quick and easy access to the 

Transform, Rotate and Scale 

channels of an object

7 - Hypershade
The Hypershade is where you 

will create all your materials 

for your scene objects. Its clean 

layout makes it easy to use.

8 - Rendering
When you render, Maya 

converts a 3D Scene into 

a 2D Image.

9 - Auto Key
Auto Key allows you to automatically key objects as you 

scrub through the timeline making transform, Rotate and 

Scale changes. Any change you make a key will be created

10 - Animation Settings
Animation Settings allow you to take control over 

all aspects of your animation setup, from Frame 

Rate to Number of Frames.

5 - Tool Box
The ToolBox holds all the 

Transform, Scale and Rotate 

tools, as well as other tools 

used for selecting objects.

6 - Viewports
Using the viewport Tools, you 

can Tumble, Pan and Zoom 

the Perspective Viewport

Shelf

Status Bar

Menu Sets

Time Slider

Playback Controls

Feedback Editor



WorkbookMaya Menus 
142 2010WorkbookWorkbook
142

In
te

rf
ac

e 
& 

M
en

u
s

3D Visualization & Animation Competition

Shelves
Shelf Tabs

Tools

Render Settings

Output Options

Open

Render Tabs

Attribute Editor

Menus

Attribute Rollouts

Tabs

Object Name

Status Bar

Snap Tools

Component Mode Menus
Rendering Options

Attributes Editor/Channel Box
Menu Sets

Render Frame Window

Render View

Renderer

Render Info

Menus

RGB / Alpha

Hypershade

Views

Tabs
Inputs / Outputs

Current Shaders

Menus

Shaders

7 - Quad Menu

Outliner

Open

Scene Objects

Menus

Defaults
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The Open file dialog, navigates you directly to the Scenes Folder, in the project 

Folder you set up earlier. Notice that all your files are laid out in an organized 

manner. Any files you save, Export, Render are all saved to their relevant Folders 

making it really easy for you to manage your project and ensure that data 

doesn’t get lost. 

3

When you Click on New under Project, The Set Project Dialog will 

appear. This simply allows you to name the relevant folders you will 

require for your project. You will just click Use Defaults then click 

Accept. The Browse For Folder Dialog will appear. Here you will select 

the directory to which all project files will be saved. 

2

File Management is crucial to the success of any 3D project. By setting a project folder, you are 

always making sure that files get saved to specific and relevant directories. For example when 

you set up a project all scene files you save are saved to the Scenes Folder, any materials you 

save are saved to the Materials Folder etc. First got to File>Project>New.

1

4 If you go to File>Import, you will notice that an Import Folder was created in 

your project directory. It is best to save any data from another application that 

you wish to import in this folder. Maya will always navigate to the import Folder 

when you click Import. Notice what happens if you go to File>Export you will 

notice that you will be taken to the project folder again. All major folders that 

are required are set up for you in an easy to manage way.
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Primitive objects consist of Boxes, Spheres,

Cones, Planes, Pyramids and Cylinders. They 

are easy to create, generally with a 2 click 

mouse operation. 

22

In Maya you generally create new primitive objects using the Shelf, 

or the Create menu. Primitive objects are used to block out your 

model. You then go into the different sub-object modes to model the 

primitive into shape. 

1

4 An Editable Poly has 7 Sub-

Object levels, Vertex, Face, 

Multi, UV, Object Mode. Each 

of these levels allows you 

access to different elements 

of the Polygon.

4

Deformers can also be applied to objects in the 

Animation Menu>Create Deformers>Nonlinear 

Deformers. When a deformer is added you have 

the ability to Bend, Squash and Twist the shape.

5

Once you have created a primitive object as your starting block you can 

immediately work with it as an Editable Poly  by right-clicking over the object 

and bringing up the marking menu. You can start using some of the Sub-

Object modeling tools to  develop and refine your model. 

3
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1 The Hypershade is an easy to use dialog. This is where all your 

scene materials and textures will be created. The Hypershade allows 

you to manage individual scene materials in their own individual 

material slots. You can create Procedural Materials. These are 

materials created parametrically within Maya. You have different 

types of shaders available that act as a starting point for creating a 

particular look for a material.  Examples of shader types are Blinn 

and Anisotropic. You can also create Bitmap Materials. These use 

either parametric image maps or external image files.

Now you will create a material with a texture on it. 

Create a new Blinn Material, double click it, and in 

the Attribute Editor Click the Map Button next to the 

Diffuse Slot. Select Checker from the Create render 

Node Dialog. Apply the shader to the object and press 

6 on the Keyboard to view the texture in the viewport.

4

2 First you will create a simple Procedural 

Material. To do this click on Blinn to create a new 

Shader. Double click the new shader and in the 

attribute editor you will Change the color to Red.

In the Attribute Editor, double click the Diffuse 

color swatch to bring up the Color Chooser 

Select a light red using the Sliders.
3

In the scene, create a Sphere and with it selected go into the Hypershade, Right Click 

over the Material Slot and from the Marking Menu, select Assign InitialShadingGroup To 

Selection
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1 In this tutorial, you will create a simple animation of a sphere moving across the 

viewport. To start, go to the Polygon Shelf and click on the Sphere. Left Click in the 

viewport and drag out a Sphere. Go to the Toolbar and select the Move Tool. Select 

the Sphere. You are now ready to start animating.

2 Go to the bottom right of the interface and hit the Auto Key button. Move the Sphere 

on Frame 1, then press S to set a key, this creates a key at frame 1. Now go to Frame 10 

and then move the Sphere to a new position. Notice that a new key frame is created. 

Move the Time Slider to Frame 20 and move the Sphere, another new key frame is 

created.

3 As you move the Time Slider across the Time Line and move the Sphere you will see 

new keys are created. Set new Keys at Frames 30, 40, 50 etc until you reach 100. 

When you are done be sure to turn off Auto Key. 

4 Once you have animated your Sphere, Go to 

Window>Animation Editors>Graph Editor - Curve Editor. 

With your object selected you will see the animation curves 

that were created. You can refine your animation using 

these curves. 

The Animation and Playback controls allow you to play your animation in real-time 

in the Maya viewports. Auto Key, allows you to set an initial key, scrub through the 

timeline, move your object, and the object will be automatically keyed. 

Auto Key

Animation Controls

Playback Controls

Frame Number
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1

In this tutorial, you will animate a camera along a path. 

This is a great way of creating camera walkthroughs. 

You can attach either a Free Camera or a Target Camera 

to a path. First go to Polygon Shelf>Sphere. Drag out a 

Sphere in the perspective viewport. The next step will 

be to create a Path and a Camera in the scene.

2

Go to Curves Shelf>EP Curve Tool, and create a curve 

in the top view around the Sphere. In the next step you 

will create a camera

4 To create the Motion Path Controller, first 

select the Camera, then select the Path. Go to 

Animate>Motion Paths>Attach to Motion Path. 

This will attach the camera to the path.

5 You will notice the camera jumps to the 

beginning of the path.  Also key frames are 

created at the beginning and end frames. If 

you scrub through the time line you will see 

the camera sweep along the path

3 To create the Camera, go to Create 

Menu>Cameras>Camera. Place your 

Camera over the path. In the next step, 

you will attach the camera to the path. 

You will do this using a Motion Path 

Controller.
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Getting Started with Maya

This is a “Getting Started” introduction for Maya basics, you will want 

to become familiar with all of tools in this section and if you need more 

information refer to the help Menu in Maya.
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Main Menus

The Maya user Interface

We are going to cover the most commonly used menus, commands and 

hotkeys. The Maya User Interface is shown here in its default configuration, 

and can be customized to fit your workflow.  There are many menus in this 

interface, some for modeling and some for animation. They are grouped into 

different shelves, so that you 

can open them individually. 

Maya is a very big program and 

you will not need to memorize 

everything in this layout.  Just 

explore as much as possible and 

try to get a sense of the overall 

interface and as you learn more 

you will begin to see how the 

tools all work together.  

The Main Menus are located 

at the very top of the Maya 

Interface.  It is the top bar that 

starts with File and ends with 

Help.  The main Toolbar also 

has other menus that are always 

visible, such as Edit, Modify, Create, Display, Window and Assets. These 

Menus will always stay visible. 

The Status Line Toolbar is the top toolbar. This Toolbar has several category 

settings that you can choose from, such as Animation or Polygons for instance. 

When you switch between the categories, the top right section of the tool bar 

will change with new categories specific tools.  
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It also contains another set of icons below that are status line icon commands.

All of the commands can be accessed in the 

drop down menus by default, pictured here is 

the Mesh menu.  

This is the main area for the commands you 

will probably use most often.  On the end of 

each command menu there is a black square 

Options Box, this contains additional Options 

which can be setup before the command is 

executed.  

Inside the Smooth Options box there are 

sliders and check boxes that can be adjusted. 
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Status Line Icon Commands are a set of icons that help with selecting groups 

and common settings.  

The Shelves toolbar holds creation items and tools, each categorized in tabs. 

The Polygons tab is selected in the image below. There are icons to create a 

polygon spheres and cubes, also on this toolbar there are other commonly used 

objects and features.  

You can add icons to the Custom Shelf tab, by pressing Alt + Left Mouse 

Button, while selecting a command.

The Toolbox is located on the left side of the user interface and contains useful 

object transform tools.

The select tool is used when you want to select an object, or to get out of a 

transform mode. Below that are the Move, Rotate and Scale Icons. These are 

used to manipulate any object or component, such as polygons or edges. 

File Buttons are used to create and save 

scenes.  

Selection Mode Buttons let you select 

between object hierarchy.  

Selection Mask Buttons let you make specific 

object component types selectable or un-

selectable.  

Snapping Buttons, toggles snapping objects 

to grid, points, and curves.  

Render Options Buttons, are used to open 

the render window, settings, and to perform 

an IPR render.  

Input Mode, allows you to input absolute 

values for the selected transform of an object.  

You can also use the option box to rename multiple selected objects.
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The Quick Layout Buttons are used to change the viewport configuration.  

Sometimes you want to have a view of the Hypershade and just a perspective 

window. This depends on your own preferences or workflow and there is an 

icon to change this view quickly.  You can also change back and forth from Four 

View and Single View by using the icons, or using the Spacebar hotkey.

The Hotbox Shortcut Menu can be accessed by holding Spacebar in any Panel 

viewport window. Once the menu is visible, you just Left Mouse Click to the 

desired command, another menu will also pop up with a square options. This 

menu is commonly used for advanced menu navigation, but even new users can 

access this powerful tool.  
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Viewport Panel

The Viewport Panel is the main navigation window 

where you will be working. This is like the desktop on your 

monitor.  Everything you design will be represented in these 

areas. 

The Orthographic panel viewports support up to four 

simultaneous views, by default it is set to Top, Perspective, 

Front and Side.

The Viewport Panel Toolbar is located inside each viewport panel.  This is 

commonly used to change the current viewport render settings. It has icons 

to toggle between different lighting and camera options. There is a drop down 

menu right above this panel with additional functions, think of these as options 

boxes. They contain various options to customize everything that is visible in 

each viewport.

Every viewport can have custom settings.
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Panel Viewport Camera Navigation

You can move the camera around an object when it is selected. To do this 

just select an object and hold Alt key + mouse button you can maneuver the 

camera, around, sideways, and zoom.  These same key commands are also used 

for navigation inside the Hypershade and UV Texture Editor.  However the 

rotate function is disabled because you will be dealing with 2D space.

Holding Alt + Left mouse button and dragging 

will rotate around the object in the viewport.

Holding Alt + Middle mouse button and drag-

ging will move the camera with the model in 

the viewport.

Holding Alt + Right mouse button and drag-

ging will zoom the camera in and out from the 

model in the viewport.

The Attribute Editor is on the top right section and gives you full graphical 

controls for adjusting objects. It is located above the Channel Box Menu. This 

is a great way to set the exact parameters of your primitive objects, such as a 

cube. When you want to set values for things this is also done here.

All you have to do is move the slider to the right or left, or input a numerical 

value to the box. 
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The View Cube is located in the top corner of the selected viewport.  Clicking 

on a particular face, corner or edge of the cube automatically adjusts the 

camera’s view so it matches that face. The viewing camera animates in real-

time during the transition between views so you can see how the orientation 

of the camera changes in relation to the 3D scene. There are 26 standard views 

available.  You can turn off the View Cube and edit options for the View Cube 

by selecting Window > Settings/Preferences > Preferences, and selecting the 

View Cube category.

3D Space is the ability to see and manipulate an object in all three coordinate 

spaces.  In computer based 3D we use the Coordinate System to model our 

objects.

XYZ Coordinate System

In Maya, 3D space is measured using the XYZ Coordinate System, it is defined 

by three axis; the X-axis, the Y-axis and the Z-axis. If you imagine looking into a 

movie screen, the width would be the X-axis, the height would be the Y-axis and 

the depth would be the Z-axis. In Maya, these axis are presented with X and Z 

on the ground, represented as the grid,  and Y as the height. 

You can find any point in a 3D world by defining a coordinate for each of the 

axes. To help you visualize the three axes, each is given a corresponding RGB 

color.  X is Red, Y is Green, Z is Blue.  
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The Viewport Gizmo is located in the lower left corner of the viewport. It will 

tell you which direction is up, depending on the camera.  The Origin is the 

center point of the world; it is located at 0, 0, 0, of the XYZ axis.  All objects 

and transforms are measured from this location.

Viewport Manipulator Gizmos are visual handles that allow for 

transformation of an object, by either move, rotate or scale.  The yellow square 

allows for movement on all axis at once.

Move an object by pressing hotkey W to bring up the gizmo handles. 

Using the Left mouse button and dragging on the colored arrows will move it 

on the desired axis. 

Rotate an object by pressing hotkey R to bring up the orbital gizmo handles. 

Using the Left mouse button and dragging on the colored arrows will rotate it 

on the desired axis. 

Scale an object by pressing hotkey E to bring up the gizmo handles. 

Using the Left mouse button and dragging on the colored arrows will scale it on 

the desired axis. 

Undo Command is Ctrl + Z. This will allow you to go back previous steps.
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Polygon Components

Polygon Components are Edges, Faces, Vertex, and Polygons. They can be 

accessed by Holding Right Mouse Button while you have an object selected. 

This will bring up a options box that will allow you to select from the various 

object components, such as Edges, Faces, or Vertex.  

The Multi Component will allow you to select more than one component at 

the same time while using the Shift Key during selecting.  Once you have your 

selection you can manipulate each of these components using your transform 

tools.  

Polygon Components, Edge, Face and Vertex.

Edges Component Selection

Faces Component Selection
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Vertex Component Selection

Multi Component Selction

A polygon is any 3 or more-sided 2D object and when it’s composed with more 

polygons, it can create a 3D object. 

Maya Hypershade

The Hypershade Toolbar is where you will create a material and 

shading network. 

Window > Rendering Editors > Hypershade.  

A material type is also referred to as a shading model or shading 

network. The shading model determines how the surface simulates 

a natural reaction to light.  Some of the most common materials 

are Blinn, Phong and Lambert. They are located in the Create 

Nodes Bar. You can also create Maya, Mental Ray and other nodes 

here. 
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At the top is the Hypershade Main Toolbar.  It contains some key commands 

for navigating the Hypershade.  

Viewport Layout will change the work area 

between a top and bottom configuration.  

Graph Materials buttons will show the 

shading network of a selected material when 

selected.  

The Connections buttons will show you all 

input and output connections to a node.  

Think of Node Containers as folders for Materials, Lights or Shading Groups.  

They help you keep organized.  The Search Box is used to separate materials 

with a certain prefix or to find a specific texture.

The Hypershade Viewport area contains the Materials 

Tab, pictured below. The Work Area is where all the shader 

connections can be made using a visual drag and drop method.  

This is done by using the middle mouse button to drag from 

a material to a surface property. Pictured is a Blinn Shader 

Network. 

It has connections made for a Diffuse, Specular and Normal Map.  

The Bar Size buttons make the tab larger or smaller.
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UV Texture Editor

The UV Texture Editor is where we do our UV Texture mapping.  

A UV is a point that matches up with a Vertex on the surface of a 3D model.  

To open the UV Texture Editor, Window > UV Texture Editor.  You have the UV 

Texture Editor Toolbar that contains all of the UV layout commands.  

UV Texture Editor Toolbar

The UV Texture Editor Viewport is similar to the 3D viewport, expect it only 

works on X and Y axis.  It is essentially a 2D representation of the 3D models 

surfaces.  The top right quadrant is referred to as the 0-1 Texture Range. All 

of the UV’s should end up in there for most cases.  However there are tiling 

methods that allow for placement outside of the 0-1 Texture Range.  

UV’s are marked as green points. UV’s can be edited by holding Right Mouse 

Button and selecting UV.  
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The UV Texture Editor Toolbar is similar to the other menus in Maya. You can 

Right Mouse Click on the Icon to open the options box for that tool. There is 

also a drop down menu on the top with every command, and a black options 

box.  

Below we have a row of icons that are shortcuts to the most used layout 

commands.  

 Maya Help can be accessed on the Main menu or by pressing hotkey F1 and is a 

very useful resource guide.  Refer back to it if you want to learn more about the 

tools and commands we have covered. 

The UV Tool Buttons will allow you to ma-

nipulate and layout UV’s.  

The UV Orientation Buttons let you flip UV’s 

and rotate by 45 degrees.  

The Cut and Sew Buttons allow you to cut 

and sew UV shells. A shell is a bunch of at-

tached UV’s.  

The UV Layout Buttons will layout UV’s in a 

cleaner more optimized way.  

The UV Alignment Buttons will align the 

selected UV’s to the minimum or maximum U 

or V value.  It is a good tool to make UV’s flush 

to the left, right, top or bottom edges.  

The Isolate Selection Buttons allow you to 

work on a subset or shell of UV’s while hiding 

the rest.  

The Image & Texture Buttons allow you to 

control the display of images and textures in 

the UV Texture editor Viewport.  

The UV Texturing Buttons are used for tex-

ture baking and changing the viewport image 

ratio.  

The UV Edit Buttons are used to show the 

location of UV’s and allows you to copy & 

paste UV’s.
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Simple Mass Modeling

This exercise covers the creation and editing of simple primitives and how they 

can be moved, rotated, scaled, duplicated, and assembled to gain a greater 

understanding of architectural form and space. You will also look at various 

concepts of pattern, scale, and proportion and explore additive and subtractive 

forms. Universal design themes will also be covered, including the creation of 

centralized, linear, radial, clustered and grid forms; 

space; and planes and plutonic forms. 

In this lesson you will learn the following:

How to set up a scene with preferences

How to create building blocks from simple 

primitives

How to move, rotate and scale objects

How to split and cut polygons

How to extrude surfaces

How to chamfered vertices and bevel edges

How to assemble forms

How to assemble space

Getting Started

Set preferences

Before you create your polygon architecture, you 

will need to change some of the default settings to 

a more suitable environment for this type of work.

0 Select Window > Settings/Preferences > 

Preferences.

The Autodesk® Maya® software user 

preferences window appears.

Toy Blocks Are the Basis of Form and Space

0 In the Preferences window choose Categories > Polygons

0 In the Polygon Display settings, set the following:

Border Edges: On

Edge Width: 4

This displays border edges more prominently on polygon meshes and helps to identify 

the edge conditions of any open geometry. 
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0 In Preferences window, choose Categories > 

Selection

0 In the Polygon Selection settings, set the following:

Select faces with: Whole face

The Whole face setting lets you select polygon faces by 

clicking on any part of the face rather than on a center dot as 

with the center setting. 

0 In Preferences window, choose Categories > Settings

0 In the Working Units dialog box, select the Linear 

drop down-menu  choose meter

0 Click the Save button to close the settings window

0 Open the Outliner and select each camera one at a 

time: top, side, front, and perspective then change 

the Near Clip Plane to 1 and the Far Clip Plane to 

100000 for each of them. This will ensure the scene is 

visible at long and short distances

Camera Attributes

0 Select Create > Polygon Primitives and turn off the 

Interactive Creation option for primitives 

0 Select  Display > Grid and in the Grid Options dialog 

box change the grid size for length and width to 120 

with the Gridlines and Subdivisions at 10

Preferences Dialog Box

Grid Options Dialog Box
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Creating the Building Blocks

Once your workspace is ready, create a new scene and 

name it.

Create a file

0 Select File > Save Scene As…

0 Name the file Architecture01_Form_Space_Mine

Create cube primitive as the building block form

0 Ensure you are working in the perspective view

0 Select Create > Polygon Primitives > Cube 

0 In the Channels dialog box to the right, select the input node polyCube1 and 

highlight all three fields by holding down the Ctrl key and change the width, 

height, and depth to 2 

0 In the Channels dialog box rename the mesh Block01

File Save Menu
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Adjust pivot for easy movement within the scene

It is always a good practice to position the pivot of an object at the center of its 

base. By default the pivot of most primitives exist at the center of the volume 

but having it at the center of the base can be very handy when snapping an 

object or scaling it.

0 Select the new building block Block01

0 Select the move tool (hotkey: W) to enter move mode (this will allow you to see 

the pivot) (Using the + or – hotkey will scale the manipulator larger or smaller)

0 In the viewport menu Select Shading > X-Ray  

See how the pivot sits at the center of the block. This makes it difficult to move 

precisely on a grid.

0 Enter Edit mode for the pivot point by pressing the Insert key

X-Ray Mode and Pivot Adjust Mode On

0 Snap the pivot to the base of the cube by holding 

down the V key (Snap to Points mode) and click 

dragging the pivot along the Y-Axis to one of the 

bottom corners of the cube; this should place the 

pivot directly at the center spot underneath the cube

0 Exit Edit mode for the pivot point by pressing the 

Insert key again

Tip: 
Notice how the manipulator loses its arrows.
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Pivot Moved to Center of Base

Tip: 
Holding down the V Key will let you snap to any 

vertex in the scene and is extremely helpful when 

moving objects or adjusting the pivot of an object or 

group.

0 Now move the cube onto the grid by holding down the X key 

(Snap to Grids mode) and click dragging the mesh over the 

origin of the grid

0 Save the scene

Now the block is better suited for architectural placement, 

scaling, and rotation within the scene. Placing the pivot at the 

center and base of the mesh helps when positioning forms 

upon a surface and is an excellent practice when creating 

architectural form. 

Create the rest of the primitives

Create the rest of the plutonic forms but using a sphere, 

cylinder, cone, and pyramid. Make a few duplicates of the cube 

and make a flat square platform, a post, and a beam. Keep them 

relatively similar in size. 

0 Select Create > Polygon Primitives > Sphere

0 Select Create > Polygon Primitives > Cylinder

0 Select Create > Polygon Primitives > Cone

The Plutonic Forms
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For the pyramid, duplicate the form and simply collapse the top surface.

0 Select Block01 then select Edit > Duplicate

0 Select top face then select Edit Mesh > Collapse

0 In the top viewport select the vertex that is off-center, and snap it to the grid 

by holding down the X key (Snap to Grids mode) and click dragging it to the 

center of the mesh

Pyramid tip adjustment

Tip: 
You can use the Ctrl+D hotkey to duplicate the 

selected geometry without going into the menu each 

time.

Creating the Additive and Subtractive Forms

Use new―or copies of―the sphere, cylinder, cone, and pyramid. 

Create Subtractive Forms by Deleting Faces

For the sphere, you will simply delete faces and fill in the missing surface.

0 Select Create > Polygon Primitives > Sphere 

0 Select the faces of the lower half of the sphere and delete them

0 Select Mesh > Fill Hole  to close the new dome

Sphere Subtractive Form
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Create subtractive forms by deleting edges and 

vertices

For the cube, you will cut the faces of the object and 

delete the edges along with the vertices.

0 Using the cube in the scene, select Edit > 

Duplicate and create a copy to modify

0 Select the new cube and select Edit Mesh > Cut 

Faces Tool

0 Subdivide the cube a few times in the top 

viewport holding down the Shift key to constrain 

the action in the x and z axis

Tip: 
You can use the G hotkey after each operation to use 

the tool over and over again.

0 Subdivide the cube in the top viewport at an angle at one of the corners

0 Select the edges of the corner 

0 Select Edit Mesh > Delete Edger / Vertex and the entire corner edge will be 

removed without leaving stay vertices 

Cube Subtractive Form

Create subtractive forms by chamfering

Chamfering vertices is another method to create subtractive forms. Using the 

cube, you will bevel edges and chamfer vertices of the object to create new 

forms

0 Using the cube in the scene select Edit > Duplicate and create a copy to 

modify

0 Select the top four vertices and select Edit Mesh > Chamfer Vertex Tool Box 

and set the width to 0.25. Be sure to leave the Remove Face After Chamfer box 

unchecked and press Apply

0 If the edges of the newly formed object looks awkward, it may be that they are 

soft; to harden them, select Normals > Harden Edge 

Chamfer Dialog Box
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Create subtractive forms by beveling

Beveling edges is yet another method to create subtractive forms. Using the 

cube, you will bevel edges and chamfer vertices of the object to create new 

forms.

0 Using a cube in the scene select Edit > Duplicate and create a copy to modify

0 Select the top four edges and the side edges and select Edit Mesh > Bevel Tool 

Box 

0 Set the Offset type to Absolute and Offset Space to World with the width at 

0.25 and then press Apply

Bevel Dialog Box

Cubes with Chamfered Vertices and Beveled Edges

Create subtractive forms by splitting polygons and extruding

Scaling or extruding parts inward of a pure form is yet another method to create 

subtractive forms. Using the cylinder, you will subdivide the object and extrude parts 

inwardly to create new forms. 

0 Duplicate a cylinder in the scene using the Control + D Hotkey

0 Select the cylinder and then Edit Mesh > Split Polygon Tool 

0 Set the snapping tolerance to 100

0 Split the cylinder along the side faces twice to create additional faces 

0 Select Edit Mesh > Extrude and push the faces inward

Cube with Chamfered Vertices and Beveled Edges
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Tip: 
Continue to create subtractive forms by moving or extruding faces 

inward to the pure form. You can also use other methods, such as 

Control + Right Click on an Edge and select Edge Ring Utilities > To 

Edge Ring and Split to subdivide objects more quickly.

Create additive forms by combining objects

Additive forms are much easier as they simply require extruding faces outward 

from the form or combining various simple forms into a more substantial form.

0 Duplicate a cube in the scene using the Control + D Hotkey

0 Select a face and move it in the scene while holding down the X Key; you will 

find that you can scale cubes while keeping them of the grid. This makes it 

very easy to create forms and align them. 

0 Subdivide the cube using the various methods, and extrude single or groups 

of faces to create an additive form

0 Duplicate some of the cubes and other primitives in the scene, and scale 

some of them to different sizes vertically and horizontally

0 If you decide to use more than one object to achieve this, 

you should assemble them together and select Mesh > 

Combine to create a new additive form

Using the Grid to Snap Movement of Faces

Assembling the Building Blocks

Through simple Tools and Methods like Scale, Duplicate, 

Move, Polygon Face Cut, Split Polygon, and Combine you 

can really get a lot of curious forms. Select Face and Edge 

Loops or Rings to extrude or split to offer you more and more 

choices while you try to create the following fundamental 

architectural forms:

Create centralized forms Centralized Forms
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Create linear forms

Linear Forms

Create radial forms

Radial Form
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Create cluster forms

Clustered Form

Create grid forms

Grid Form
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Defining Space

Defining space simply involves the use of a plane or repeating elements to 

create ideas of closure. Columns work well when spaced evenly in enclosing a 

space.

Create a plane and pipe

0 Select Create > Polygon Primitives > Plane

0 Input length and width of 4 

0 Extrude the plane by 0.05 to create a ground surface with a bit of thickness

0 Duplicate the plane and rotate it so that it becomes a wall

0 Select Create > Polygon Primitives > Pipe

0 Input a thickness of 0.05 
Pipe and Plane

Spatial themes can easily be explored now 

by assembling various walls, ceiling, or 

floors to create the following fundamental 

architectural spaces:

Create centralized space

Centralized Space
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Create linear space

Linear Space

Create radial space

Radial Space
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Create grid space

Grid Space

You can create symmetry through spacing and mirroring 

elements or explore ideas about axis by setting up a linear space 

that ends at a structure. You can even make a datum.

Axis Through Symmetry 
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Datum

Concepts Explored

Pattern, Scale and Proportion

Subtractive and Additive forms

Architectural themes of Form

Architectural themes of Space

Orders of Space and Form

This exercise provided you with the essential tools and 

procedures to create form and space. It is easy to see that 

by practicing these techniques you will be able to create 

almost any type of architecture. Remember that selecting 

rings and loops of edges and faces is a powerful method 

that allows you to subdivide an object quickly before you 

extrude. Master this skill and you will be able to mass 

modeling quickly. 

The fundamental forms and space will be invaluable when 

considering types or styles of architecture. Using the 

additional files provided with this exercise will help you to 

continue thinking about how these architectural themes 

have been used throughout historical form and space.

Historical.ma provided for further exploration of 

architectural form and space.
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Playing Outside―Stonehenge 
Being told to go play outside is a frequent occurrence growing up. Anywhere 

from a backyard sandbox or schoolyard field to a dense nearby forest or sandy 

beach, children have found a place to build forts or sand castles. This desire 

to dwell in the landscape is a universal theme that started centuries ago and 

grew from the simplest meeting under a tree or baptism by a lake. Site is the 

foundation of ritual, and choosing the best location or altering it to suit an 

architect’s needs is often a very important part of establishing a sense of place.

Stonehenge

Overview

This lesson covers the creation of Stonehenge. It will involve the editing of a 

plane that will eventually become the site for this prehistoric example of space 

and ritual. This exercise will teach you how to model a basic terrain and model 

simple organic forms. 

In this lesson you will learn the following:

How to set up a scene with preferences

How to use a 2D plane as a reference to construct and assemble a site

How to edit geometry with Smooth Selection 

How to use the Sculpt Geometry Tool

How to create polygons

How to work with polygon modeling techniques

How to smooth polygon meshes

Explore architectural themes of site

Getting Started

Set preferences

Before you create your polygon architecture, you will need to change some of 

the default settings to a more suitable environment for this type of work.

0 Select Window > Settings/Preferences > Preferences

The Autodesk® Maya® software user preferences window appears.

0 In the Preferences window choose Categories > Polygons

0 In the Polygon Display settings, set the following:

Border Edges: On

Edge Width: 4

This displays border edges more prominently on polygon meshes and helps to 

identify the edge conditions of any open geometry. 
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0 In Preferences window, choose Categories > Selection

0 In the Polygon Selection settings, set the following:

Select faces with: Whole face

The Whole face setting lets you select polygon faces by clicking on any part of the 

face rather than on a center dot as with the center setting. 

0 In Preferences window, choose Categories > Settings

0 In the  Working Units dialog box, in the Linear drop-down menu choose 

meter

Preferences Dialog Box

0 Click the Save button to close the settings window

0 Open the Outliner and select each camera one at a time: top, side, front, and 

perspective, then change the Near Clip Plane to 1 and the Far Clip Plane to 

100000 for each of them. This will ensure the scene is visible at long and short 

distances

Camera Attributes

0 Select Create > Polygon Primitives and turn off the 

Interactive Creation option for primitives

0 Select  Display > Grid and in the Grid Options dialog 

box change the grid size for length and width to 120 

with the Gridlines and Subdivisions at 10

Grid Options Box
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Stonehenge floor plan

0 Ensure you are working in the top view.

0 In the top view panel select View > Image Pane > 

Import Image 

0 Select your image file

0 The image should now appear in the Top Viewport

Projection Plane

Creating the Site with the Use of a Projection Plane

You can use various viewports to display drawings, sketches, or photographs to 

help visualize your models in Maya; much like an architect creates their designs 

from the plan, section, and elevation views of a blueprint.

Create a file

0 Select File > Save Scene As…

0 Name the file Architecture02_Site_Ritual_Mine

Create a projection plane

You can import 2D images into any orthographic camera view as image planes. 

An image plane is a 2D object (plane) that places an image file in the scene view. 

You can move the image plane, change its transparency, or turn it off.

For this exercise you need to load an image similar to this, you can create this 

by hand or in a program similar to Adobe Photoshop.
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Adjust the size and transparency of the image plane

0 In the top view panel menu, select View > Image Pane > Image Plane 

Attributes to display the Attribute Editor on the right

0 Scroll down to find and expand the Placement Extras tab and set both the 

width and height to 30 to scale the image plane to be the proper size for 

something like Stonehenge 

0 Under the Inputs Image Plane Attributes set the Alpha Gain attribute to a 

value of 0.25 to make the image partially transparent for easy working

Inputs Image Plane Attributes

Creating the Terrain 

The basis for Salisbury Plain where Stonehenge is found 

will be a simple plane. The sculpting of that terrain will 

reveal the organic features of the site.

Create a plane

0 Select Create > Polygon Primitives > Plane

0 Set the height and width to 50 and the 

subdivisions both at 50

The Plane

Tip: 
To hide the image plane in the perspective 

viewport access it through View > Image Pane > 

Image Plane Attributes and switch the Display 

to Looking Through Camera. 
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Sculpt the terrain

0 Select the plane

0 Select Mesh > Sculpt Geometry Tool 

0 Click the Tool Setting on the far right of the Status Bar

0 Under the Sculpt Parameters select Operations >  Up Icon 

0 Set the Max displacement to 5.0

Sculpt Geometry Tool
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0 Holding down the B key adjust the size of the brush with which you will be 

sculpting. 

0 Begin to pull up the terrain geometry to form a general site of concentric 

circle patterns.

0 By adjusting the smoothing and trying out some of the other buttons you 

should be able to create a convincing terrain.

0 Use different brushes sizes, and relax to get a convincing undulating field. 

Sculpted Terrain
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Adjust the grade of the terrain

0 Go to the Select mode and access the Tool Settings from the far right of Status 

Line and under the Soft Selection tab turn on Soft Select

0 Go to the Vertex mode and select a group of vertices at the center 

0 Hold down the B key just as you did before and adjust the size of the field 

you are selecting, and you should notice the color gradient of what will be 

influenced by the soft selection you have made

Soft Adjustment to Terrain
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Create a new layer and assign the terrain

0 Access the Channels dialog box by clicking on the icon in the top-right corner 

of the Status Line

0 Select the terrain you have just made and click the Create a New Layer and 

Assign Selected Objects button on the far right of the layer area

0 Double-click on the newly formed layer, and give it a name such as Terrain

Assign Terrain to Layer
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Creating the Monolithic Stones

Stonehenge would not be much without stones, so you will be creating a few 

monolithic stones to add to the scene. 

Create Basis Form for Stone Slab

Create a cube

0 Select Create > Polygon Primitives > Cube

0 Set the width to 2, the height to 8, and the depth to 4

0 Set both the Subdivisions to Subdivisions width 3, Subdivisions height 5, and 

Subdivisions depth 5
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Sculpt the stone

0 Select the plane

0 Go to Mesh > Sculpt Geometry Tool 

0 Click the Tool Setting on the far right of the Status Bar

0 Under the Sculpt Parameters choose Operations > Up Icon 

0 Set the Max. displacement to 0.5

Sculpt Geometry Tool for Stone

0 Holding down the B key adjust the size of the brush with which you will be 

sculpting  

0 Begin to pull up the surface geometry to form an interesting stone slab

0 By adjusting the smoothing and trying out some of the other buttons you 

should be able to create a convincing eroded stone form

0 Use different brushes sizes and relax to get a smooth feel to the mesh
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Sculpt the altar and lintels 

0 Continue sculpting the alter and lintels for this mysterious architecture 

using some of the techniques you learned in earlier lessons, such as splitting 

polygons and extrude, if you would like.

0 Use duplicates of the stone already in the scene or practice creating new ones.

Assemble the Geometry Using the Image Plane as Reference 

Assembling Stonehenge 

Now that you have Salisbury Plain hidden away you can begin placing your 

objects around the site like the ancient did but with much more ease. 

Assemble the stones

0 In the top viewport is the easiest way to move, scale, rotate, and position your 

new forms.

0 Use the image plane as a reference to where the stones should be placed.
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Adjust the stones

0 Using the soft selection at a lower falloff radius in vertex mode will allow you 

to gently massage the forms to each be unique and fitting to the plan visible in 

the image plane

0 Continue to follow the plan and position the rest of the stone

0 Add the lintels and scale them to be appropriate

0 Duplicate and Scale some of the stone to be smaller stones to match the plan

0 Save your scene

Adjust the Forms Using the Image Plane as Reference 
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Top Viewport Showing Image Plane and Placement of Stones

Concepts Explored

Creating Terrain

Staging primitive ritual

Ceremony in the landscape

Architectural themes of Site and Place

Stonehenge after many years Finished Model

Understanding the ideas behind establishing 

a site will help you when approaching any 

architectural problem. Now that Stonehenge is 

set up, continue to assemble the structure and 

consider researching this particular ritualistic 

architecture and try to reassemble the pieces 

to how it presently stands with broken stones 

and buried eroded elements. You could also 

raise the mound high and situate the stone up 

high or dig a hole and position them around 

the edge to see how site can vary with the 

same architectural elements at your disposal.
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The Elements and Principles of Design

The elements of design are the foundation to all visual imagery including traditional painting, illustration, architecture, graphic 

design and 3D art.

Think of elements as ingredients such as flour, baking soda, water or vinegar.

Principles are the wisdom of how to combine these ingredients, or elements. If you want a mild combination, mix water and flour. If 

you want an exciting combination, mix baking soda and vinegar. 

It’s the same with the elements and principles of design. Lines are elements. Everyone uses lines when they draw a picture. But an 

artist may draw a group of people using wobbly or energetic lines to give the picture a repetitive pattern. That’s the principle of 

rhythm. The artist may also use stiff lines to make one person stand out of that group. That’s the principle of contrast.

A comic book works the same way, but over a series of pages. Let’s look at another element: the point. In a picture, a point may be 

just a dot. In a comic book panel, it may be “the most important point” in the panel, like a light on a control panel. On a comic book 

page, it may be a series of panels that make “points” to tell the story. For example, one panel shows a red light to make the point 

that the character is in danger; the next panel shows her face to make the point that she isn’t afraid, and so on.

But not every point needs a panel. One panel may show a key entering a car’s ignition. The next may show the character arriving at 

a destination. We don’t need to show her putting the car into gear, using the blinker, or adjusting the radio – only enough to make 

the point that she drove there. That’s the principle of economy.

Knowing the elements and applying the principles can help you direct an animated story. If you consistently place the camera at 

medium distance (the element of space), you’ve applied the principle of unity: “one-ness” of camera placement. If you think it’s bet-

ter to simply return to that position every few shots, you create rhythm. If that always-the-same position gets boring, a final close-

up on a character’s face creates emphasis. It also creates contrast. We pay attention because it’s different from what we’re used to. 

It also creates balance. We had a big dose of medium shots, and we “balanced it out” with a close-up shot.
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The following are additional examples of how using design principles can help you tell stories:

With color, you can give a story unity and economy by choosing a limited palette.

You can create emphasis and contrast by using a dull palette to set the stage for a sudden bright color to pop out.
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You can create balance by using cool colors, like blue and green, for scenes that feel calm; and warm colors, like reds and oranges, 

for scenes that feel as if “the heat is on”.
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With lines, you can design your shots with horizontal and diagonal angles until your character stands strong. Then you can intro-

duce vertical lines, which give us contrast and balance.

With texture, you can emphasize smooth surfaces until “the going gets rough” in your story. Then you can introduce rough surfaces 

for contrast. Be careful, though. if those surfaces look like they don’t belong in this story, you my lose unity.

If you’ve ever wondered how great artists, animators and filmmakers make their decisions, here’s the answer: they follow their 

instincts. They feel as if the picture or story “ought” to be this way. They feel that a close-up shot reveals the character’s feelings 

better than a distant shot, or that a distant shot shows the character’s predicament better than a close-up. These decisions may be 

based on instinct, but sometimes our instincts get muddled, or they need guidance. The principles of design remind us that good 

decisions have common qualities. They are the short list of wisdom that help us make good choices.

Below are the elements of design we will be exploring. Remember they are the ingredients.

• Point

• Line

• Shape

• Form

• Space

• Value

• Texture

• Color
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Point

A point is the most basic of design elements and can be defined as the smallest area of visual attraction in a composition. Point 

is just that, it is a point or mark. But, a single point can also be used to create a focal point and attract a viewer’s attention to a 

specific area, emphasizing the story. A point can define a 

location in space, and it can create an illusion if there are 

multiple lines. When there are several points near each other, 

the human mind starts to create a visual connection. If there 

are very many, more complex shapes can be seen and we 

can even begin to assign mass and a sense of weight to the 

grouping of points.

Line

Line could be considered one of the most powerful elements of design. Line is used to define a shape, describe a contour, or be 

implied by the outside edge of a form. With line, you are able to create and describe much of what we understand about 2D and 3D 

space. A simple line can describe a horizon in a landscape, a road disappearing into the distance, or even something as complicated 

as an expressive quality such as energy or mood.

Characteristic of Line are:

Width or Weight

Heavy lines can be used to indicate a feeling of power or of a 

close proximity while light lines can indicate delicacy or distance.



Design Color Composition20106

Length

Long lines can give a feeling of continuity, while short, broken lines have a nervous tempo or pattern to them.

Direction

Horizontal lines suggest stability and project calmness and peacefulness. Vertical lines depict power and height, and diagonal lines 

can have the feeling of action, movement, or instability.
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Feeling

Sharp, jagged lines can express speed, anger, aggression, or nervousness while graceful, smooth, or meandering lines can suggest 

slowness, elegance and romance.

Focus

Sharp lines give the appearance of clarity and decisiveness, while blurry or fuzzy lines give the feeling of softness, gentleness, or a 

dreamlike quality.
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Contour

Contour lines describe the shape of an object and the interior detail – basically any edge – be it the edge of a shadow or the edge of 

plane. 

Gesture Lines

A Gesture line catches the movement or “essence” of an active figure or scene.
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Implied Line

When points or objects are in close proximity, implied lines are created. An implied line is also created by the point of view (POV) of 

an object or character.

Shape

When a line encloses a space, it creates a shape. Shape is two-dimensional only, meaning that it has height and width, but no 

depth. Depth of a shape can be implied, but it is not real; therefore it is 

illusionistic.

Shapes can be broken down into the following categories:

Geometric Shapes

Circles, squares, rectangles and triangles are the most 

familiar to us. We see them in nature and in the manmade 

realm, ranging from crystals and snowflakes to architecture 

and machine parts. Rectilinear shapes fall into this category 

as well, since they are angular or straight.
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Organic Shapes

Organic shapes are often found in the natural world. Trees, rocks, and cells are all examples of organic shapes as are all animal and 

human forms. But we can also see them in the manufactured world in anything that is free-flowing or irregular, such as drapery, 

overstuffed furniture and many stained-glass windows. Curvilinear shapes refer to the use of curved, rounded forms.

Positive Shape

A positive shape is the object within a picture plane, such as a chair.
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Negative Shape

A negative shape is the space around and in between (the openings within) the positive shape.

Static Shape

A static shape appears stable and unmoving, such as a mountain or a simple block.

Dynamic Shape

A dynamic shape appears to be moving and is active, such as the cloud 

formations around the mountain or a lightning bolt.
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Form

Form is the three-dimensionality of a shape. Shape is only two-dimensional, lacking depth; form is three-dimensional, having depth. 

Form can exist in real space, and it can exist in virtual space. With a form, you move around in it and, in the case of a building, walk 

into it. To imply form of a shape in 2D space, you can use shading or perspective drawing. By creating a light source for a circle and 

casting a gradation shadow, you can turn a flat circle into an illusionistic sphere. By using vanishing points, you can create the illu-

sion of a flat square becoming a 3-diminsional cube. Any shape can be made into a form by adding depth.

Shape

Form

Space

Space is the expanse or area in which all objects and events take place. Space has three-dimensions; width, length, and depth. 

Space can also be considered to have a fourth dimension of time. With an environment you are able to walk through and explore 

the space. With an object, you are able to walk around the object, look above it and under it. In the case of architecture, there is 

exterior space, and there is interior space. 

Two-dimensional space
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Types of space:

Positive Space

Positive space is like a positive shape, in that it refers to the shape of the object in space.

Negative Space

Negative Space is the space around the object. Negative space, as seen here in the space around the vase above, can also have a 

recognizable shape. Playing with these two spaces can create interesting results.



Design Color Composition201014

Picture Plane

The picture plane is the flat constraints of your composition; a space having width and height, but no depth.

Composition

Composition is the arrangement of your design elements within the picture plane.
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Focal Point

The focal point is the area of your composition that you want to have priority over the rest of the composition. The focal point has a 

dominant presence. In other words, it has hierarchy over the other elements.

Proximity

Proximity is the space in between shapes or forms. Proximity can create tension or balance by the positioning of the shapes or 

forms in relationship to each other.
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Value

Value is a range of lightness and darkness within a composition or within a shape or form. Value ranges from pure light to complete 

darkness, with all of the scale ranges in between.

Tint

Tint is the white added to a color or value. By adding white to a green, you tint the green to a white. By adding white to a medium 

grey, you change the medium grey to a lighter tint of grey.

Shade

Shade is the opposite of tint. By adding black to a color or value, you change its shade. A night sky would be a dark shade of blue. 

Black added to a medium grey would be a dark shade of grey.

Contrast

Contrast is the difference between values. The larger the difference between values, the higher the contrast will be. The closer the 

values, the lower the contrast will be.

Gradation

Gradation is the change in value ranges over a composition or an object.

Scale

Scale is the range of pure light/white to pure dark/black of any color.

Elements of Value:
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Texture

Texture is the surface quality of an object. Texture can be rough and prickly, like the surface of a cactus, or it can be soft like the fur 

on a cat. It can be woven like a basket, or it can be smooth like glass. Texture can be real – something you can touch and feel on an 

object. It can also be implied by the use of pattern and value, as in a drawing/painting of an object’s surface or skin.

Color

Color is the most complex of all the elements. It has a physical presence and creates a psychological response in the viewer. Did 

you know that color comes from light? Did you ever examine the colors coming from a rainbow? You can see how it was formed if 

you understand the principles of a prism. With the rainbow, the small drops of water in the atmosphere refract the light into the 

separate color spectrums. While a rainbow is refracted light, the color of an object is determined by reflected light. What color we 

see is determined by which light waves or color spectrums are absorbed and which color spectrums are reflected back and picked 

up by the human eye. In pure black, all color is absorbed, and in pure white, all color is reflected back.

Besides the color being reflected, the luminosity (light intensity) of the color is affected as well. When light hits an object, the color 

is either reflected back specularly, scattered, or it is absorbed. More often than not, it is a combination of the three.
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Specularity

Specularity is reflection that has a high sheen or mirror-like quality to it. The light reflection has a focused quality to it.

Scattered

Scattered refers to reflection that is usually uniform in nature due to the light leaving the object in an unfocused radial path.

Absorbed

When light is absorbed, the reflective quality of the color is low and therefore has a soft matt surface. A non-glare monitor screen is 

a good example of this quality.

Now that you have learned about the elements of design here are some exercises to work on.
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The Principles of Design

The principles of design are the ways in which we organize the elements of design to create a cohesive composition. 

The principles of design we will be exploring are:

• Balance

• Emphasis

• Economy and Continuation

• Rhythm

• Unity

• Proportion

• Contrast

Balance

Balance is the visual arrangement of elements or objects in a composition that creates a sense of equilibrium. Balance can be sym-

metrical, asymmetrical, or radial.

Symmetrical

Symmetrical balance means both sides of an imaginary line are the same. Symmetrical balance is another term for symmetry. A 

composition has symmetry elements are repeated in a mirror-like fashion, usually on a vertical axis. This mirror-like symmetry is 

also known as bilateral symmetry.

Symmetry appeals to our innate sense of balance. We see symmetry in our bodies, as well as throughout out natural and man-made 

environment. We observe symmetry on a daily basis in the world around us. For this reason, it can be a valuable tool in design as it 

can evoke a feeling of predictability and stability in the viewer.
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Radial

Radial balance, or radial symmetry, is when elements emanate from or are arranged around a common central point. Radial sym-

metry often incorporates the use of diagonal elements that extend from a focal point. Flowers and other natural forms often exhibit 

this kind of balance. Radial symmetry is used in many circular designs. The attention is drawn to the center by the elements and 

principles used in the design.

Asymmetrical

Asymmetrical balance means each side of an imaginary line is different yet equal. Asymmetrical balance, or informal balance, refers 

to the creation of visual balance through the use of contrasting elements. These elements may include different sizes, shapes, 

values or colors yet still provide, through the equal distribution of visual weight, a sense of balance. 

This sense of balance is created when a design has different elements of equal visual weight 

distributed on either side of a central axis. 

Large, dark shapes always “feel” heavier than light 

shapes. The lower portion of a picture format will be 

viewed as nearer to the ground and heavier because 

of our innate sense of gravity. An element’s visual 

weight will also vary according to size, texture, 

complexity of shape, contrast and placement in a 

design format.
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Emphasis

Emphasis creates a focal point or points in a design. It can serve as a marker to show what in a composition has hierarchy or 

importance. Levels of emphasis can work as road signs to guide the viewer through the multiple levels of a composition. You can 

create emphasis by making something dominant or by creating a focal point.

Dominance

An object or element has dominance when it has priority over surrounding objects either through the use of color, size, position, or 

proximity.
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Focal Point

A focal point in a composition can be created by light and dark (contrast), line movement (either implied or real), the level of 

saturation of colors, and by the use of dominance as described above.

Economy

Economy is a principle of design which emphasizes the simplification of elements to express a message. Only the elements required 

to express the idea are used. The use of too many elements or contrasts in a design may distract viewers from the message, or 

cause them to disengage completely from the viewing experience. To understand economy in design, think about and remember 

the phrases “less is more,” and “in simplicity there is beauty.”
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Continuation

Continuation refers to the “lining up” of visual elements in a design. When 

elements are placed in a continuous fashion, the viewer’s eye will transition 

from one element to the next with a feeling of unity. Continuation can also be 

created by tangible lines that you can see, such as on the edges of a tall building 

shooting up into the sky, and from implied lines, such as the direction a person 

in a composition may be looking. The viewer’s eye naturally follows both to the 

natural conclusion.

Rhythm

Rhythm refers to the repetition of shapes or elements in a design. Rhythm also refers to the movement of the viewer’s eye through 

a design. Often, the repetition of shapes can serve as a tool to create this visual pathway. This repetition may be random or 

planned, forming a pattern. It can also create a sense of tempo, or time, in the composition.
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Repetition

There are different types of repetition.

• Regular

Regular or systematic repetition is created when the elements and intervals between the elements have a consistency 

with very little change.

• Flowing

Flowing rhythm is more organic and can have more variation in the elements used to create the composition, much 

like a winding natural stone walkway or waves of meandering wire.
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• Progressive

A progressive rhythm sets up anticipation of continuation. This is done by the progression of sequential elements, like 

the scene layouts in a comic book or buildings in a city skyline.

Pattern

Pattern is created by elements being repeated in a predictable fashion. The repeating element or elements work together to create 

an overall pattern.
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Tempo

The tempo of the rhythm in a composition is created by the variation of the 

repetition of elements. Small elements repeated frequently and 

close together create a faster visual tempo than larger or more 

fluid elements spaced further apart. This can also create a 

sense of time in the composition.

Unity

Unity refers to visual harmony and agreement among the elements in a design. When the parts work together to create a whole, 

you have unity. This is also called Gestalt. Gestalt is complex. Simply put, it means that the whole is greater than the sum of the 

parts meaning that we as viewers of a composition, get greater pleasure from the whole composition than by examining the indi-

vidual elements used to create the composition. To achieve Gestalt, or unity, we can utilize the concepts of repetition, proximity 

and continuation. 
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Proximity

Proximity can create unity or tension depending on how much emphasis is given to each element and how close the elements are 

placed to one another. A sphere near the top edge of a cube creates tension through the sense that the sphere could drop, whereas 

another cube placed squarely on top of the cube creates a sense of unity or stability.

Proportion

Proportion is the relationship of elements in comparison with each other, or with 

aspects of a single element or object. Proportion can create a sense of unity 

or of unease. If we view a house with a door much out of scale with the rest 

of the house, we have a sense that something is not right. The same goes 

for a man with arms too long for his body. Proportion can also govern 

the amount of an element we use to create balance, such as how 

many organic shapes we might use in conjunction with how 

many geometric shapes. Proportion works well with balance and 

with unity.
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Contrast

Contrast is used to create emphasis through the use of contrasting elements. Elements with strong contrast stand in opposition 

to one another: light against dark, large against small, round against square, smooth against rough, etc. In color, this might mean 

warm colors against cool colors, or light colors against dark ones.

There will often be many kinds of contrast within one design. Too little contrast will cause a design to be uninteresting; too much 

contrast can cause it to be confusing. 

Contrast is a part of our everyday world. From the shape of a building against the sky, a boat against an ever-changing backdrop of 

sea and sky, or a statue in a garden, the mix of man-made and natural contrasts is all around us.

Examples of contrasts used in design might be:

• Large to small

• Light to dark

• Curved to straight

• Old to new

• Geometric to organic

• Smooth to rough

• Warm to cool

• Many to few

• Deep to shallow

Types of contrast

Line Contrast

The use of different types of lines can create a strong contrast. Thick, bold 

lines have a bold effect, but when contrasted with delicate lines, the entire 

atmosphere of a design can change. The bold lines may appear closer and the 

smaller, more delicate lines appearing further away. An emotional context can 

be established for strength versus weakness, leader versus follower, etc. 

Line contrast can also create pattern and texture. Think of the hard flowing 

line that might make up the horns of a goat (pattern), and the short softer 

lines that can represent the fur of the goat (texture).
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Shape and Form Contrast

Similar shapes of different sizes offer many opportunities for contrast. A larger shape may seem to advance visually, or it might 

appear more stationery because of its stronger visual weight. A smaller shape, because of its lesser visual weight, may seem to have 

the freedom to move around at will. Working with this type of contrast becomes an 

exercise in space and balance.

Completely different shapes offer another approach. Differences between large 

and small shapes can provide one form of contrast, but complexity or 

simplicity of different shapes and their relationships to each other 

plays a large part in the overall contrast of a composition. 

A small, but complex organic shape can offset the size of a 

larger, simpler one. The eye will be attracted to the smaller, 

organic shape because of its complexity. 

Angled or sharp edges can be very dramatic 

when tempered with curved or softer shapes. 

This type of contrast adds visual interest to a 

design.

Color Contrast

Color allows for very bold, or very subtle contrast, and an infinite number of steps in between. Colors can be contrasted with warm 

against cool, light against dark, bright against muted, etc.
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Value Contrast

The effects of dark and light offer an infinite number of dramatic possibilities. They can set mood, create emphasis, establish a pat-

tern, as well as give a sense of excitement, dimension, space, or environment.

Composition

Focal Point

An area of interest is called a focal point. As an artist, you can create and 

manipulate this area of interest. A focal point can also be thought of as a 

visual starting point within an image or space.

When designing a composition and placing a focal point, the artist is 

creating areas of emphasis within the picture area. The Golden Section 

is one method that artists throughout history have used to create these 

divisions of space in a harmonious manner. The “golden section” is a system 

of proportion, devised by the Ancient Greeks, based on mathematical 

relationships found in nature. This system of proportion relies on the use of 

a ratio, which defines the relation of one part to another. This is also used 

to create a relationship to the whole composition through a mathematical 

formula. The “golden section” is also known as the “golden ratio”.
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Contrasts of value, shape and color are all simple and effective ways to engage the viewer. These differences and contrasts attract 

attention and can be used to make images more engaging.

The area of greatest contrast may also be the area of greatest interest in a design. This area of interest is called a focal point. The 

artist is both the creator and manipulator of this area of interest. 

There are many ways to create this area of visual interest but one of the simplest is through value contrast. To review, value con-

trast refers to the relationship between areas of light and dark. Areas of similar value within an image are can be described as low-

value contrast and areas with more extreme, pronounced value contrast can be referred to as having high-value contrast.

To create a focal point using shape:

• Use complex shape(s).

• Direct the viewer using compositional or perspective lines.

• Isolate the area of interest.

• Interrupt a pattern.
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To create a focal point using value:

• Place highest value contrast in area of emphasis.

• Create a focal point in a high key design with dark values.

• Create a focal point in a low key design with light values.

• Create emphasis with size difference.

To create a focal point using color:

• Place an intense, saturated color in a design of muted colors to create emphasis.

• Place muted colors in a saturated design to create an area of interest.

• Introduce another color in a monochromatic scheme to create a focal point.
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Color Theory

Controlling color can be difficult. But, it can be one of the most effective ways to control or affect a composition. The best approach 

with color is to think about a color scheme before applying color to shape or form. Joseph Ittens, the famous color theorist, said, 

“He who first draws lines and then adds color will never succeed in producing a clear, intense color effect.” Color is an essential part 

of any composition and needs to be determined in the early stages of any work to be the most effective.

Color is tricky, in that it is constantly changing and is always being influenced by the colors surrounding it. It is almost impossible to 

see a color by itself without it interacting with its surroundings. In virtual space and on a 2D plane, color can behave quite differ-

ently than in the real world. In the real world, distant objects in the background appear to blend together and appear less saturated 

due to atmosphere. This can be replicated in virtual space, as well as on a 2D surface if you understand how to manipulate color.

The Color Wheel

Many people find choosing colors that work together an intimidating and confusing process. The following are some of the basic 

principles about how the color wheel works and schemes for using color. The following guidelines will help you learn how to use a 

very limited palette, yet give the impression of using many colors. The basic color wheel is made of twelve colors:

• Yellow

• Yellow-green

• Green

• Blue-green

• Blue

• Blue-violet

• Violet

• Red-violet

• Red

• Red-orange

• Orange

• Yellow-orange

All colors can be changed by changing the tint or shade. Tint is changed by adding white, and shade is changed by adding black. The 

following colors examples will include not only hue (the color) but the hue with tint (white) and the hue with shade (black).

Primary Colors

Primary colors are used to create all other colors. When Primary colors are used 

together in a design, there is a strong color contrast because of their lack of 

similarity. Each color has a separate, independent identity.



Design Color Composition201034

Secondary Colors 

Secondary colors are the product of mixing two primary colors together. They are positioned midway between the primary colors 

from which they are mixed. Secondary colors, when used together, have less color contrast than primary colors. For example, green 

and violet are secondary colors which both contain the primary color blue. The influence of the color blue creates a commonality 

between them. A softer color contrast is the result.

Tertiary Colors

Tertiary colors are made by mixing a primary with a secondary color. They are positioned between the primary and secondary colors 

from which they are mixed.

Temperature

The color wheel can be divided into areas of color temperature, known as warm and cool. 

Cool Colors

Cool colors are any colors that contain or are related by the color blue. Colors such as green, blue and violet are dominant cool 

colors. Cool colors are calming and appear to recede into space when placed next to warm colors.
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Warm Colors

Warm colors are any colors that contain or are related by orange. Yellow, orange and red are dominant warm colors. Warm colors 

are aggressive. When used with cool colors, they appear to move forward into the foreground.

Working with Color as a Beginner

Many artists who are just beginning to work with color find choosing colors that function well together an intimidating process. 

The biggest mistake artists make in the beginning is trying to use too broad of a color palette. Learning to work with a limited 

palette in an effective way can actually give the impression of using many colors. Let’s look at a few of the basic color schemes and 

consider some of the basic ways to begin using color.

Monochromatic

Monochromatic is the simplest of the color schemes. It uses only a single hue along with tints, shades, and tones. Adding a neutral 

and varying the values of that single color can help create interest and add contrast. A monochromatic color scheme explores the 

tints and shades of a single color. You will notice that the pure hue is brighter and more vivid than the hue mixed with either white 

or black. The color in its fully-saturated state attracts the eye more powerfully than the tints and shades around it. The tints and 

shades are not as intense in hue saturation and become desaturated. Adding white, black, or any other color to a pure color will 

desaturate it.
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Analogous

An analogous color scheme uses two or more hues lying next to each other on the color wheel. This is an elegant scheme to use 

and often seen in nature. An analogous color scheme is harmonious because the colors used share common color characteristics.

For example, red-orange, orange, and yellow-orange are all mixed from varying amounts of red and yellow. Analogous color 

schemes can be very effective and like monochromatic, in a 3D environment or on a flat 2D picture plane, can create color consis-

tency.

Complementary

A simple complementary scheme begins with two colors that are opposite of one another on the color wheel. These colors intensify 

each other’s appearance, so the end result tends to be stimulating, and can even give the visual illusion of vibration

Toning down the saturation of complementary hues (with tint/shade/saturation) and raising or lowering their value beyond the 

level of maximum saturation lessens the visual contrast between them.
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Triadic

This is a broader range of contrasts that draws on three colors equidistant from each other on a color wheel. (This happens if you 

draw an equilateral triangle within the color wheel). An example would be the three primary hues. If you turn the triangle a bit, you 

would have red-orange, yellow-green, and blue-violet. When any two colors from a triadic color scheme are mixed together, they 

will create interesting semi-neutrals. 

These colors are called semi-neutrals because they are not true neutrals. A true neutral, or mute, is the product of a color mixed 

with its complement.

Split Complementary

A split complementary is any one hue plus the two hues located on either side of its complement. This can be a broad color scheme 

and easy to use in a number of interesting ways.
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Hue, Value, and Intensity

Every color has three properties: hue, value and intensity. 

Hue

Hue is the quality we identify by a color name such as “red” or “purple.” It corresponds to the distinctive wave-length of a color. To 

change the hue of a color, we must mix another color with it. If a little green is mixed with blue, the resulting change from blue to 

greenish blue is a change in hue.

Value

Value is how light or dark a color appears. Referring to the relation of a color to white or black, value indicates where on the value 

range of pure dark to pure light a hue resides. Think of it this way: a light blue sky has a high value; a dark night sky has a low value. 

A change in value is higher or lower in value than the normal spectrum of the hue. 

To change the value of a color, we need to mix it with something lighter or darker. By mixing black or white with a color, we change 

the value without changing the hue. This is how you desaturate a color.
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Intensity

Intensity refers to how bright or dull a color appears. It is also called saturation or chromaticity.

Basically, intensity is how much of the hue is identifiable. Grays are achromatic, meaning no hue or color is identifiable. Therefore, 

grays are low in intensity. A primary red, on the other hand, would be completely saturated and therefore extremely intense and 

high in chromaticity. Hues reach their full intensity at different values. Yellow would reach its full intensity higher on a scale of 

grays than red or blue.

Different colors have different values. For example, if you compare the value of yellow to the value of violet, yellow is much lighter 

in value than violet.

One way to imagine the value of a color is to imagine it as a black and white 

photograph.
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Neutrals

Neutrals are hues that have had their complements added to them. Adding a color’s complement to desaturate it is referred to as 

muting the color. This creates a neutral hue. Mixing any two highly contrasting colors is an easy way to make the colors harmonize. 

The two hues mixed begin to share the same influences in the process.

This process is one to stay in if you want your work to appear harmonious. It is also one way to ensure a pleasing color scheme. 

When you can work primarily in the neutral range, you can use the more saturated and contrasting colors to create your focal 

points or relief to the predominate color range.
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Color and Storytelling

Color theory may not be magic, but it does bring us to the hidden emotional power of color.

When it’s a drab day and you watch a movie that takes place in a sunny resort, you may feel as if you’ve been in the sunshine. What 

we see affects our feelings, but how? If you put your hand on a picture of warm colors, then on a picture of cool colors, you can’t tell 

the difference. But somehow your eyes tell you that one is warm and the other cool. That’s because color has “associative power.” 

Warm colors like yellow and orange and red are associated with the sun and fire and embers. Cool colors like green and blue and 

violet remind us more of leaves and pools and nighttime. There are exceptions – some fire is blue, and the petals of a rose may be 

just as cool as the leaves – but we still feel as if red is warmer and blue is cooler, even if it’s not literally true.

Artists use this. Storytellers use it. They choose colors based on how the colors “feel.” They may use bright colors to make a block 

look like a piece of candy, or a poisonous frog. They may color a track to appear like vines or limbs or blood vessels or trails of light. 

They may color a tense conversation scene with a palette like an erupting volcano. They may color a love scene, even if it takes 

place indoors during the winter, with a palette like a spring garden. This is how we use color creatively – not by choosing literal 

colors, but by choosing colors that express feeling. Or to put it another way: we don’t paint with acrylics or oils or RGB coordinates, 

but with fire and ice and blood and earth.

Now, put your imagination to work. How would this scene look if it were colored like an ice-cream parlor? 

A blast furnace? 

A jungle?

 A farm? 

A junkyard? 

A fiesta? 

A desert? 

A dungeon? 
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What “season” should it feel like? Autumn colors may give a story a somber tone, whereas summer colors may feel more cheerful. If 

you think this scene should feel a certain way, come up with your own ideas for color associations. It will help you to make creative 

choices for your palette, and add emotion to the scene.

As you learn to model, texture and animate in 3D, think about how the elements and principles of design, color theory and compo-

sition apply to your scene. 

• Are your objects interesting shapes?

• Are the scale and proportion working?

• Are there areas where your eyes can rest?

• Are there focal points to draw the viewer to?

• Are you using color to tell your story?

Working in 3D allows you to view your objects in orthographic and perspective views. You are able to create objects and render 

them from different camera angles. Design, color and composition are important factors and a larger challenge to control in a 3D 

space. As you start to lay out your project, think about what the story is you want to tell and how you can apply the theories you 

have learned to create a clear message for the final viewer of your project.
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In this lesson, you  learn the process of creating a texture from photographic 

references, and how they apply to video games and film.  The texture tells 

the story of the untextured grey model.  Textures add life to the entire 

environment, and give way to new ideas.  Many art styles are combined when 

creating professional textures.  Hand painted textures are created with a stylus 

much like a painter’s brush.  A great deal of time is required to get high quality 

results.  Devising a system of texture creation can speed up production time.  

The process is easy to understand, but it may take some practice to get the 

textures just right.

Tileable and Custom
A texture map is a 32 bit RGB color file created in Adobe Photoshop or 

another 2D painting program.  Textures are used in video games, film, TV, 

and advertising.  Most 3D models have a texture on them,  like a colored skin 

that shows color, specular, and fine details.   Procedural textures require a 

mathematical algorithm to be generated.  These are used mainly in film and TV 

production.

A tileable texture is a 2D image that is applied to a polygonal object or BSP 

level geometry.  You create the textures from a digital photograph or a hand 

painted image.  Tileable textures are designed to have seams in a specific 

area, or no seams at all. Having no seams enables  a texture to be repeated 

over a large area.  Custom textures are unique to a specific model or area.  A 

custom texture has unique UV space and a fixed resolution.  It is possible to 

reuse portions of a custom texture to save space and time.  One way to reuse a 

portion of texture is to mirror from the right side of an object to the left side.

Pictured are a tiled brick texture and a custom metal prop texture. 

Tileable brick texture                                             

Custom prop texture
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The images display a brick texture mapped on primitive objects.  The brick 

texture is tiled once, and can be made to tile in all directions.  This is a Phong 

shader, and it has a diffuse, specular, and normal map.

Diffuse Map Specular Map Cosine Map Normal Map



Workbook2010WorkbookWorkbookTexture Principles 
5

Te
xt

u
re

3D Visualization & Animation Competition

Pictured is an organic grass texture.  This is a Phong shader and it has a diffuse, 

specular, and normal map.

Diffuse Map Specular Map Cosine Map Normal Map
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You create procedural textures using a nod- based system in the material editor 

of the 3D software package or game engine.  These textures are mathematically 

based, and can be infinitely tiled.

The image is a chrome shader on a 

sphere, in an environment with checkers 

on the walls and floor. Notice the yellow 

lights in the scene are reflected on the 

chrome ball. There is a directional light 

facing downward to the lower left, and 

two point lights.
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The process for creating a tiled texture that may  be used vertically and 

horizontally is done in Photoshop.   Once you have a good photograph, use the 

offset filter to display the seams in the middle of the texture.  The goal is to 

paint out the hard edges.  Using the Clone tool, the seams are hand painted so  

they are not visible.  The same process is done for concrete and wood textures.  

It is more difficult to paint out the seams in organic textures, and may take time 

to perfect.  Brick can be made seamless by using single or groups of bricks to 

cover the seams. 

The images are of  a grass texture,  the offset texture, and  the texture with 

seams painted out.

Pictured is the seamless grass texture tiled twice in both directions.

Original grass texture Grass texture using offset filter Grass texture with painted seams

b th di ti
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When creating a texture for film or video 

games,  use the proper pixel size.  Texture 

sizes are often divisible by an even number 

such as 8.  A common texture size for 

the Xbox 360 and PS3 is 512 by 512, up to 

2048 by 2048 pixels.  When creating textures for film or TV, the current 

standard is 4096 x 4096 pixels.  In film, textures are all custom. This 

means every part has its own area of texture space, so  nothing looks 

repeated.  In video games, disk space and memory are always a concern, 

so mirroring of textures is common.  A texture can be resized for game 

optimization at longer distances, which is called a mipmap.  The texture 

size is quartered several times to create a smaller file size.  

The image is mipmap for a brick texture.

The images are the brick texture on a cube, one is tiled once, and the other is 

tiled twice.

UV’s tiled once UV’s tiled twice
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You create a mipmap using a plug-in for Adobe Photoshop, with the Nvidia 

Normal Maps and DDS filter.   The Nvidia Normal Map and DDS filter create 

normal maps, and may also  export specific settings to the DDS format.  The 

DDS format is a compression tool for exporting smaller versions of the same 

texture.  Creating a mipmap is usually done on the programming side, and is 

automatically swapped when the player gets farther away from an object.  The 

physical resolution or polygon count is optimized in video games called a Level 

of Detail model. A LOD model is created at half the resolution for viewing at 

long distances. In film, there is no need for this since it is all rendered out for 

non real time viewing.  

The image is mipmap for a prop texture.
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UV Placement
A model has a set of UVs  on each polygon edge, similar to  a vertex for 

texturing.  A tileable texture usually starts on the 0 to 1 Texture Range, and 

can be scaled to the desired resolution based on the geometry size.  It is 

okay to go outside of the 0 to 1 UV space when creating a tileable texture 

in a 3D package.  In a human head model, the geometry is laid out so that 

there is no UVs overlapping.  In some cases, there may be overlapped UVs 

when the geometry is mirrored or reused.

The image is the Autodesk Maya UV Texture Editor and 0 to 1 texture 

range.

Pictured is a prop with correct UV placement, although there is some 

wasted UV space.  Use stickers and detail variations to fill empty space.  

Try and fill the empty space with extra details and variations
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p

The image displays  a UV Layout with UVs in the 0 to 1 space.

The image displays the UV layout with tiled UVs twice.
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A square texture occupies the 0 to 1 UV space, such as 512 by 512. A rectangular-

shaped texture, such as 1024 x 512, also occupies the 0 to 1 space.  However, it 

must be scaled left to right to fit.  When the texture is applied, it will show up 

in the Texture Editor and on the model as looking correct.  This is a good way to 

save space using the 2:1 ration textures. When creating UV layouts, think about 

ideal placement for optimal resolution and reuse.  It might seem extreme, but 

the tighter the UVs, the higher the quality of the textures.  

The  texture displayed  fits in the 0 to 1 space and is 1024 x 2048 pixels.
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This image is the UV layout of the handgun.
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The texture displayed  fits in the 0 to 1 space and is 1024 x 1024 pixels.

This image is the UV layout of the prop.
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The Grid
The grid refers to the coordinate system that a game engine, Photoshop, and 

3D software use to align geometry and textures.  The game engine is based 

on powers of 2.  The grid is used in every 3D software package, but may have 

different settings. It is applicable in creating assets for film and TV. Setting up 

proper grid units in the 3D software and Photoshop enables you to take full 

advantage of reusing textures.  The artist creates trim pieces that can be taken 

from a tileable texture and reused throughout the level. Texture sets that are 

the same style may be built on the grid, and will line up with the game engine 

or 3D geometry.  

The image is a photo of a grid setup in Adobe Photoshop with a grid overlay 

and rulers.

In older generation video games, the 

textures were made to lie precisely 

on the grid.  Today, video games 

have enough storage to have custom 

texture maps on many surfaces.  

When creating environment artwork, 

use the 3D grid.  The grid enables 

modular pieces to  be snapped to 

one another.  Many video games also 

take advantage of the 3D package 

unit setup, which usually matches the 

video game engine units.  You adjust 

the grid for the scale and dimensions 

of the object being created.  It is 

important to build the geometry 

clean, so there are few intersecting 

pieces of geometry.  

Pictured here is a cube snapped to the 

grid in Autodesk® Maya® software.
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Texel Density
Texel density is  the pixel resolution on the relative size of the object. The 

pixel resolution  keeps a relative balance between the textures in a scene.  It 

is best to keep a close relationship of resolution on the environment and 

characters.  You make adjustments  if visual flaws are apparent.  Some game 

engines automatically use a predefined texel density, such as 4 pixels per inch.  

The game engine  automatically repeats the texture to fit the size of the level 

geometry.  In film, the resolution is set manually by the artist in the UV editor.  

There are resolution standards for games and films that export directly from a 

3D package.  

Texel density is the amount of pixels used per inch of geometry.  A 512 by 512 

pixel texture covers 7 1/2 feet of space, or 90 inches. A 1024 by 1024 pixel 

texture covers 15 feet of space, or 180 inches.  The desired texel density of 5.6 

pixels per inch is calculated this way for most surfaces.  When creating smaller 

table top sized props, use a higher texel density of 8.5 pixels per inch. This 

means that a 512 by 512 should cover 5 feet, or 60 inches.  A vehicle or portion 

using a 512 by 512 texture equates to 10 feet or 120 inches, with a texel density 

of 4.2 pixels per inch.  The wheels  use the 90 inch formula of 5.6 pixels per 

inch.  

The image is a 7 1/2 foot and 15 foot wall using a 512 by 512 texture.

In Maya, enter 90 in the Projection Height and Width. It displays the amount of 

UV space to use.  Autodesk® 3ds Max® and XSI also have settings that enable 

a fixed texture resolution.  If your object only takes up one quarter of the 0 

to 1 space when a 90 inch projection is used, then the model will only require 

a 256 by 256 texture.  This ratio of size to pixels may  be changed when more 

resolution is needed.  There is no exact texel resolution for film or games. It is 

usually set by a technical director and may vary.  

The image is an 8 foot prop using a 1024 by 1024 texture. 

Brick wall that is 7 1/2 feet 

tall using a 512 x 512 texture

Brick wall that is 15 feet tall using a 512 x 512 

texture
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The image is a tiled grass texture applied to a polygon plane.

Common Usages
There are many hard surface and organic types of textures with multiple 

uses.  When creating a texture for film or games, never assume that it has 

one purpose.  An artist applies a wall texture on the floor or ceiling.   It is 

good to create textures for use on multiple types of architecture.  You use 

hard surfaces such as concrete, metal, and wood on almost every type of 

surface. 

In the image, the textures point to their location on the model.

Do not build surfaces such as grass and dirt on the grid unless they have 

incorporated trim pieces. Organic textures are commonly used on ground 

surfaces.  Architectural pieces such as floors, walls, ceilings, and trim are 

similarly made.  These pieces are grouped in texture sets.  Create doors, 

windows, and detail pieces to accent the environment.  

The polygons are best to texture if the 

geometry is flush, without overlapping 

areas.  Without lights, the wireframe and 

shaded views display the geometry lines and 

hard edges.  If the model is built in quads, 

the video game converts it to triangles.  This 

is done to optimize performance of the 

render engine.  When rendering for film, 

keep the geometry in quads.
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Workboo

Pictured are the Bio Chamber scene in wireframe and 

shaded wireframe.
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The image is the Bio Chamber scene with textures applied.
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Reference Images
You use reference images as visual guides to create the details of the 

texture.  It is difficult to create  details from memory.  When designing 

a texture, use photographs or  references. Apply the reference photos 

directly on the texture and blend into the surrounding elements.  Using 

realistic textures creates a good sense of urban reality.  Many films and 

video games are themed to an urban style.  

The images are references of a cargo container, concrete cracks, broken 

glass, and rust.

Concept art is often used as a style guide to 

create 3D models.  It is best to have clean line 

art to work from.  An orthographic drawing 

is made by the concept artist, and may be 

modeled from as a visual guide in the 3D 

viewports. 

The image is a drawing of a chandelier 

prop.
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It is a good idea to use a color scheme when building a texture set. Try 

different color schemes before settling on a specific one.  Complimentary 

colors often work well.  Use low saturation pantone colors to create a color 

scheme.  Sometimes, one color needs the slightest adjustment, either in 

the hue or saturation, to make it perfect.  Using a color scheme ensures 

that textures maintain visual consistency.  The colors of a palletized color 

scheme were placed in vertical strips, and gradients of grey were overlaid 

horizontally to create different hues.

Pictured is the color scheme 

used for the Bio Chamber. 

The image is an example of a 

palletized color scheme.

Base Textures and Detail Templates
It may take a production artist several hours to create a single texture.  To 

save time, create a base set of Photoshop layers to use for a texture set.  

You use these layers as a starting point, and then add the details needed to 

build the final texture.  This system enables the textures to have a uniform 

look.  

A metal base texture is built by taking a series of metal photographs, and 

setting them to Overlay Layer Style. Set the Opacity 20%.  Use five to ten 

images to create a metal base texture.  Below is an image of four side by 

side examples of textures used for the metal base.  The same process is 

used  for concrete, organic, and custom layout textures. Similar textures 

are used on organic textures, not necessarily metal photos.  You use this 

process  to create a consistent look in film and games.

The following image is four metal base texture examples

Basesesese TTTTexexexextureeees sss anananand ddd DeDeDeDetatatatailili  Temmmmplplplplatatatates
It may takaaa e a prprprprodo uction artisst t tt sesess veraraaal hours t

save time, cccreate ee a bababaase sssset oof Phototototoshop lay

Y th l ttt ti i t d t
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Positioned under the metal base layers are localized Color Areas.  This is 

an  easy way to block in the color, and  change it  any time.  You use the 

Marquee Selection tools to select areas, 

using the UV map as a guide.  You employ 

the Paint Bucket tool to fill in areas with 

color. 

The black, gray, and blue colors display 

areas where this process has been applied.  

Once the base texture is built up to a 

good point, it is easy to place the base 

metal layers into a folder and reuse to 

other files.  

The images display  the color base map 

and the color with metal overlays.  

Pictured below is a common layer tab in 

Photoshop.
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Detail templates are similar to  metal base layers because they are a 

collection of details that may be reused on many textures.  For example, 

a  rust dripping texture may take several minutes to find and extract using 

the Color Selection tool.  You  copy and paste it to the new layers, and 

tweak it to the desired parameters.  Multiply this task by 20, and it may 

take several hours.  The trick is to save your handpicked, cleaned up details  

to a new file or separate folder.  When a rust texture is needed,  go to the 

folder, pull out a layer, and flip it or erase a bit to make it look different. 

Create detail templates  for bolts, cracks, stickers, and color variations.

The image is a detail layer set of rust that may be used for overlays.  

The image is a collection of stickers and logos used to detail the textures.
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High Resolution Models
You use primitive and complex models  to design a tileable or custom texture.  

Details do not always have to be created in 2D.  You may use high resolution 

3D models to design all the texture.  High resolution models  add great realism 

and depth to the texture.  A 3D model enables you to bake a normal map and a 

matching ambient occlusion map.

The image  below is a picture of a high resolution model used to create the Bio 

Chamber textures.

The process for constructing a normal map begins by creating a high 

resolution model and a low resolution model.  The high resolution model 

is created by using polygons and a collection of detail pieces.  Establishing 

a library of detail pieces makes it easier to design complex models.  Once 

the high resolution model is finished, it is baked down to the low resolution 

model.  The low resolution model may be a primitive plane or fitted to the 

high resolution model.  Creating textures that have detail baked in will save 

on the polygon count and improve performance.  

The image is the normal map rendered on the low resolution geometry.
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Textures add more realism to an environment and characters.  There are many 

2D painting programs that can be used to create textures, such as Adobe 

Photoshop and Corel Painter.  Many artists use photographs and add hand-

painted details to create textures.  Every artist paints a different way, with a 

certain style or look.  Sometimes you  adapt to a predefined art style, so that 

the textures look similar.  The textures in this lesson are from  different models, 

but were all painted by the same artist.  The first textures shown are from a 

science fiction-themed scene. The textures depicted later in this lesson are 

from an ammo case prop and a fantasy prop.  These scenes and props were 

rendered using mental ray Standalone in 3D software such as Maya, 3ds Max, or 

Softimage (formerly Softimage|XSI) .

The image displays  a render of the Bio Chamber created in XSI

Pictured are renders of the Hydrant Prop created in Maya.



Workbook
26 2010WorkbookWorkbookTexture Maps 
226626

Te
xt

u
re

3D Visualization & Animation Competition

The images  are renders of the Ammo Case created in Maya.
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Standard Texture Maps

AO Maps
Ambient Occlusion is a shading model that 

adds realistic shadows to a 3D model or 

scene.  AO maps add shadows to cracks and 

the underside of objects.  AO maps have 

a soft look,  and are used as an overlay on 

the diffuse texture.  This is accomplished by 

setting the AO map Layer Style to Multiply 

in Photoshop. This is a  simple way to fake 

global illumination, which is a method to 

calculate realistic lighting.  It saves rendering 

time because the shadows are overlaid onto 

the diffuse texture.  AO maps are created 

from a high resolution model and can take a  

long time to calculate.

The images  below are  ambient occlusion 

maps.
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Normal Maps
A normal map is an RGB colored texture 

that acts as a 3D bump map.  A normal 

map uses X, Y, Z coordinates to add detail 

to the surface normal of the polygon 

face.   The normal map adds fine detail 

on a relatively flat surface. The normal 

map is seen when a light hits the polygon, 

shading the concave areas with shadows 

and the edges with highlights. A normal 

map bumps in any direction, but tends 

to degrade the effect when viewed at 

less than a 45 degree angle.  You create 

normal maps  in Photoshop using a 

grayscale image.  You use the Nvidia map 

filter to convert a grayscale image into 

a RGB normal map.  The common colors 

of a normal map are shades of blue, pink, 

purple, orange, and green.

Pictured are normal maps used on a floor 

and props.
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Diffuse Maps
The diffuse map is an RGB color texture.  

This texture  holds the majority of the 

detail and color information seen on the 

3D model.  In production settings, the 

normal map and ambient occlusion maps 

are created before the diffuse map. The 

textures  should have details that line 

up on top of one another.  It is common 

to go back to the normal and AO maps 

to add details while creating the diffuse 

map.  When viewing a diffuse texture in 

a video game engine, it sometimes over 

saturates colors, blows out the color 

white, and darkens black colors.   Lower 

the saturation, and never use pure white 

or black. 

The images are  diffuse color maps.
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Specular Maps
Specular textures come in two styles: 

grayscale maps and color maps.  A 

grayscale specular map accents areas 

of the texture that are shiny and matte.  

White and gray areas are shinier when 

hit by a light.  The black and dark gray 

areas do not reflect much light, and 

have a low specular value.  You use color 

specular maps  to add color when viewed 

at a glancing angle.  To create a chrome 

material, add some of the same color 

to the specular map.  The specular map 

adds  refined detail in a texture.  The final 

specular map is sharpened or blurred to 

get a worn or soft feel.

The images  below are specular maps.

Color Specular Map                                                Grayscale Specular Map
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Special Texture Maps

Alpha Maps
You use alpha maps  for glass, decals, and even hair textures.  An alpha 

map is a grayscale texture usually placed in the alpha channel 

in Photoshop.  The texture is  saved out as a 32 bit 

Targa file.  There are special alpha map settings for 

use in a game engine.  Alpha test is a setting that 

uses almost completely white and black values.  

This is less expensive because the alpha is 

transparent and opaque, with no blending.  

Alpha channels applied to windows  use 

the full grayscale spectrum to achieve 

the desired transparency value.  These 

settings are  slightly more expensive 

in video games, when there are 

transparent objects rendering in 

front of another.  In pre-render, this 

is not as much of a performance 

concern.

The images are an alpha map used 

with alpha test, and another used 

for glass.

Alpha Test                                                 

Glass Alpha                                        

Glass Diffuse
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Cosine Maps
Cosine maps  define the glossiness 

of a surface.  A cosine map is a 

grayscale map, and may be used in 

combination with a color specular 

map.  In some game engines, the 

glossiness level  uses a reflection 

cube map. White areas in the cosine 

map  pick up the reflection of the 

world through the cube map.  When 

trying to get a highly reflective 

surface, the diffuse texture must be 

a darker color.  Cosine maps look 

similar to a grayscale specular map.

The images  are examples of cosine 

maps.
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Secondary Texture Maps

Detail Normal Maps
Detail normal maps  create macro 

details surfaces such as fabric, or 

large subtle variations in stone.  

You create a second set of UVs  for 

adjusting the scaling and  detail.  

Detail normal maps are usually 

small, about 128 by 128 pixels or 

less.  A dual layer shader is needed 

with two normal map channels.  The 

detail normal map is created from a 

grayscale map, using the Crazy Bump 

or the Nvidia normal map filter. 

These images are detail normal maps 

in grayscale and normal map.
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Parallax Maps
Parallax maps are a form of visual displacement map.  This map makes the 

environments surface look like it has more depth.  Parallax textures are 

grayscale textures and are similar to normal maps in that they add depth in 

all directions.  The more extreme the view angle, the more depth is created.  

Organic textures are ideal for parallax maps because they have a nonuniform 

layout.  Custom normal mapped textures are sometimes problematic if they 

have very detailed edges and corners.  Some 3D packages such as Softimage 

create a depth map, which may be used as a parallax map.  There are also file 

converters that  create a displacement or parallax map from a normal map.

The images  are parallax maps for fabric and stone.
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BRDF Maps
The bidirectional reflectance 

distribution function is a four 

dimensional equation that defines 

how light is reflected on a 3D object.   

In video games, a 128 by 128 pixel 

color texture that simulates a light 

source is used to create lighting 

effects.  A BRDF map is created 

on a solid black background, using 

gradients and hand painted details.  

Depending on the placement of 

the painted details, it controls the 

reflection properties on the model.  

One effect is rim lighting, which is 

a highlight around the edge of the 

model.  

Anisotropic is a directionally 

dependent property that prevents 

the light from moving with the 

model when it is rotated.  An 

anisotropic surface  changes in 

appearance as it is rotated around 

its center.  Cloth and velvet are 

examples of anisotropic materials.  

There are two types of BRDF maps: 

a diffuse and specular map.  The 

diffuse map defines the lighting 

from the polygon normal of the light 

source.  The specular map defines 

the lighting from polygon normal 

facing the camera or player.  

The images display diffuse and 

specular BRDF maps.

Diffuse BRDF                                            Specular BRDF

Glass Diffuse BRDF                              Glass Specular BRDF
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Final Textures
Most traditional game engines render a diffuse, normal, and specular map.  The 

advanced game engines such as Unreal 3, Cry Engine 2, and Hammer support 

the maps covered above and many more.  3D software rendering  supports 

many of these, but may have to be created and applied in different ways.  

Below are final texture maps created at 1024 by 1024 pixel resolution.  From left 

to right, they are diffuse, specular, and normal map.
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The application of realistic wear and tear, dirt, and grime is an art form in 

itself.  Objects that interact with humans and the environment develop a wear 

pattern.  The patterns may be oils from hands or machinery parts, and scratches 

from rubbing on another surface.  When you study objects that receive heavy 

traffic such as furniture, you notice the corners are worn down to bare wood, 

and the large surfaces have scratches and dents.  When objects are exposed to 

environmental elements such as sunlight and moisture, it  causes paint to peel 

and cracks to form. Visit a large body of water and look at  metal and wooden 

objects, noticing the water stains and rust formation. The bottom section of 

an object  shows signs of decay and may turn white when minerals such as salt 

are deposited on the surface.  Concrete  shows a great deal of history, with 

Pictured is a wooden table that has been outside for an extended period of 

time.

The image is the hood of a truck that has been in a hot climate near the 

ocean.  

cracks and the pot holes on street asphalt.  A video game environment does 

not look like a clean hospital ward, but has skillfully placed areas of dirt and 

grime.  Observe the real world process of weathering to create a convincing 

replica texture.  Use the techniques outlined in this section, and your props and 

environments will look more realistic. 
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Localized Wear 
Localized wear and tear happens to specific areas of an object over time.  

Mother Nature is the most powerful source of structure decay.  Water, wind, 

and sunlight on the coastline effect the surrounding environment causing 

constant erosion.  The metal on 

a power box is a good source to 

study for signs of breakdown.  On 

the handle area where there is 

frequent access with tools, the 

paint is stripped, exposing the 

bare metal.  Aluminum does not 

rust very easily because it forms 

a layer of aluminum oxide, which 

protects the underlying metal.  

The sun causes paint to peel 

and fade over time, causing it to 

expand and contract.  Be aware of 

the type of material an object is 

sitting on, such as dirt, concrete, 

or grass.  Areas that have grass  

contain moisture in the topsoil, 

which disintegrates the metal over 

relatively short periods of time.  

Dirt often  accumulates and sticks 

to the paint on lower sections of 

objects. The underside of lips and 

overhangs rust, causing streaks to 

form.

Pictured here is a diagram of a 

power box near the ocean.



Workbook2010WorkbookWorkbookTexture Realistic Wear & Polish 
39

Te
xt

u
re

3D Visualization & Animation Competition

Water and the movement of the underlying ground cause cracks on a stone 

or concrete surface. Damage occurs when vehicles drive over the surface, and 

heavy objects  drop on them.  Water and dirt  erode the surface and create deep 

cracks and holes.  When creating a texture,  find good top down reference of 

these details.  You create variation by cutting out crack details and overlaying 

them on top of a similar surface.  Dirt layers may be overlaid onto a clean 

version of concrete or asphalt.  The key is to use sharp details from photos and 

subtle dirt layers fine tuned to the desired result. The diagrams show areas of 

detail that may be replicated in a real texture.

The photograph below displays distress on a concrete sidewalk.

The image is a photograph of distress on an asphalt lot.
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Dirt and grime effects are applied in layers over the base textures.  The 

dirt may be applied as streaks under windows and awnings.  You apply 

grime as a treatment for a more uniform looking texture.  Game engines 

support a second and third UV channel, and multiply the dirt layers over 

the base texture.  Use a multilayer shader in a 3D package for use in a 

film.  Large surfaces tend to look very tiled, even without a seam showing.  

Using a grim texture  breaks up the repeating pattern and adds realism.  

Dirt gathers in the corners and along the bottom edges of the buildings, 

windows, and door trim.  Details that are inset, such 

as vents, may be caulked with materials such as sealer 

or concrete.  Polygon geometry pipes  running along 

a building have a grime strip texture behind them to 

add depth.  The buildings in the diagrams have not 

been cleaned for a long time, and have collected dirt in 

the corners.  When it rains, the dirt runs down along a 

building’s natural cracks or connection points.

The image displays areas where dirt collects and is 

washed away during rainy days.
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Surface Overlays
A solid library of textures enables you to build 

a convincing texture.  There some textures 

essential to creating the effects described in 

this section.  The black and white grime overlay 

is great for a full surface effect.  In Photoshop, 

set this layer style to overlay, or multiply and 

adjust the layer’s opacity.  The concrete wall 

photograph is a real world example of the 

desired effect.  Another way to create this effect 

is to use a dark grime texture, and place a black 

and white overlay texture in the alpha channel.  

Black and white grime overlay                                          Concrete wall photograph

Alpha black and white grime                                             Dark grime texture
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Selecting a color range makes it easy to choose localized areas for overlays.  

Apply rust and colored streaks  directly onto a texture, or  use as an alpha 

texture sheet.  Take a photograph with streaks on it, use the Color Selection 

tool in Photoshop to select out that color, and paste it into a new layer.  The 

new grime layer may be set to overlay or multiply.  Make adjustments  to the 

hue and saturation to tint the color. Place this new grime layer on areas that 

need localized wear and tear.    
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Rust is a common detail that is separated by using the color selection method.  

Take textures while  looking at buildings and finding areas of heavy run off.   

Pictured is a layer selection of rust.  

Edges may look worn down on the corners of the model’s textures to simulate 

every day use.  You use the Paint Brush tool and a light color to paint in the 

wear and tear.  Use the specular map for  the majority of this high contrast 

detail.  When the light catches the edges of the surface, they  create a nice 

highlight.  The inset areas of an object usually collect dirt as illustrated in the 

diffuse texture.  Dirt is  trapped in the tread of a tire or along the trim of an 

automobile.  Study real world objects with heavy outdoor use,  and reproduce 

the localized areas on a texture.

The images displayed are the edges on a specular map and dirt on a diffuse 

map.



Workbook2010WorkbookWorkbookTexture Realistic Wear & Polish 
44

Te
xt

u
re

3D Visualization & Animation Competition

Pictured is the Levels tab. Levels are adjusting by using the sliders to clamp the 

color values.

Color Correction
Texture polish refers to the time it takes an artist to refine a texture to match 

others.  This can be a series of shader setting  used by everyone working on 

a project.  It takes time to become accustomed to using the Wacom tablet to 

draw in details.  Painting by hand brings the external artist back into the more 

painterly and sculptural areas of art.  The final texture  looks like a piece of art, 

with clear form and resolution.  

Color correction is done at the end of creating a texture or multiple textures.  

Adjust them all to within a value and color range, so they look similar.  There 

are ways to adjust a texture when it is completed. You create a brightness 

contrast layer, or a levels adjustment layer.  These filters are accessed in the 

Image and Adjustments list.  Using the Levels windows makes it  easy to adjust 

the minimum and maximum light values.  The keyboard shortcut for adjusting 

the Levels is CTRL + L.

The images  are an over saturated texture of the ammo case, and a color 

corrected one.
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When the texture is finished, sharpen it for a 

grittier look.  It adds bang for your buck when the 

texture is rendered.  Use the Photoshop Sharpen 

filter or un-sharp mask to sharpen the texture.  

If the specular map is too sharp, the texture 

appears to flicker on the screen.  To adjust the 

specular map use a Gaussian blur.  Set the blur of 

a few pixels to offset it, so that the texture looks 

smooth.

The images display  a diffuse texture that has 

been sharpened, and a specular texture that has 

been blurred.
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Rendering
When a texture has a light source directly over it, a bright area is created and 

shadows are cast.  A secondary shadow map that includes lighting and color 

information is added as a multiply layer during rendering.  The process  bakes 

the lighting and shadows into the texture.  This  saves processing power and 

enables the computer to run faster.  A light map is similar to a secondary 

ambient occlusion pass, multiplied over the diffuse layer when rendered in 

game or for film.  

The images  are textures that have lights and shadows baked into them.
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Rendering for video games and films is a 

different process.  Video games attempt 

to get all of the artwork rendered in real 

time, which means it has to render it on 

the fly.  In film and TV, it is rendered out to 

a video file that is replayed. This is called 

pre-visualization.  Mental Ray is a rendering 

engine used for film that takes texture 

sizes up to 4096 by 4096 pixels. This is the 

standard for film quality resolution.  

A video game engine may only handle 100 

megabytes of texture memory at once, and 

may require lower quality textures, such as 

1024 by 1024 pixels.  3D software packages 

such as Maya, Softimage, and 3ds Max  render 

images in mental ray.  Rendering a final shot 

and setting up the lighting may take hours.  A 

specialized artist may only work on rendering 

and lighting for a project.

Pictured are renders of the Bio Chamber in 

mental ray.
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